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www.dexim.net

Compatible with BlackBerry/T-Mobile G1/HTC Phones

AV Dock Station Smart Backup Battery for iPhone/iPod
with Remote Control for iPhone/iPod 1200mAh

« Navigate the menu, select songs and videos,
control volume, play/pause by remote

+ It comes with Dock, Remote, Cables (Video / Audia),

Batteries, and the variety of adapters for
iPod / iPod touch / iPhone

1200 mAh capacity in
a pocket size unit

Richard|Solo”  weaictasseleen
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Dual Dock Charger DCAD84 USB Car Charger Kit DCA090 Travel Adapter Kit  pCADS4

Er; Made for D Works with iPod is a trademark of Apple Inc., registered in the U.S. and other countries. iPhone is a trademark of Apple Inc.
@ iPod iPhone BlackBerry*is a registered trademark of Research In Motion Ltd.
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Premium MHub Dock Station
Designed for Mac/PC/iPhone /iPod /BlackBerry

. 3 Standard USB 2.0 ports

- Charge & Sync dock station for iPhone / iPod / BlackBerry

- Hi-speed HCSD /5D / MMC card reader port
DWPO005

'
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-~ Size: 3.75" X 3" X 0.65"

Aluminam Case
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BAMBOO FUN

Now there’s a new way to edit digital photos, paint,
draw, and write by hand—right on your computer.

Bamboo Fun works on either Mac or PC, allowing
you to express and share your creative ideas
quickly and more naturally. Imagine the ease and
freedom of pen-input with your computer to edit
and draw on your digital photos, make personal
cards, jot notes, write journal entries by hand, or
sketch out an idea.

Bamboo Fun includes creative software from
Adobe®, Corel® and Nik® to help get your
creative juices flowing, but it works with any

application. Bamboo Fun is available in a
variety of colors and sizes, starting at $99.

credte your world

www.BambooFunPenTablet.com
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Readers respond.
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Notto Be?
Should Apple stick with AT&T?
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After just nine months, the App Store hits a huge
milestone.

Apple to Netbooks: Drop Dead

Once again, Apple disses the tiny laptops.
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Check out the cool stuff we're into right now.
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Cameras

For $100, you can find a surprisingly capable digital
camera. Ben Long takes a close look at five cameras
that will barely dent your bank account.

macworld.com/reviews

We're constantly reviewing the latest Mac hardware
and software on Macworld.com. Here are quick
summaries of this month’s online exclusives.

App Store Selections

The App Store features thousands of applications
foryouriPhone and iPod touch. Each month, we
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Top Products
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wellasacomplete listing of all current Macs and iPods.

Mac Gems

Add daily weather reports to iCal automatically,
quickly find lyrics to your iTunes music, get better
PDF browsing on the Web, and more.
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A Windows Guru Spends Two Weeks with a Mac
Computerworld’s Preston Gralla works with a MacBook Air for
two weeks. Will he ever go backtoa PC (

Apple Leads, Dell Lags in Customer Satisfaction
Jim Dalrymple finds that Apple blew away the competitionin
the latest consumer survey (i

) HD Camcorders: Buyer’s Guide
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Listen Up. Sync Up. Charge Up.

These sleek Reson8® speakers are the first all-in-one
computer speakers to sync your iPhone with iTunes™.

iPod

@
Available at I

Apple Retail Store
Apple Online Store

_— D\:Vorks with
Mo’ i Live Lfe Loud iPhone

Our iHM77 rechargeable pop-up
speakers offer Sound Beyond Size.
They're the perfect accessory
for your iPod, gaming system
and computer.

Looking For
portability?

www.ihomeaudio.com

iHome and Resond are registered trademarks of S0l Technologies, Inc. iPod and iPhone are trademarks of Apple Inc., registered in the .5, and other countries



Give your iPhone or
BlackBerry® more than

double

A
For iPhone/iPod

Direct plug-in/no cable.
Includes 2G /3G support by

RS001 $60.95

For iPhone/iPod with Cable
GCable connection only.
Parfect for iPod touch.

RS008 $69.95

For All BlackBerry®
Cable or direct plug-in.
Works with all USE-port phones,

RS007 $69.95

Included Free:

* Retractable USE Cabie

T by

the juice.

Built-in super bright
LED flashlight.

by Richard Thalheimer

Just plug RichardSolo 1800 into your iPhone/BlackBerry once or twice
a day for fifteen minutes, and keep your device charged up. At your desk
or at dinner, plug in RichardSolo to instantly transfer charge. No more
battery worries! 1800 mAh lithium-ion battery is largest in its class and
holds its charge for months. RichardSolo 1800 will charge iPhone to full
1.5 timas, and lithium-ion is good for 3-5 years of recharges.

Retractable USB cable, 110-240v AC wall charger, and dual-port USE car
charger included — like getting two extra chargers for free! Even charge
the RichardSolo 1800 and phone together at the same time. Take only one
charger when traveling and wake up in the morning with the RichardSolo
and your phone charged. Put the RichardSolo in your pocket, plug it into
your phone now and then to top it up. Use your phone while charging it.

Enjoy a built-in laser pointer and ultra-bright LED flashlight, too! These
two lights use very little power, so you get handy extra features. RS001 is
the only snap-on battery available with a latching mechanism for iPhone,
to keep battery firmly attached. RS001 fits all iPhone/iPod cases except
the very thickest armor. Optional 2G/3G support brace included.

RS001 works with iPhone and all iPod models except shuffle.

RS008 works with iPhone and all iPod models except shuffle — perfect
for iPod touch.

RS007 works with all BlackBerry models and any phone with a mini/
micro USB charging port. Plug in directly or use with cable.

Your satisfaction is guaranteed, with our 30-day, no-hassle return privilege.
If you're not satisfied for any reason, we'll email you
a pre-paid return label. You have no risk whatsoever,
and the warranty is now one full year.

Buy Me An
Phone

BEST'

iPod and iPhone are a trademark of Apple Inc., registerad in the U.S. and other countrias.
BlackBerry® is a registered trademark of Research In Mation L1d. Free items require purchase.

On-line ordering and blog reviews.
Order two of the same and save 15%

Plus

Order now, and we will include our

$24.95 hard case for iPhone 3G
as a free bonus with RS001/RS008!

iPho

Cable shown with model

‘ Built-in laser pointer.

The quick pocket solution to top up your iPhone or BlackBerry!
And now get a free iPhone case too!

We are here to support you!
Actual customer comments:

“To have your company exhibit such exceptional
service is unbelievably refreshing.” — P.S.

“Dear Richard and Team: This is what | call
great customer support. | wish more companies
would figure this out these days. Thank you so
much." — D.C.

“You have provided me one of the best services
| have ever encounterad on any on-line/
telephone shopping.” — T.K.

Reviewers give it top marks.

“Your product is excellent, and the customer
service is, of course, outstanding.”
— Chris.Pirillo.com

“Now RichardSolo has released a much
improved version of the Backup Battery that
not only provides more power for your iPhone
or iPod, but some excellent new features that
trash the competition." — TUAW.com

“The guintessential accessory for alliPhone/ iPod
owners. If you don't already own one, you need to
order yours ioday." — BuyMeAniPhone.com

2% | OiPhone

- ®
Order today, goes out next business day ] www.RichardSolo.com | email: support@RichardSolo.com RIChard |S°I°
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By JasonSnel
The Computer behindthe TV

When will Apple do the living-room Mac right?

very time Apple updates the Mac
E mini, I get a strong urge to install
one in my living room.

I parked one of the original Mac
minis on top of my HDTV for the entire
summer of 2005, intending to use it as
a media center. I found the experience
both frustrating and fulfilling.

It was cool to play back Internet video
on my TV. But that coolness was
tempered by the minfi's lack of a good,
remote-control-driven interface. It was
still, in the end, a computer. When you
use a computet, you lean forward, your
face a few inches from the monitor, one
hand on the keyboard and the other on
the mouse. The last thing I wanted to do
was park a keyboard and mouse on my
living-room coffee table, and “leaning
forward” doesn't really describe my usual
posture on the couch.

Still, when Apple released the new
Mac mini in March, I was prompted to
rerun the experiment. I thought that
advances of the past four years—espe-
cially improvements in remote-control
software—might have solved the
interface problem. (See Christopher
Breen’s account of his experiment with a
Mac mini media server on page 59.)

But based on my latest test, I think it
will still be some time before having
Macs attached to our TV sets will seem
normal. I've once again disconnected the
Mac mini from my TV and removed it
from my living room.

Apple TV or Mac?

Since my first attempt to attach a Mac
mini to my TV four years ago, Apple
came out with the Apple TV—essen-
tially, a stripped-down Mac mini with a
menu-driven interface that doesn’t
require a keyboard or mouse. If you
store all your music and videos on a Mac
somewhere in your house, an Apple TV
will let you play that media in your
living room effortlessly.

I’d like to take all
the great video | can
play on my Mac and
play it back on my
TV screen.

Unfortunately, the Apple TV’s
simplicity comes at a price. Its software
doesn’t support third-party Internet
sources other than YouTube, nor will it
play any video formats other than those
supported by iTunes. Enterprising
hackers have found ways to upgrade
the Apple TV's software with clever
programs like Boxee (www.boxee.tv)
and XBMC (xbmc.org). Unfortunately,
these programs only expose the
limitations of the Apple TV hardware,
which is barely capable of playing 720p
high definition video.

Compare the limitations of the Apple
TV to the options you have on a Mac
mini media server. You could install the
free Perian (perian.org) plug-in to play
almost any video format known to
humanity. If you subscribe to Major
League Baseball's MLB TV service ($80
to $100 per season; mlb.com), you could
watch HD-quality video of live baseball
games on your TV. More importantly,
using software such as Boxee or Plex
(www.plexapp.com), you could replace

Front Row with a slick, remote-driven
menu system featuring all kinds of
Internet content.

Plex and Boxee are both evolving
quickly enough that, by this time next
year, you'll probably be able to install one
or the other on a Mac mini and have a
device that'll put the Apple TV to shame.
But they’re not quite there yet.

Something for Everyone

Of course, if you've got a cable box or

a DVR, you've already got a computer
in your living room. TiVo and its ilk
usually run some variant of Linux; my
first TiVo had a PowerPC processor and
a Mac-based file system. But that
software is hidden behind a friendly,
remote-driven interface.

The simpler the interface, the easier a
device is to use. But the more power-
ful a device is, the harder it is to create a
simple interface for it. Programs such as
Boxee and Plex have to let you attach to
remote file servers, play back video from
dozens of Internet video providers, and
more. And they have to do it all with a
friendly interface that won't make my
wife throw the remote at me and ask
why I've made watching TV so difficult.

This is where Apple, with its interface
expertise, could contribute some serious
innovation. But will it? Steve Jobs
famously called the Apple TV a “hobby.”
It's unclear whether that's because the
market isn’t mature or because Apple’s
attention is focused elsewhere.

All T want is to watch all the great
video I can play on my Mac on my TV
screen. I'd like Apple to be the company
to make that happen. If it doesn’t, I'm
pretty sure someone else will. &3

What do you think? Would you ever install
a Mac miniin your living room? Have you
tried it already? Write me at jason_snell@
macworld.com or join the discussion at
forums.macworld.com.

July 2009 Macworld 7



Extend your Apple MacBook battery life up to

3 32 hours!

World’s first external battery and car charger for all
Apple MacBook, MacBook Pro, MacBook Air models

e ———

Power your MacBook and any USB device (iPhone) simultaneously

Power and recharge your MacBook continuously for more than a day
or recharge your iPhone up to 52 times with the built-in USB power port.

Four different capacities

to choose from

HyperMac External Battery for
MacBook comes in 4 different
sizes (60/100/150/222Wh). In

comparison, the MacBook Air
internal battery is only 37Wh.

Original Apple MagSafe

power connecter/cable

HyperMac uses original
MagSafe power connecters

for maximum compatibility,

allowing every battery to
work with all MacBooks.

The better way to power

MacBook on the road

HyperMac DC Car Charger
powers your MacBook and
is safer, higher fidelity, more
efficient and compact than
traditional AC inverters.

HyperMac

hypermac.com|1.888.202.1888

Apple, Mac, MacBook, MacBook Alr, and MagSafe are registered trademarks of Apple. Inc.
The MigSafe cable and connector is manufactured by Apple, Inc and modified to be compatible with HyperMac
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One business trip (airfare, car rental and hotel)

$49

Unlimited online meetings per month
Do the math. With GoToMeeting you could hold a month’s worth of online
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you want for one flat rate - free VolP and phone conferencing included.

Do more and travel less with GoToMeeting. Try it free for 30 days.
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FEEDBACK

No to Green, Yes to Netbooks

Readers get bored with the environment, and creative dreaming of an Apple netbook

Environ-mental

Count me among your readers
who are tired of this pandering to
environmental extremists (“How
Green Is Your Mac?” April 2009).
The planet has been through
earthquakes, ice ages, floods,

Mea culpa: Upon further review, we have
toagree thata “black” Google won’t
reduce the energy consumption of a
modern LCD display; it would, as you say,
cut consumption only for a CRT. And your
tip regarding turning down the brightness
isagood one.—Dan Miller

volcanoes, fires, and hurricanes. Yet

Netbook Fantasies

Yes, I would pay $500 for a supersize

we're going to destroy it by using
Macs? Apple has realized it can make
money off these gullible “green” iPhone-like netbook made by Apple
customers. But many of us would (“Netbook or Bust,” From the Editor’s
rather focus on what our electronics i Desk, April 2009). The iPhone
can do for us rather than what we can . “\%\\\ " screen is too small for even casual
do to please some environmentalist — browsing of Web sites. I con-
freaks from Greenpeace. stantly have to increase the text

[=] Clayton Rhoades size and scroll right and left to read. But
a 7.5-by-5.3-inch netbook would be
You suggest using the site Blackle, which  on constantly, regardless of the state of perfect. This “TouchBook” would be

shows a black background for Google the pixels. Thus, a black pixel will smaller, thinner, and lighter than any
instead of a white one, as a way of saving  actually use slightly more power than a netbook on the market.

energy. This is a misconception. Whilea  white one. So how do you really reduce [ Edward Ho
black background would have saved the power consumption of your display?

energy in the days of CRT displays, this Turn down the brightness. It's the Apple will be making a huge mistake if
is no longer true with today’s LCD backlight that consumes the majority of it doesn’t enter the netbook competition
displays. LCD screens require power to the power. soon. Our school is planning on pur-
become opaque, and their backlights are 21 ThomasReed chasing a laptop for every student next

year. We are seriously considering the

OVERHEARD ON THE FORUMS v e

the economy and Apple’s laptop pricing
are driving the decision. Purchasing

“While | would like to see Apple provide some more backward compatibil- .
1,000 netbooks instead of 1,000

ity, I think its decision to continuously move forward by eliminating older

technologies prevents them becoming the mess that is Microsoft.” MacBooks will save us $500,000. And
pcharles much of what our students do now is
macworld.com/4833 Web-based, so the platform and OS are

becoming less of an issue. Apple may
not be in the business of creating

“Hopefully we will not have to wait supercheap products for the bottom of
for iPhone OS 4.0 or even 5.0 before the market, but it profited sizably from
voice recognition and voice dialing being the first to cater to the K through
are added at the system level.” 12 market. Apple risks losing that
MacPClustCreate market without a netbook or a lower-
macworld.com/4832 priced MacBook.

=1 Bruce Deger
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READER POLL

When did you buy your
last Mac?

45%

10% 994

-

2005 2006 2007 2008 20090
or before

+1% of respondents said they'd never bought a Mac.
Source: Macwerld.com anline poll, March 2009

As a professional photographer, I would
find a Mac netbook a godsend on field
assignments where [ need to turn
around JPEGs on the spot, or simply as a
repository and backup device for full
Compact Flash cards. [ wouldn’t need to
run Photoshop or InDesign on it, but it
would be nice if T could run a lighter-
weight app like GraphicConverter for
quick editing, entry of metadata, and file
renaming. So no, I would not pay $500
for an iPhone-like netbook. But I would
pay $600 for a MacBook-like iPhone.

[=] Brian Drumm

Instead of making a new netbook, what
if Apple made a docking station right
now for the iPhone and iPod touch with
VGA, mouse, and Ethernet connections?
That's a working netbook platform if I've
ever heard of one.

=] David Etengoff

Mail Manners

I'd like to make your article on e-mail
manners mandatory reading for the
people in my contact list (“E-mail
Etiquette,” Working Mac, April 2009).
One of my biggest pet peeves was
missing, though: sending huge attach-

ments. I've had my inbox reach its limit
thanks to the 20 high-res pictures of little
Bobby's first steps, causing subsequent
senders to have their messages bounce
back with an “inbox full” error. Before you
send, check the size of your attachments.
If they're huge, resize or zip them. If your
e-mail client doesn’t tell you the size of
your attachments, and if you don’t know
how to check, don’t click on send.

[=] Steve Diniro

Too Many Mice?
After reading recent reviews of various
Apple hardware and software, I'm
beginning to wonder if Macworld
reviewers read their own reviews before
giving almost everything four mice. A
look at the list of cons, followed by a
reading of the reviews of iPhoto and
iMovie, make me wonder what the rating
would be if the software came from
someone other than Apple. Apple’s
laptops, with the exception of the
MacBook Air, all received four mice
despite the lack of FireWire or a matte
screen option. Don't get me wrong, |
love Apple and I love Macs—but
reviewers should expose the warts as
well as the good points of Mac hardware
and software to prospective buyers.

=1 EdWood

In your glowing review of iMovie "og,
you didn’t mention that if a user imports
VHS tape and then burns a movie to
DVD, the picture is terrible—like an old
8mm home movie. The interleave
method of capturing video in iMovie "og
is optimized for new camcorders with
high-definition images, but leaves us
DV-import geezers back with iMovie "06.
Too bad, because iMovie ‘o9 does have
some great features.

[=] Richard Posner

Put an End to Whining

I'm a little taken aback by the designer
community's whining about the glossy
screens on MacBooks (Feedback, April
2009). I can only assume these are
young designers who don't remember
the days of no-choice CRTs that weighed
a zillion pounds and had glass faces with

no antiglare coating. Some even came
with hoods to help mitigate the glare.
Even then, we were at least industrious
enough to arrange our offices and dim
lights so that the screen was easily

viewable. While I agree that the antiglare
screens are somewhat preferable in
general, these are MacBooks, for crying
out loud. If something is glaring off the
screen, get up and move.

[1 Adam Eric Junkroski

After reading your Feedback column for
many months now, I can’t help but
wonder, just how spoiled are Mac users?
They have no idea how great they have
it. After using a PC for nearly three
decades, my only regret is that I didn't
switch to a Mac sooner. Apple makes
the best hardware and software com-
puter solutions I've ever used. I've used
many operating systems over the years
(Unix, CPM, MS-DOS, and so on), and
Mac OS X is by far the best. Every Mac
user should have to “do time” with a
Windows-based PC on a weekly basis.
Their opinions of Mac OS X would be
far more favorable.

[ Lou Saad

Contact Us

Post comments on our forums (<)

at forums.macworld.com or send
them by e-mail ((=]) to letters@
macworld.com. Due to the high vol-
ume of comments we receive, we can't
respond personally to each one. We
reserve the right to edit all e-mail let-
ters and forum comments. All pub-
lished letters and forurm comments
become the property of Macworld.
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\erizon and Apple:

0 Be or Not to Be?

Should the iPhone move to Verizon? BY DAN MOREN

here’s been a lot of hubbub
recently over reports that
Verizon and Apple are talking

about expanding the choice of carriers
for iPhone users. Would this be a good
thing? We decided to give each side of
the debate an ardent champion—me.

Point: Verizon and theiPhone Are a
Match Made in Technology Heaven
If there’s one weak point in the iPhone’s
seeming invulnerability, it's the Achilles’

14 Macworld July 2009

heel called AT&T. Since day one, potential
iPhone customers have hemmed and
hawed over whether to purchase the
handset, because they would have to
switch providers—many of them from
Verizon Wireless, AT&T’s primo rival.

So the news that Apple and Verizon
might strike a deal to bring the iPhone—
or other portable devices—to the Verizon
network has consumers singing Handel's
“Hallelujah” chorus. Way back when the
iPhone was in the planning phase,

Verizon reportedly took a pass on a
chance to help bring it to market, because
the company was reluctant to give Apple
the share of subscriber revenues that
AT&T proved all too willing to shell out.

In hindsight, the Apple-branded
handset seems to be the “one that got
away” for Verizon. The iPhone has gone
on to become a blockbuster seller, pulling
in plenty of profits not only for Apple, but
for AT&T as well. The wireless provider
said it activated 1.6 million of Apple’s
handsets in the most recent quarter, many
for users who were converts from other
networks. It's been noted that the iPhone
may be a substantial factor in keeping
AT&T’s wireless business in the black,
given its lately shrinking profits.

The iPhone market is certainly a
tantalizing target for Verizon, but what
does Apple get out of the deal? Having
been spurned by the company once, why
would the iPhone maker go back to it
now? Simple: because it's good business.
Although AT&T and Verizon are duking it
out for the title of the nation’s best net-
work, Verizon's network is widely perceived
as more robust, with wider coverage, while
many AT&T customers complain loudly
about dropped calls and poor coverage. If
ATE&T is the chink in Apple’s armor, it’s no
surprise that Apple wants to patch it up
with stronger stuff. Who better than the
nation’s self-proclaimed “largest 3G
network” to fill the gap?

Of course, matters are complicated by
the exclusive deal AT&T and Apple sup-
posedly struck, which takes the two com-
panies through 2010 or 2012—accounts
vary. It's possible that the terms of that deal
have changed—recent stories have AT&T
trying to get Apple to extend the contract—
but it also lends credence to rumors that
Apple is shopping other devices to
Verizon. Presumably those devices
wouldn't be subject to the same exclusivity.

A partnership with Verizon would also
present technological challenges, as Apple
chief operating officer Tim Cook pointed
out in the company’s most recent
conference call with financial analysts,



when he effectively declared the death of
CDMA, Verizon's wireless protocol of
choice. However, since Verizon is planning
to transition to the GSM-compatible ITE
standard for its next-generation network,
those hurdles will be moot within the next
few years. With all that amassed evidence,
the question is not “Why Verizon?” but
rather “Why not Verizon?”

Counterpoint: Why Verizon Makes
NoSense

Apple ditch AT&T for Verizon? You gotta
be nuts. Seriously, folks: Verizon and

structure requirements, and additional
customer support personnel. And
compared to the global GSM standard,
CDMA exists in very few places outside
the United States. Besides, there’s the
matter of philosophy: Apple doesn’t want
the customer to have to think about
which technology or which provider to
choose—just buy an iPhone.

Verizon has made forays into the
touch-screen space with the LG Voyager
and the BlackBerry Storm, but try as it
might, the company hasn’'t managed to
produce anything that competes with the

If AT&T is the chink in Apple’s armor, then
it’s no surprise that Apple wants to patch
it up with stronger stuff.

Apple? It's about as likely as Bruce Willis
and Cybill Shepherd teaming up for a
reunion of Moonlighting.

Apple and AT&T have been partners
for two years now, and while that might
not exactly be considered a long-term
relationship in the business and tech-
nology worlds, it's worth noting that the
companies have released two iPhone
models together. Apple wouldn't toss that
partnership aside lightly.

Verizon is certainly a likely enough
partner—it’s not as though Apple is
going to jump ship for T-Mobile or
Sprint. But however loudly Verizon may
brag about its amazing network, AT&T
still has 78 million subscribers—and
that's nothing to sneeze at.

While the technology hurdles aren’t
impossible to overcome, the chances that
Apple will make a CDMA-based version
of the iPhone go by the names of “Slim”
and “None.” An LTE phone for the
forthcoming 4G network is a possibility
since it will be GSM compatible, but
given how recently most of the providers
finished rolling out their 3G networks,
it's going to be a while before the 4G
networks reach anywhere near the same
level of market saturation.

Why not two separate smart-phone
models? It just doesn't seem like Apple’s
modus operandi. It would mean two
manufacturing processes, dual infra-

iPhone’s ease of use, broad application
platform, and sleek design. Verizon has
also shown itself willing to play the field
with anybody: a Wall Street Journal article
suggested that the company is also court-
ing Microsoft to partner for a phone
product. That might not sit well with
Apple, given that the company enjoys
being the center of attention.

The more likely explanation for the
Verizon and Apple talks, as some have sug-
gested, is to give Apple some leverage
against AT&T. When Apple discontinued
the original iPhone in favor of the iPhone
3G, the company gave up most of the
concessions it had wrung out of AT&T—
such as a cut of subscriber revenues—in
return for the wireless provider’s subsidiz-
ing the price of the phone. That lower cost
helped propel the iPhone 3G into its
widespread popularity; if Apple could cut
the price even further, it would make
things that much sweeter for the company.

But Apple is likely to talk AT&T into
those terms only if it has a substantial
bargaining chip, in this case a reason-
able rival to turn to in lieu of AT&T. And
in the current circumstances, Verizon is
a prime candidate. Actually making a
deal with Verizon isn't what Apple’s
after: it just wants to bluff AT&T into
folding its hand. &

Dan Moren is a Macworld associate editor.

LAPTOPS

MacBooks
Sweep
Consumer
Reports’

L]
Laptop Ratings
Apple has scored itself a trifecta
with the release of the June issue of
Consumer Reports, The highly
regarded publication gave the com-
pany top rankings in three of its
notebook categories: 13-inch mod-
els, 14-inch to 16-inch laptops, and
17-inch models.

The MacBooks bested their com-
petitors, despite the higher prices
for the Apple systems. The $1,999
15-inch MacBook Pro, for example,
scored 75 on the magazine's 100-
point scale compared to the runner-
up—a $700 Toshiba Satellite, which
earned 64 points.

Apple’s laptop line dominated the
13-inch category in particular; it was
topped by the unibody MacBook and
followed by both the MacBook Air
and the white polycarbonate Mac-
Book. In addi- o
tion, the 17-inch
MacBook Pro

got the highest
rating of any
notebook
reviewed by
Consumer
Reports, scor-
ing 8o points,
and nabbed an
Excellent or
Very Good
rating in every tested category.
Apple’s desktops didn't fare quite
as well, but both the Mac mini and the
iMac took home silver medals in their
respective categories. The company
also earned the highest marks for
computer tech support in both the
desktop and notebook categories.

—DAN MOREN
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PEOPLE

Woz Talks
about Hackery,
Technology

While you may know that Apple
cofounder Steve Wozniak tore it up
on ABC’s Dancing with the Stars and
recently joined hardware startup
Fusion-io, | sure didn’t know that he’s
still using Eudora, an e-mail program
that | stopped running circa 2002
Woz reveals that and many other
fascinating quirks in an interview with
productivity blog Lifehacker (macworld
.com/4830). Other gems: he packs a

Thanks a billion.

One Billion Served

Nine months after opening its App Store, Apple announced on its Web site in April
that it reached the milestone of 1 billion downloads of iPhone applications. (That
number includes free apps, paid apps, and app updates, whether downloaded 17-inch MacBook Pro and travels with
through iTunes or directly onto an iPhone or iPod touch.) an iPhone and a BlackBerry—why
When 13-year-old Connor Mulcahey, from Weston, Connecticut, downloaded both, | don’t know. Then again, this is a
guy who carries around sheets of $2
bills and is a master of Segway polo.
But | digress.

On the software front, Woz runs
Safari and says he has never really had
time to check out Linux, although he
does add that “Linux people always
think the way | want to think.” While
he used to have a jailbroken iPhone,
he doesn’t anymore, due to the con-
stant back-and-forth that’s required
to reenable hacks after every update

of Apple’s software—CYRUS FARIVAR

Bump, an app for swapping contact information (macworld.com/4829), he pushed
the count over the top. Apple awarded Mulcahey a $10,000 iTunes gift card, an
iPod touch, a Time Capsule, and a MacBook Pro—not a bad haul for downloading a
free app.

The App Store currently has more than 35,000 apps available for download, includ-
ing big-name titles that have helped the iPhone and the App Store grow large in a rela-
tively short period of time. And during the second-quarter conference call with ana-
lysts, Apple chief financial officer Peter Oppenheimer said that “software is the key
ingredient for a great mobile experience,” and that Apple is very excited about the
types of apps developers will create using the features in iPhone OS 3.0, The only
question now: how long will it take to get to 2 billion?—Jim DALRYMPLE

2 4 Difference in wireless data-
M transfer speeds between
Bluetooth 2.0 and 3.0

Number of
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RAID system comes in capacities
ranging from 250GE to 2TB
(pricing starts at $230).

cigarette-lighter jack to provide a
USB port for charging iPhones or
iPods ($15).

continuously at 4 frames per
second and record 720p HD
movies (bady only, $730).

-
=%
™
2
ac
_1




PEOPLE

X-Men’ Mutant
Gives Word Two
Claws Down

Look out, Microsoft—you've gone and made
Sabretooth mad. Actor Liev Schreiber, who plays
the hirsute villain in the new X-Men Origins:
Wolverine, was a guest on National Public
Radio’s weekly news-quiz program, Wait
Wait... Don’t Tell Me! During the interview, host
Peter Sagal asked: “How annoyed do you get
when you type your name into Microsoft Word,
and it keeps wanting to spell it ‘Live’?”

“So annoyed that | moved to a Mac,”
Schreiber said. | bet Sabretooth would make

short work of Clippy—PHILIP MICHAELS

LEGAL

DVD Copying Goes
to Court—Why
You Should Care

RealNetworks and the major movie studios are currently fighting it out in court in a case
that could determine the fate of DVD copying.

RealNetworks would like to sell its $30 RealDVD application, which lets Windows
users back up commercial DVDs to a computer’s hard drive for archival purposes (these
backup copies are still protected and can’t be burned to DVD). The movie industry
wants to maintain control of its content and argues that RealNetworks is in violation of
the Digital Millennium Copyright Act. (The Motion Picture Association of America, in
fact, won a temporary injunction in October 2008 that prevents RealNetworks from
selling RealDVD.)

The question at stake is, once you purchase a hunk of media, is it or is it not yours to

real

do with as you legally please? If the “fair use” doctrine triumphs, the media companies
fear they'll go out of business because their wares will be pirated from one end of the
world to the other. And if the DMCA wins the day, the “fair use” crowd believes they'll be
ground under The Man’s heel.

I don’t think this trial will decide the question once and for all because of its narrow
focus, but | do hope it sets us on the path to a more logical approach to dealing with the
issue. My archived copy of Mary Poppins depends on it.—CHRISTOPHER BREEN

Problems?
Fix them yourself and save money on
costly repair bills.

Save Money! Install TechTool Pro Now!
« Keep your computer running smoothly.
« Help prevent problems in the future.

« Fix most of your problems on the spot.

K| @

Micromat, Inc., 5329 Skylane Blvd., Santa Rosa, CA 95403, USA

|
Mac | |uwe| - 300-829-6227'707-566-3831  info@micromat.com www.micromat.com
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iPod +iTunes News

Everything you need to know about digital music

U.S. Military
Extensively Using
iPod Touch

Inarecent Newsweek article
(macworld.com/4831),
under the headline “Apple’s
New Weapon,” Benjamin
Sutherland waxes eloquent
about how the iPod touch is
being used for tasks as var-
ied as translation, data shar-
ing among soldiers, and even
the calculation of ballistics.

Price of Prince
iPod WillMake
DovesCry

Are you a huge Prince fan? If so, you
may be a prime candidate for this
limited-edition iPod celebrating his
career, Just g5o of the Prince Opus:
21 Nights iPods (www.princeopus
.com) will be made,

The purple iPod touch comes

loaded with a 40-minute video made by Prince himself of his

“21 Nights” performance at London’s O2 Arena in 2007, as

Apple Says
It’s Sorry
about Baby
Shaker App

Most controversies about App
Store apps have revolved around
those Apple rejected rather than
those it erroneously let through.
But you can definitely count Baby
Shaker among the latter.
Sikalosoft’s Baby Shaker app
featured a drawing of a baby
accompanied by audio of crying;
the goal was to shake the phone
until the baby stopped crying.

The well as 15 tracks from the artist’s Indigo Nights live album. Some groups called the application
article The iPod is packaged with an exclusive book of Prince photo- offensive, espe-
e e pomtls out graphs, produced by publisher Kraken Opus. All this can be cially in light of
—— —~ that since yours for a mere $2,100.—DAN MOREN the dangers of
R -%w e 5
the iPod shaken—baby syn- 0:00:06.4
. . touch is drome. Defenders
ili - : f
fam't'ar ©  IPODTOUCH,IPHONE SALES ° _:jhfhp“’g'ﬁm
mos said the applica-
recruits, TOTAL 37 Ml LLl ON U N ITS tion is clearly
training During Apple’s second-guarter earnings conference call—in humorousin
soldiers to which the company announced a profit of $1.21 billion—Apple its intent.
use the device is straight- chief operating officer Tim Cook revealed that iPod touch Apple pulled
forward. They can use it sales had more than doubled year over year. Apple has now the app from the
without encountering much sold a combined 37 million iPhones and iPod touches. App Store not

of alearning curve.

We know, of course, that
the iPod is designed to play
video and audio, but Suther-

Cook called that number an “enormous platform for devel-
opers,” adding that with the recent changes introduced in
Apple’s iPhone 3.0 SDK, which went betain March and is
expected to be released to customers this

long after its
release, and an
Apple spokesperson then issued
the following apology: “This appli-

land points out another
potential use: “Consider the
impact of showing villagers
avideo message of a relaxed

summer, Apple and developer partners will
keep the company years ahead of every-

one else. Allin all, Apple sold more than 11
million iPods and

cation was deeply offensive and
should not have been approved
for distribution on the App Store.
When we learned of this mistake,

=
and respected local leader nearly 3.8 mil- the app was removed immediately. :
encouraging them to help lion iPhones We sincerely apologize for this }'
root out insurgents.” during the mistake and thank our customers

I smella new Apple ad quarter. for bringing this to our attention.”
campaign in the making, —PETER —DAN MOREN
—CYRUS FARIVAR COHEN

SOFTWARE NetDiagrammer, from CS Odessa ProfCast 2.5, from Humble Daisy SecuriKey for Mac 3.1, from GT

Mudbox 2009, from Autodesk
{usa.autodesk.com): Digital
sculpting software adds a new
production-focused texture paint
workflow ($745).
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{www.conceptdraw.com): Plug-in
for ConceptDraw Pro 8 helps |T
managers and network administra-
tors plan and illustrate a computer
network topology ($49).

(www.profcast.com): Lecture-
recording and podcast-creation
software adds the ability to export
recordings as.m4v files ($60;
update, free).

Securikey {www.securikey.com):
Updated hardware-software
security combo features
enhanced AES data encryption
(starting at $130).

.
A
O
o

i
_|




LAPTOPS

Apple to Netbooks: Drop Dead

As someone whao's fascinated by the idea of Apple making some sort of tiny laptop-like device,
| pay close attention to what Apple says about the whole netbook market. (If you haven’t been
paying attention, a netbook is a cheap, small laptop, and Apple doesn’t make one.)

During the company’s conference call for second-quarter financial results, analysts once
again wanted to know what Apple was doing in the netbook market. As he did three months
earlier, Apple chief operating officer Tim Cook dismissed current offerings, and said Apple
has some ideas of its own.

Cook said netbooks have “cramped keyboards, terrible software, junky hardware, very
small screens, and just not a consumer experience... that we would put the Mac brand on,
quite frankly.” But he added that “if we can find a way to deliver an innovative product that
really makes a contribution, then we’ll do that—we
have some interesting ideas in this space.”

If you follow Apple, you know that the company
often runs down its competitors in a category
before introducing its own game-changing prod-
uct. Cook’s past statements lead me to believe
that Apple is indeed planning its own answer to
the netbook—and his recent statements did
nothing to dissuade me from that opinion.

With smack talk like “I think [it's] a
stretch to call [the net-
book] a personal
computer” circulat-
ing, can Apple’s net-
book entry be far
behind?—JasoN sNELL

iPhone’s Happy Users

It may not come as a huge
surprise, but Apple’s iPhone
ranked number one in a
survey of satisfaction
among smart-phane
customers from research
company J.D. Power and
Associates. The iPhone
rated highly in ease of use,
operating system, features,
and physical design.
—MARYAMM JONES THOMPSOM

Smart-Phone Customer Satisfaction Ratings

Source; 1D, Power and Associates

HARDWARE

Quadro FX 4800, from Nvidia (www.nvidia.com):
Graphics card for Mac Pros features 1.5GB of
memeory, bandwidth of up to 76.8 GBps, and two
Dual Link DVI connectors ($1,799).

Rugged XL, from LaCie (www.lacie.com): Full-size
version of rubberized orange and silver external
USB 2.0 hard drive offers 1TB capacity ($160).
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Hot Stuff

What we’re raving about this month

ProTools8

Pro Tools may be the industry-standard
digital audio workstation, but that doesn’t
mean its developer, Digidesign, is going to
sit back and relax. The release of Pro Tools 8
has brought some fantastic new features
like audio comping, a Score Editor for
writing in musical notation, new instru-
ments, and the ability to view multiple lanes
of data for each track. Pro Tools also
includes Elastic Audio and Elastic Pitch,
features that allow you to stretch audio
in a variety of ways, making some of
the most difficult audio-editing tasks a
breeze. Pro Tools 8 includes a com-
pletely redesigned and customizable
interface, with movable elements to fit
the way you work. Registered Pro Tools
users can upgrade for $150; the full
version sells for $300 (www.digidesign
.COM}.—JIM DALRYMPLE

-
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ChocoShuffle

times a tiny

Steven Slate Drums

Virtual drums have come a long way from
afew years ago, when you had only MIDI
drums that sounded like you were banging
ona tin can. Steven Slate Drums allows
you to enhance your songs with drums
based on kits from the
likes of Led Zeppelin and
AC/DC. Steven Slate
Drums starts at $149 for
20 drum kits, and works
either as a stand-alone
instrument or as an RTAS,
VST, or AU plug-in (www
stevenslatedrums.com).
—JIM DALRYMPLE

Some say Apple’s latest iPod shuffle is too small—it’s without a doubt the easiest-to-lose
iPod Apple’s ever made. And the shuffle’s size makes it tempting to stick the player in your
pocket with your keys and other scratch-inducing items. If you'd like to add alittle
protective bulk to your shuffle, SwitchEasy’s ChocoShuffle may have you salivating. The $9
ChocoShuffle, available in milk chocolate, white chocolate, or strawberry chocolate, is a
silicone case that turns your iPod shuffle into a realistic chunk of a chocolate bar. The case

fits the shuffle perfectly, exposing only the headphone jack and control
switch on top, and the shuffle’s clip on the back. The thick silicone
protects your shuffle and enhances your grip, and the
ChocoShuffle is also a clever way to surprise your

sweetheart with the tiny iPod—just be sure to
warn them before they take a bite
(switcheasy.com).—DAN FRAKES
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Photo Cabine

Need to let off a little steam? Then check
out Photo Cabine, by LeDjam. All you need
for this free Web-based photo booth ser-
vice is a Webcam, -
such as your iMac's
or Mac laptop’s
built-in iSight, and
you're good to go.
Enter the Photo
Cabine’s URL into
your browser of
choice, click on the
photo booth cur-
tain, and then click
on the red button to
start taking your
series of images. (All
instructions are in
French, but they're
easy to grasp.)
When the picture-
taking is done, you
wait a moment for
the picture strip to
appear, along with
options to print it,
saveitasa JPEG

(in either large or
“blog” format), or
exit the booth
(www.laphoto
cabine.com).

-M“c‘in_mg;
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Without a ScanSnap scanner, this office

would be a mess right now.

1 d - Meet the new ScanSnap S1500M. Faster and more advanced than ever.
: \ . ScanSnap just got smarter. It knows when a document should be scanned in color, grayscale or black and white. It
2Ry b . knows if it should increase the resolution on small documents for readability. It has intelligent paper feed detection
SEa b \ §0 you can rest assured that all the pages in the automatic document feeder will be scanned the way you want.
And ScanSnap scans at a blazing 20 pages per minute—directly to an application or to secure, searchable PDFs

for filing or emailing. All at the touch of a button. Managing paperwork is now a no-brainer.

‘.’ Tell us how you'll ScanSnap. You just might win an American Express gift
& | check. Visit http://us.fujitsu.com/scanners/macworld for more details.
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Bargain Shooters Ifyou
don’t currently have a
digital camera, or if your
point-and-shoot digital
camera is afew years old,
now is a great time to
consider buying a new one.

Affordable Point-

and-Shoot Cameras

For around $100, you can find an excellent snapshot camera BY BEN LONG

hile the current economic
environment is filled with
uncertainty, there’s one

definite, reliable fiscal principle in
technology: digital cameras continuously
improve and become more affordable.
These days, this allows budget-minded
people to buy a surprisingly good digital
camera for under $100, one that produces
decent (if not outstanding) images and
packs a robust set of features.

The snapshot-oriented cameras at
this price have automatic modes that do
the work of adjusting settings for you.
These cameras are a great place to start
for beginners who know nothing about

photography.
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The $100 cameras that used to
dominate the market had 3 to 4
megapixels, but today a $100 cam-
era can get you between 7 and 10
megapixels. The larger pixel count
allows you to print larger photos
while maintaining high image resolu-
tion, or to make tighter crops.

Today’s $100 camera may offer other
advantages over an older point-and-
shoot. For example, it's likely to yield
much better results and perform better
in low light. Also, it has a range of
features that didn’t even exist until
recently; from face-detection autofocus
to HD video, a mere $100 outlay can buy
you a lot of new capabilities.

What You Get for $100

For this review, we looked at five point-
and-shoots that have a manufacturer’s
suggested retail price of around $100. If
you shop around, you can find these
cameras for under $100. We reviewed the
Canon PowerShot A470, the GE A835,
the Kodak EasyShare Cgi3, the Nikon
Coolpix Lig, and the Polaroid Tio31.

All the cameras we reviewed are fairly
small, though not as tiny as some
more-expensive point-and-shoots. All
have full automatic modes. And all pack
a zoom lens, a built-in flash, a movie-
shooting capability, and scene modes
that tailor the camera’s settings to
particular shooting situations.
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What you won't get are high-quality
lenses, manual features for assuming
more photographic control (although
there’s one exception to this in our group
of cameras), and sturdier bodies. You'll
need to shell out more cash for these
features, as well as to get other options
such as wireless Internet access for
e-mailing pictures or uploading
them to a photo-sharing Web site like
Flickr.com directly from the camera.

Build and Handling

For $100, you'd probably expect a
chintzy-feeling camera. While the cam-
eras in our review are far from bullet-
proof, they all are sturdy. None of them
exhibited creaking or flimsiness. The
mode dial on the GE was loose, but it
didn't feel like it would break.

All of the cameras in our review have
plastic bodies with a nice finish. The
Canon is the prettiest, though the
Polaroid has the thinnest design. With
protruding lens barrels, the Canon and
Kodak models were awkward to carry in
a pocket or bag.

These five cameras all have zoom
lenses that extend when you power them
on, and they start up quickly. Each
camera was ready to shoot as soon as the
lens was fully extended.

Thanks to its comfortable handgrip,
the Nikon is the easiest to hold. The
Canon and the Kodak have moldings
and grips that let you
easily grasp them using
just your right hand. The
GE and the Polaroid don’t
provide such grips.

Cameras at this price
tend to use LCDs that aren’t
as nice as those found on
pricier cameras. All of the
LCDs in this group suffered
from occasional vertical
streaking when used for
shooting in bright sunlight.
These streaks didn’t appear
in the final images, but they
were annoying during
shooting. The GE's 2.5-inch

.comyj4542

CanonPowerShotAg70

Add,

PROS: Great image quality;
excellent macro feature; good
design, interface, and feature set;
good performance at high 1ISO.
CONS: A little bulky; images
have a slight but correctable
color cast; flash is a little strong.
PRICE: %100

COMPANY: Canon,
WWW,LS3,CaN0N.Com

FULL REVIEW: macworld

LCD was noticeably darker than the
others’, making it hard to use in very
bright sunlight. The Canon and the
Kodak also have 2.5-inch LCDs. The
Nikon has a slightly larger 2.7-inch LCD,
while the Polaroid has a 3-inch one.

One thing that's missing from all of
these cameras is an optical viewfinder—
the little peephole you might be
accustomed to looking through,
although it's quite possible that you've
never actually used an optical viewfinder
before. It can come in handy when the
LCD screen is hard to see.

Automatic Pictures

All of the cameras we reviewed work just
as you would expect. They all have an
automatic mode that makes the essential
camera adjustments for you.

Buttons to zoom in on and away from
your subject are located on the back of
each camera, within thumb’s reach. The
Nikon has the best, most accurate zoom
control. The GE, on the other hand, has
a jerky zoom control that can make it
difficult to get the precise framing you
want, The zoom controls on the Canon
and the Polaroid scored about the same,
with the Kodak’s zoom performing a
little better than the GE’s.

All of these models have a similar
zoom range, from fairly wide to
telephoto. The Nikon has the longest

Focus: Mobile

Phone
Cameras

Almost all modern
mobile phones have
cameras, so a lot of
people think thata
dedicated camerais
unnecessary. But even if
you have a 5-megapixel
camera phone, any of
these $100 point-and-
shoots will still create
better images—much

2agi
TTEY

better than the pictures from the
iPhone 3G’s 2-megapixel camera. Pixel
count is not nearly as important to
overall results as is lens quality, and
mobile phones simply don’t have

room for a high-quality lens.

Mobile phones also have inferior light
meters, most don't have zoom lenses,

they lack sophisticated image

processing, and they certainly don't have
any advanced photography features,
such as macro support. Theyre also

harder to control when you're

composing shots. While mobile phones

can sometimes yield nicely stylized

images, they all fall far short of any of the

cameras we've reviewed here.
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range, offering a 3.6)< zoom, with the
Canon coming in just behind, at 3.4x.
The rest offer a 3x zoom. Because these
zoom ranges are in the same ballpark,
this feature shouldn't factor hugely in
your buying decision.

All of the cameras also offer digital
zoom, which enlarges your subject by
using a mathematical algorithm to create
additional image pixels. Digital zoom
never works very well because it usually
degrades the image quality, and the
digital zooms on these cameras are no
exception. You'll want to deactivate this
feature when you get the camera.

Like all digital cameras these days, the
models we reviewed all have autofocus.

And they all work the same way: after

your desired composition before you
press the button the rest of the way.

The Canon, GE, and Kodak cameras
have a multipoint autofocus option that
attempts to locate the subject automati-
cally. This feature works well and can be
handy in some situations. On the GE,
you must switch to a different shooting
mode to access this feature (we'll discuss
shooting modes shortly). The Polaroid
lets you switch between a narrow and
wide focusing area, while the Nikon
offers no multipoint autofocusing at all.

Since these cameras will be used
mostly for snapshots, all of them except
the Kodak include a face-detection
feature. Face detection automatically
locates and focuses on a face in your

The $100 cameras that used to dominate the
market had 3 to 4 megapixels. Today a $100
camera can get you 7 to 10 megapixels.

framing your shot, you press the shutter
button down halfway, which tells the
camera to focus and to meter the light.
The camera will then beep or give some
kind of indication that it has locked in the
focus. You then press the shutter button
down the rest of the way, and the camera
takes the picture. All of these cameras
provide quick autofocus, although the GE
is the slowest of the bunch.

Low-light conditions can trip up an
autofocus system. During testing, the
Polaroid performed the best, with

speedy, accurate focus in low light. At the

other end of the spectrum
was the Kodak, which simply
showed an AF warning and
then gave up. It did allow us
to take the picture anyway.
All of these cameras offer a
single-point autofocus mode,
which focuses on whatever is
in the center of the frame. If
you want to focus on
something at the edge of the
frame, you must place that
object in the center of the
LCD, pressing the shutter
button halfway to lock in the
focus, and then reframe for

24 Macworld July 2009

Nikon CoolpixL1g

A4

PROS: Nice design; good
interface; good video quality.
CONS: Detail problems; slight
but correctable color cast; Easy
Auto mode doesn't really work.
PRICE: 3110

COMPANY: Nikon,
www.nikonusa.com

FULL REVIEW: macworld
com/4545

scene. On the four cameras that have
this feature, it worked well.

The GE, Nikon, and Polaroid cameras
also include smile detection. Working in
tandem with face detection, this feature
automatically focuses on a face, but the
camera doesn't take a picture until the
subject smiles. The Nikon automatically
fires when the subject smiles; the GE
and Polaroid require you to press the
shutter button first, but both of them
wait to shoot until the subject smiles.

While this feature does work, it can take
all three cameras a while to detect a
smile—your subject might need to hold
that grin for a long time. In general, this
is a gimmicky feature that shouldn’t be a
key factor in your buying decision, and
you might want to turn it off if you buy a
camera that has it.

The Nikon also provides a continuous-
autofocus feature, which constantly
focuses as you move the camera, rather
than only when you half-press the
shutter button. This feature can be
handy when you're shooting an action
shot, but because the camera is always
working, continuous autofocus can drain
your batteries faster than usual.

Overall, when the camera is shooting
in auto mode, there’s no clear winner
among the models in our roundup. All
did a good job of autofocusing and
choosing exposure settings.

Shooting Modes
All of these cameras offer different
shooting modes, which adjust the
camera settings to suit your shooting
environment. Most people who use a
camera like the ones in our group will
use the auto mode almost all the time.
The Nikon actually has two auto modes.
Its Easy Auto mode tries to assess if you're
shooting in a situation that requires
special settings. While this feature
sometimes works, it also often gets things
wrong and winds up using inappropriate




Polaroid T1031

AL

PROS: Compact design; HD video
support; manual controls; big LCD.
CONS: Low-guality lens makes for
poor image detail; color casts in
most images; no dedicated contral
for changing modes.

PRICE: %120

with the Canon and the
GE coming in with about
the same number. How-
ever, scene modes aren’t
much good if you don’t
use them. With all of
these cameras, you must
wade into the menu
system to select the mode
that's most appropriate to

settings. Fortunately, the camera also

provides a normal auto mode that's akin

to the auto mode on the other cameras.
In addition to auto mode, all of these

cameras offer scene modes, which are

predefined settings tailored to spe-

cific situations. For example, a portrait

Buying Tips

Today’s digital cameras are chock-full of features that make taking
great pictures easier than ever. In fact, the most difficult task you'll
face s picking one camera from the seemingly endless selection
available. Our tips will help you make the right decision.

The Megapixel Myth A high megapixel rating doesn’t mean
better image quality. For example, the camera in our review with
the best image quality had the lowest megapixel rating of the
group. More megapixels does give you more flexibility when
making enlargements or cropping, though.

Zoom In Look at optical zoom and ignore
digital zoom. Optical zoom relies on the optics of
the camera to magnify an image, and it produces
much better image quality than digital zoom.
Digital zoom offers a longer zoom range, but
because it uses interpolation (a mathematical
algorithm that creates dots for an image), the
image quality isn't as good as with optical zoom.

Frame Your Shots All of the cameras in our
review rely solely on the LCD as the viewfinder
and forgo an optical one. In fact, optical viewfinders in general (not
just in $100 cameras) are rarities today.

Camera Modes Point-and-shoots offer shooting modes that
automatically set the camera based on your situation. For example,
a portrait mode keeps foreground subjects in focus. With $100
cameras, you'll most likely rely heavily on these automatic shooting
modes. If you like to tinker with camera settings, look for a
point-and-shoot with manual shooting modes.

scene mode will automatically use
face-detection autofocus, as well as try to
select exposure settings that render the
background softer in order to bring
attention to your subject.

The Kodak, Nikon, and Polaroid
cameras have the most scene modes,

your scene. For example,
the Polaroid offers night
scene, night, and
candlelight modes. The
Nikon’s Easy Auto mode,
meanwhile, tries to
assess the situation and switch to the
proper scene mode. This feature didn’t
work very well, so you're better off
shooting in normal auto mode.

Of all the scene modes available, a
night portrait mode is the most
practical scene mode. This combines a
flash with a long exposure, for times

COMPANY: Polaroid,
www.polaroid.com

FULL REVIEW: macworld
LCOM{4546

Power Play Some cameras use AA or AAA batteries, while
others come with a proprietary rechargeable battery. If you
plan to be out and about with your camera, consider the battery
type and figure out what you'll need to do to have an extra
battery at hand.

File Formats Most $100 point-and-shoots save pictures as
JPEGs, a commonly used file format. Often you can choose the
image quality to use, such as fine or superfine. The better the image
quality, the bigger the JPEG file size, and the more
room the picture will take up on your memory card.

Memory Cards Cameras require amemory card,
usually a Secure Digital (SD) card. The cards that are
bundled with cameras have a small capacity, so you
might want to buy an extra card with a larger
capacity. Some cameras have a small amount of
built-in memory that holds a few pictures, but not
enough to rely on solely.

Software Bundles Almost all point-and-shoot
cameras work with Apple’s iPhoto software for
importing pictures from the camera. You can also access the
memory card using a card reader, and use the card as you would
any other storage device. All cameras come with software, usually
Windows only.

Video Point-and-shoots let you record videos at resolutions of
640 by 480 and/or 320 by 240 pixels. The video quality often isn’t
as good as it is with a dedicated camcorder, but it will do ina
pinch.—ROMAN LOYOLA
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when you're shooting
images of people at
night and you don’t want
the background to
disappear into total
blackness. The Canon
camera was the only one
in our review that didn’t
have this mode.

For users who want
the highest degree of
manual control, the
Polaroid comes out on

Kodak EasyShare Cg13

A

PROS: Nice design; easy to hold;
good feature set.

CONS: Mediocre image quality;
terrible movie quality.

PRICE: $i00

COMPANY: Kodak,
www.kodak.com

FULL REVIEW: macworld
.comf4544

top with the fullest

complement of manual

options. However, all of the cameras in
this roundup include exposure compen-
sation, which lets you tell the camera to
over- or underexpose—an invaluable
feature for handling bright scenes. The
Canon also scores well with its manual
features, thanks to its three metering
modes, which make it easier to handle
backlit situations.

Flash

All of these cameras have a small,
built-in flash with a short range. You
actually don’t want to use the flash in
low light—these types of flash pictures
always look harsh and overblown. If you
can, it’s best to move the subject to an
area with better light, or try using one of

the night scene shooting modes, which
will adjust the camera appropriately.

As odd as it may sound, the flashes on
these cameras act more like fill flashes
and are actually made for shooting in
bright light, when a subject is wearing a
hat or standing in shade. The fill flash
helps the camera capture the details in
the shadows, making for a better picture.
In general, all of these cameras do OK
with fill flash. The Canon’s fill flash was
a little strong, and the Nikon fared the
worst in this regard. The other cameras
all generally produced similar results.

Fortunately, you can disable the flash
on all of these cameras, and each

Point-and-Shoot Cameras Compared

Canon

M
RATING

PRICE

PERFORMANCE *

IMAGE QUALITY Very Good

COLOR QUALITY Very Good

QUALITY Good
SPECIFICATIONS

RESOLUTIO 7.1
MEGAPIXEL

34x/38mm-132mm

BATTERY TYPE two AA batteries

S0, SDHC, MMC, MMC

MEDIA Plus, HC MMC Plus

SIZE (W X H X D, IN INCHES)

41x22x1.6
WEIGHT (IN OUNCES) 58

*Scale is Superior, Very Good, Good, Fair, and Poor.
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0
| PICK| PowerShot Ag70

L1} (11

$110 $100

Fair Goed

80 92

3xf36mm-108mm 3%/36mm-108mm

two A4 batteries two AA batteries
SD,SDHC 5D, SDHC
36x23x1.1 36x24x10

4.7 48

80

3644 1 mm-145mm

provides an auto [SO mode that will
adjust the sensor so it's more sensitive to
light, making it perform better in dimly
lit settings. But the extra sensitivity to
light also means that the camera is more
sensitive to camera shake, and you have
an increased chance of taking blurry
pictures. When shooting in low light
without the flash, the Canon, Nikon, and
Polaroid cameras show an on-screen
warning if they think there’s a risk of
blurring due to camera shake. The GE
lacks this feature, and the Kodak tells you
that an image is blurry only after you take
the picture. When you're shooting in low
light with a high ISO, keep the camera as

GE AS835 Kodak EasyShare Cg13 ‘ Nikon Coolpix L1g Polaroid T1o31

Lil) L1l
$110

$120

Good Goed

100

3x{36mm-108mm

two AA batteries rechargeable lithiumion
5D, 50HC 50,5DHC

38x24x12 3Bx23x07

4.6 46



still as you can to reduce the risk of blur.
Use a tripod whenever possible.

Macro Shots and Movies

For shooting extreme close-ups, all of the
cameras offer a macro feature, with the
Canon providing the best results at
incredibly close distances. The GE was
the next-best performer, and the Nikon
turned in mixed results. Neither the
Polaroid nor the Kodak could get nearly
as close as the other three cameras.

All of these cameras also capture
640-by-480-pixel movies at 30 frames
per second. The Polaroid goes one
better and includes an HD mode that
shoots 1,920 by 1,080 video. The Canon
and the Nikon also allow you to record
movies in macro mode.

In our testing, the Canon had the
best-looking videos, and the GE and
Kodak cameras had the worst movie
quality of the group. The Nikon came
in behind the Canon; its video looked
good, but the Nikon was slow in
adjusting for different lighting situa-
tions. The video quality on the GE and
the Kodak is far worse than the
still-photo quality; images are severely
pixelated and suffer from strange color
artifacts. If you plan to shoot video, you
might want to skip these two cameras.
And while the Polaroid produced
HD-resolution video, its quality still left
much to be desired.

Image Quality

Ultimately, you should pick a camera
based on the image quality it produces.
With this group of cameras, though, you
need to remind yourself that they cost
only around $i00.

One way a manufacturer can lower the
price of a camera is to use a lower-quality
lens, and the lens is the weakness on all
of these cameras, to varying degrees. In
addition to their inability to render fine
details, you'll also find that when you
zoom in, areas of what should be smooth
color are somewhat mottled.

In descending order of image quality,
the Canon scored best with its clean

If you're just looking to print out 4 by
6 snapshots, you'll get decent results
from these cameras. If you have a more
serious eye, you might be bothered by
some image-quality limitations. Overall,
though, the image quality is acceptable
for simple snapshots.

Macworld’s Buying Advice

You shouldn’t be surprised to discover
that a S100 camera has some rough
spots, but you should be pleasantly
surprised to learn that such an
affordable camera packs so many
features. In general, however, these
cameras work best when you skip over

Overall, when the camerais sI:nooting in
auto mode, there’s no clear winner among
the models in our roundup.

images and good metering. The Nikon
came in second, though it had a harder
time metering some situations. The
Polaroid came in very close behind the
Nikon, followed by the Kodak and then the
GE, which lagged noticeably, due to very
bad optics and overall muddiness.

All of these cameras yield images with
a color cast (a shift in colors toward a
certain pigment). In the case of the
Canon, Nikon, and Kodak cameras, the
color cast is slight but recognizable, and
easy enough to correct in iPhoto.

PROS: Good designand
feature set; great macro
capability.

CONS: Weak image quality;
terrible movie quality; jerky

see in bright sunlight.
PRICE: %110

COMPANY: GE,
www.general-imaging.com
FULL REVIEW: macworld
LLOMmJ4543

zoom control; LCD difficult to

the fancier features like smile detec-
tion and stick with a basic auto or
semi-auto mode. Stepping into a
higher-priced category—$200 to
$250—won’t get you more pixels or
features, but you will see a marked
improvement in image quality.

The Canon PowerShot A470
emerges as our top pick. It combines
great overall image quality (which
should be your main consideration)
and a feature set that's well suited
to this market. The Nikon Coolpix
Lig and the Polaroid Tio31 are also
both good contenders based on

their image quality; the Nikon
earns points for its comfortable
design, and the Polaroid for its
low profile.

It's hard to enthusiastically
recommend the Kodak Easy
Share Co13 or the GE A835
because of their mediocre image
quality, but if price is para-
mount, then the GE A835isa
good deal—you can find it
online for about $70.

Macworld Senior Contributor

Ben Long writes about digital
photography at the site www
.completedigitalphotography.com.
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What we’re reviewing online this month

SOFTWARE

Contour 1.1 &
raming: $8¥ > price: $45 company: Mariner

Software urL: www.marinersoftware.com
Contour 1.1 is story-development
software that helps screenwriters build
a structurally sound movie blueprint
that meets the standards of Hollywood
studio development departments and
also satisfies moviegoers. Contour
works much like a software-installation
wizard, asking the user to answer
simple questions and then constructing
the foundation for a feature film in

the process. The application is stable
and easy to use, but some aspects of
it—spelling errors in the interface and
file exporting that doesn’t format your
documents correctly—make Contour
feel like a work-in-progress (macworld
.com/4764).

T g s s s o g by

FontExplorer XPro 2.0 2

rating: SBFH: price: $79 company: Linotype
urL: www. fontexplorerx.com

FontExplorer X Pro 2.0.1 is the most
advanced, capable font-management
tool available. Its iTunes-like interface is
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straightforward and easy to use, and
when you need to customize it, you'll
find hundreds of ways to do so. With
the Application Sets feature, you can
activate certain fonts when a specific
application launches, and then
optionally deactivate them when the
application quits. The program’s Font
Detector can identify fonts used in
many kinds of documents, and then
create a new set from those fonts,
activate them, or even help you
purchase them if they’re not already in
your library. Designers and prepress
professionals will find everything they
need for font management with
FontExplorer X (macworld.com/4765).

Multiwinia1.3 2
rating: $EFT price: $19 company: Ambrosia
Software URL:www.ambrosiasw.com

Multiwinia 1.3 is a 3-D real-time
strategy (RTS) game unlike any other.
You play in a computer mainframe
against your fellow 2-D digital life
forms (Darwinians) in a pixelated war
for supremacy. There are six different
mission types: domination, king of the
hill, capture the statue, assault, rocket
riot, and blitzkrieg. Fach map has
multiplayer support for up to four
players. The graphics are intentionally
eighties retro, and when four armies
are in combat, the game provides some
unique and stunning visions of war.
Cheeky, oddly adorable, and very fun to
play, Multiwinia is a strong RTS game
that has recently been ported to the
Mac (macworld.com/4769).

Portraiture2.0 2
raming: $$¥ ¥ price: $200 company:

Imagenomic URL: www.imagenomic.com
Portraiture 2.0, a Photoshop plug-in,
makes professional-quality portrait
retouching a simple job for anyone using
Adobe Photoshop or Photoshop Ele-
ments, While good lighting, makeup, and
skillful camera work are still essential for
good portraits, Portraiture will add that
last bit of professional oomph to your
images. Portraiture works its effects by
automatically generating a mask for your
image, based on skin tone. The program
also offers some basic image-editing
controls, such as Warmth, Tint, Bright-
ness, and Contrast. These tools allow you
to improve the color rendering of skin
tones, whiten teeth, and conceal stray
hairs and eyelashes (macworld.com/4532).

SiteGrinder 2 Professional
rating: $§$¥: price: $349 company: Medialab
urL: www.medialab.com

Graphic artists and designers who are
comfortable with mocking up Web sites
in Photoshop will love the SiteGrinder 2
Pro Photoshop plug-in. SiteGrinder

Find It Online

For expanded reviews, type
the blue URL at the end of
each summary into your
browser’s address bar.



Successful websites start

Limited Time Offer: Save 50% on select plans. Visit www.1and1.com for details.

Private domain registration ” Everything

is included for O = lnfO you need for
4 per month*

FREE! Srwtn $ 8_99‘. a professional
&J. G website.
first year* (first 6 months)

E-COMMERCE

1&1 BUSINESS PACKAGE

_5.9.—99’
.99

Designed for high performance Set up your online 181 STARTER eSHOP
websites. e e il store and start
Wity selling! - —5‘9'55
i ! ! 4 per month*
i first 6 months,

*Setup fee, minimum contract term, and other terms and conditions may apply. Visit www.1and1.com for full promational offer details. Server prices based on Linux servers.
Private domain registration not available with .us domains. Program and pricing specifications, availability and prices subject to change without natice. 181 and the
1&1 lngo are trademarks of 181 Internet AG, all other trademarks are the property of their respective owners. © 2009 181 Internet, Inc. Al rights reserved.

1-877-GO-1AND1

www.land1.com
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-ﬁﬁ"-"" B e e TimeBridge addresses of the attendees, suggest a few
oy v w rating: §8§ price: free company: TimeBridge dates and time slots, and click on Send.

=H e ", _ uRL:www.timebridge.com Each participant selects his or her
{’ i O - TimeBridge is a Web-based application preferred meeting slot, and TimeBridge
z { e that makes it easy to schedule meetings.  aggregates the responses and chooses the
E l’ l o e O 05 '"' You click on a button to create a new day and time that works best. Time-
= i mace. meeting request, type in the e-mail Bridge has a few bugs when it comes to
":: J - s . ————

LY CUET—

l. I npes » ? hlmlm.

sl ¢ Pl irde_ Tom o I t 4 M
Ly e s - ool Sovon Hasen
;- § ::h: 'E: Comeact Shast 1. n uos

. _— X Actere Sackage 1k

: i By —— L rating: B§EH: price: $349 company:
LY 2 :m Wacom URL: wWww.wacom.com

2f : T - With a drawing area that’s o3 by

[- LS

o] e 53/3inches, the Intuos4 M tablet offers

awhopping 2,048 levels of pressure
sensitivity—great for artists working in
Adobe Photoshop or an illustration
program. The programmable hot keys
feature illuminated OLED (organic light-emitting diode) minidisplays that electronically

creates sites by recognizing Photoshop’s
layer comps as pages and reading
specific hints that you add to the layer
name of each page element. You can

easily create photo galleries with label each key, with either text or an icon, to indicate the function you've assigned to it.
thumbnails and Flash-animated slide The cool-white ExpressKey displays, which float beneath the tablet’s glossy black trim,
shows, or include audio and videos. instantly update to reflect different application-specific hot keys as you toggle from app
SiteGrinder doesn’t have a way to format to app. The Intuos4 M is one of the most ergonomic and easy-to-use pro-caliber tablets
visited links, or to add heading tags or around (macworld.com/4768).

anchors (macworld.com/4771).

(Gacally
Introducing all new

accessories for your mac
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Naw Metting rnyitation

syncing with iCal and Google Calendar,
and it lacks support for Microsoft
Entourage (macworld.com/4772).

G-RAID Mini2SSD

raming: BEFF price: $2,499 (512GE) company:
G-Technology urL: www.g-technology.com

The G-RAID miniz SSD is a portable
RAID that uses a pair of solid-state
drives (SSD). SSDs routinely suffer from
slow write speeds, but the G-RAID
miniz SSD produced some of the fastest
times we've seen in an external drive. Its

biggest drawback is its extremely high
price. The drive has a price per gigabyte
of $4.88—by comparison, a typical
500GB hard drive has a price per
gigabyte between 70 and 8o cents
(macworld.com/4766).

G2210 22-Inch Widescreen Flat
Panel Monitor

rating: §E8: price: $239 company: Dell

urL: www.dell.com

This 22-inch backlit LED display is
manufactured from recycled materials,
and its cabling is free of PVC and other
harmful chemicals. The G2210 has
VGA and DVI connectors but omits
HDMI and DisplayPort. When the
monitor is switched on, a built-in
ambient light sensor detects the level
of brightness in the room and adjusts
the screen accordingly. The G2210
displayed easy-to-read text and nice
color, though on some screens we
noticed some dullness in photos
(macworld.com/4767).

PowerShot A11001S 2

rating: B8F# price: $200 company: Canon
URL: WwWwW.LISa.Canon.com

Offering a nice feature set and very good
image quality, the PowerShot Aunoo IS
is a great starter camera. The camera’s
4x zoom lens offers a very nice range,
from fairly wide to surprisingly tele-
photo (for a camera this small), and
includes special mechanics that can
counteract shake. The color output is
very good, and the lens delivers sharp
images that are free of any discernible
distortion, vignetting, or chromatic
aberration. The camera produces clean
results when you're shooting at settings
up to ISO 400 (macworld.com/4770).

Join our mailing list at

shinn 'gift and
receive a free gift with your next(

bel purchase,

istomn handcrafted cases for iPhone and iPod
www.shinnorie.com




App Store Selections

iPhoneand iPodtouch software that’s caught our eye

GAMES

TheOregon Trail 1.1.8

raTing: $§ ¥ price: 36 company: Gameloft
URL: macworld.com/4750

This iPhone version of the educational
game gets a cartoon makeover that
distinguishes it from past editions while
setting a fun, lighthearted tone. Its
lengthy game play can tax the iPhone’s
battery, but The Oregon Trail makes
excellent use of the phone’s features
(macworld.com/4751).—CHRIS HOLT

SPORTS
MLB.comAt
LAD®SD (Piaying) Bat2009

[ wears | 1,0.1

' 3 rarine: §EET:

PRICE: $10 COMPANY:
MLB Advanced Media
uRL: Macworld.com/
4748
The 2008 edition
of MLB.com At
Bat had just about
anything a baseball fan could have
asked for, except live game audio. That
feature is the centerpiece of the 2009

MLB.com S

version, and it improves upon a great
offering for baseball fanatics (macworld
.COM/4749).—JASON SNELL

More Reviews

PHOTOGRAPHY

Fast Tap Camerai.3

raTinG: $8: pricE: $1 company: Soneso
umL: macworld.comf4752

Soneso’s utility lets you tap anywhere
on the iPhone’s screen to snap a photo.
That’s useful -

if you are
taking a self-
portrait. But
the newfound
capability
slows down
the save times
for images
(macworld.com/
4753).—BEAU
COLBURN

See more iPhone and iPod touch apps we've tested at iPhone Central (macworld.com/4164).

ColorSplash 1.2 Image editor

Hend ueck

iStat1.0 iPhane statistics
Bjango monitor

Pace1.6 Running and
Ron Forrester walking journal
Reunion 1.0 Genealogy-app
Leister Productions companion

Tumblr 1.0 Mabile micre-
Tumblr blogging client

macworld.com/4758 takes you to our review of ColorSplash.
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Typing a find code after macworld.comyin your browser's address field directs you to a product’s review or overview. For example,

CHAT
Skype1.0.3
rating: §35 ¥

PRICE: free company:

) +1555454558

Skype Software urw:
macworld.com/4756
This mobile
version of the
voice-over-1P
client delivers
free voice and
text chats, but
with some

limitations. You
can make Skype voice calls only over
Wi-Fi, and audio quality can vary from
call to call; for now, you must keep the
app open to receive calls. Still, it's a
fine, mostly no-cost way to extend your
communication capabilities (macworld
.COM/4757).—JOHN BRANDON

MUSIC
Radio Paradise 1.4
rating: BPFF} price: free company: Stormy
Productions urL: macworld.com/4754
This slick Internet radio application
provides an eclectic mix of streaming
audio at three different bit rates—24
Kbps, 64 Kbps, and 128 Kbps—auto-
matically choosing the best stream
based on available bandwidth. The app’s
appealing Tunemark button lets you
create a bookmark, e-mail a link with

' informa-
tion on a
currently
playing
track, or
buy that
track from
the iTunes
Store
{macworld
.com/4755).
—JEFFERY
BATTERSBY



Mal‘.WI]ﬂd iPhone App Showcase

s " CameraBag

9 vinta ameras in one iPhone app

Battery Burner

Draining your battery completely after recharging your
device 100 times will help maintain your battery’s health.
This application will drain your battery extremely fast using
multiple methods. Download Now.

Find it now! www.macworld.com/4803

i ,]l

AENEREEN
|

I

Smart Recorder - Perfect for recording meetings or short
audio memos. Travel Diary - Record the story of your
vacation. Take pictures with time and location stamps,
add notes, create HTML pages, export to Facebook.

Find it now! www.macworld.com/4806

Anti Mosquito

Essential App for Summer! High frequency sounds
generated by Anti Mosquito stop mosquitoes flying
around you. Anti Mosquito works in sleep (lock) mode,
also ‘Kids-Safe’ and ‘Fluctuation’ modes are supported.

Find it now! www.macworld.com/4802

Now you can EXCEL

on your iPhone.

— e — . - s
[ e -;..r-- — [

Introducing Mariner Calc for iPhone.

* View native Mac or Windows Excel files
* Edit native Mac or Windows Excel files

* Wirelessly transfer files to and
from your computer

Mariner Calc
for iPhone

www.marinersoftware.com

32,000 by 256 column support
* Supports cut, copy, paste, undo, redo
* |45 functions!

* Support for multiple sheets
n ﬂ.-h

Introductory offer :

i(tmmmo

Brilliant RTS and Tower Defense gameplay modes.
Original soundtrack and graphics. Voice acted storyline.
One epic iPhone adventure!

K" hitp://www.macworld.com/4805 \ﬂ;

iRec Voice Recorder

&

iRec Voice Recorder is the most powerful profes-
sional recorder application available for the iPhone/
iPod Touch.

Find it now! www.macworld.com/4804




Top Products

Your guide to the best hardware we've tested. See more at macworld.com/reviews.

=

\ — Multifunction

PRODUCT FIND CODE
Pixma MX850 (pictured) L1 1 FR i) ink-jet 3503
WWW.Canon.cam

Photosmart C7280 {111} $199 ink-jet 3581
L'J'W\'J..']F].C\':l[:'"

Desktopand Portable
PRODUCT
Mercury On-the-Go 88 5165 portable 4258
(pictured)
www.macsales.com
My Book Studio Edition  ##8%)  $110  desktop 3205

wwwwesterndigital.com

High Definition

PRODUCT FIND CODE

HDR-SR11 HandyCam (111} $823 hard drive, 3731
WWW.SaNY.com {pictured) Memary

Stick
Vixia Hvzo [11]] %559 MiniD 3708

WWW.Canan.com

RATING: $§§¥ PRICE: 5989 comPANY: Apple URL: W .2pPIE.COM FIND CODE: 4357

Why We Like It:

While Apple has reengineered most of its
MacBook and MacBook Pro laptops with an
all-aluminum unibody design, the revamped
2GHz MacBook Intel Core 2 Duo instead
offers awhite polycarbonate exterior for
aretro look. This white model is the least
expensive of the line and is also the only
one to offer FireWire 400 connectivity and
amatte screen. Its Nvidia GeForce

9400M graphics

system makes it a

surprisingly power-

ful model as well.

ALSO CONSIDER: 2.4GHzMacBook; §§§¥; $1,299; macworld.com/4187

1entand Flatbed
FIND CODE

ScanSnap S510M (pictured) 111 PR

WA, fLIji tsu.com

document 3321

Perfection V300 Photo LLLL I flatbed 4071

WWW.EPSON.COM

E Point-and-Shoot

PRODUCT FIND CODE
EX-z250 (pictured) {11]] $160 9.1- 4256
wWww.casio.com megapixel

PowerShot SD88o IS (111] $228 10- 4257
WWW.CANON.CoM megapixel

- Desktop and Portable

PRODUCT FIND CODE
Portable DVD+RW #8868  $100  portable 3878
wj LightScribe (pictured)
WWW.IRCH.COMm
d2 DVD:RW w/LightScribe  $888 590 desktop 3900
www.lacie.com

Laptop Shopping Guide

s One of the major features that
differentiates the various Mac
laptops is connectivity. Users
who need to transfer a lot of data
quickly should turn to laptops that
have FireWire ports.

o MacBook Pros offer higher-end
features for the more professional
user, such as faster connection
types, faster processing, and more
powerful graphics cards.

» People who use their laptop only
for word processing and Internet
connectivity may want to consider
the more basic models of the Mac-
Book or MacBook Air lines.

2.66GHz MacBook Pro; §§##;$2,670; macworld.com/4490

TOP PRODUCTS are those we've recently reviewedina comparison of like products, As new products become available, we'll update thislist. For longer reviews of these products and for other
product recommendations, goto macworld.com/reviews. All prices are the best current prices taken from a PriceGrabber survey of retailers as of May 13, 2009. FIND CODES: Inabrowser’s address
field, typing infind codes after macworld.com/quickly takes youto a product's review or overview. For example, you canfind our review of the Apple MacBook 2GHzat macworld.com/43g7.
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Widescreen

PRODUCT

324 LCD (pictured) 89 5899 24-inch
www.iacle.com dlspla}'
LP3065 L11]] $1,077  3c-inch
www,hp.com display
MultiSync 3090WQXI1 $¥¥8) $2173  30-inch
wwwinecdisplay.com display

PRODUCT

C6150dn (pictured) L111 BTy LED; color
www.ckidata.com

HL-4070CDW e 5349 PostScript
www brother-usacom cempatible
Cs544dn e 332 LED; color
whwnw lexmark.com

Macs

DESKTOP

$1,076 20inches

Intel Core2 Du/266GHz  §##1
111
L1
111

Intel Core 2 Duo/2.66GHz %1400 24inches

Intel Care 2 Dug2.93GHz %1700 24inches

Intel Care 2 Dug/3.06GHz %2119 24inches

Intel Core 2 Duof2GHz ¥E88 5559 not
(120GE hard drive) included
Intel Core 2 Dug2GHz 1115 %770  net
(320GB hard drive) included
Intel Xeonyquad-core BE8S: 32376 not
2.66GHz included

$3,299 not

included

Intel Xeon/two quad-core
226GHz

Ll

256

270

297

189

202

348

343

FIND CODE

FIND CODE

3899

3385

4356

4487

4488

4503

PORTABLE

(NEYS:NNI (ntel Core 2 Dugf2GHz 111 13inches 186 4397
(white)
IntelCore2Ducf2GHz ~ §##¥  $1,099 13inches 195 4186
IntelCore2Duof24GHz ~ §§¥  $1,29% 13inches 212 4187

UETS:LLY IntelCore2Duof1.6GHz - §##:  $1549 13inches 153 4191

MFE Intel Core 2 Dugh.B6GHz  §8§1 $2,149 13inches 174 4192
IntelCore2Duc/24GHz ~ $§§8  $1699 15inches 215 4188
IntelCore2 Duof266GHz  §§8¥  $2,375 15inches 235 4489
Intel Core2 Duo/266GHz - §889 %2670 17inches 224 4490

*Speedmark 5is Macworld Lab's standard te:
information on Spesdmark testing goto

$570

EOS Rebel XSi (pictured) (1118 12-megapixel  3g9g
Wy on.com

D4oDSLR (111 ] £710 61-megapixel 2408
www.nikonusa.com

D300 DSLR $888: 31725  123megapixel 3434
wwwinikonusa.com

FIND CODE

PictureMate Zoom [ 111 PR3] compact; 3102
PM 290 (pictured) photo
Www.epson.com
Deskjet D2545 (11 $59 inexpensive; 4067
www.hp.com general

purpose
Stylus Photo R1g00 88 3410 professional 3649

photo quality

WWW.EpsSon.Ccom

iPods

120GB PR 5200 25-inch 36 hours of 3863
color music playbaclk;
6 hours of video
playback
8GB ks 3214 35-inch  36hoursofmusic 3864
color playback; & hours
ofvideo playback
16GB 111 1 B2 35-inch  36hoursofmusic 3865
color playback; & hours
ofvideo playback
32GB #8888  $369  35-nch  36hoursofmusic 3866
color playback; & hours
of video playback
8GB 1111 FR-AI] 2-inch 24hoursof music 3867
color playback; 4 hours
ofvvideo playback
16GB g8 5199 2-inch 24hoursof music 3868
color playback; 4 hours
ofvideo playback
4GB 111] %79 none 10hoursof music 4491

playback
iPHONE

iPhone 8GB s 5199 35-inch  Shoursof3G 4184
3G color Internet; 5 hours
of3Gtalk time
16GB FE8s 5299 35-inch  Shoursof3G 4185
color Internet;5hours
of 3Gtalk time
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Mac Gems

Discover great, low-cost Mac products BY DAN FRAKES
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Better PDF Browsing PDF Browser Plugin gives you more options for navigating and viewing

online PDFs.

PDF Browse

rating: B§¥§ price: free for noncommercial use
compaNY: Schubertlt urL: www.schubert-itcom

Most modern Web browsers offer basic
PDF-reading capabilities, and if you've
installed Adobe software, you've likely
got additional functionality thanks to
Adobe’s browser plug-in. But my favorite
alternative is PDF Browser Plugin. Once
you've installed it, clicking on a PDF link
on a Web page loads the document in
your browser window. But instead of just
the basic commands—in the case of
Safari, zoom, save, or open in Preview—
you get a slew of additional features.

Go to Weblog

Read Mac Gems online
(macworld.com/macgems)
for longer reviews of these
and other products.

36 Macworld July 2009

r Plugin2.3

For example, your browser now
displays the PDF document’s table of
contents (if one exists) and lets you
navigate sections. A new PDF toolbar
lets you open the PDF in Preview or any
other program; save or print; display the
PDF as individual pages; and more.

PDF Browser Plugin also works with
protected PDFs, letting you provide a
document’s password to view or print it;
it displays annotations if a document
contains them; and it allows you to insert
text into forms right in your browser. One
of my favorite features is split view, which
lets you view two different parts of the
current document simultaneously.

One feature I couldn’t get to work was
PDF Browser Plugin’s custom print
options, but my biggest annoyance is
that you can't scroll through a PDF using
your mouse’s scroll wheel or your
trackpad’s scrolling gesture. Still, it's a
great Web browser add-on.

PUBLISHING

CUPS-PDF 2.4.6.1

rating: $§¥ 3 price: free company: Codepoetry
URL: Wwww.codepoetry.net

One of my favorite Mac OS X features is
the capability to “print” to a PDF file via
0S X’s Print dialog box, but I wish it
were more efficient. Saving a document
as a PDF requires that I press $-P,
mouse down to the PDF button and click
on it, choose Save As PDF from the
resulting menu, navigate to the desired
folder, and then press Return.

Codepoetry’s CUPS-PDF is a virtual
printer driver that lets you create a
“printer” that will save documents as
PDF files. Once you've set up this
printer, your new PDF printer appears in
the Printer pop-up menu in every Print
dialog box. Choose it and click on Print
to create a PDF of your document in a
new CUPS-PDF folder on your desktop.
If, like me, you save to PDF more than
you print to paper, you can set your
virtual printer as the default through the
Print & Fax preference pane; this makes
saving documents as PDF files as easy as
pressing #-P and then Return.

CUPS-PDF is also useful for converting
documents to PDF format. If you place
your CUPS-PDF printer (located in
yourusetfolderLibrary /Printers) in the
Dock, or create an alias of it on the

a0 (=]
[ o gl KU
Sywe Py Barjaur
Narme  CUPS-POF
Location
Brint Using | Select a driver 1o use ]
. — =
o Seybus Pt Sevs, 13 =
Canarc PCL Lasar Priesar, 1.3 =
Canene Posongs Premer, L3 *
WP Desiint S, 1) :
_Add )

PDF Creator CUPS-PDF letsyou createa
virtual printer that saves files directly to PDF,
saving you the multiple steps usually required.



He was a
hardworking farm boy.

She was an
Italian supermodel.

He knew he would

have just one chance
to impress her.

The fastest and easiest

way to learn ITALIAN .

Arabic « Chinese (Mandarin) » Danish « Dutch « English (American) -Engllsh (Bntlsh] French « German » Greek « Hebrew « Hindi
Indonesian - Italian « Irish « Japanese * Korean « Latin « Pashto + Persian (Farsi) = Polish » Portuguese (Brazil) » Russian
Spanish (Latin America) « Spanish (Spain) « Swahili « Swedish « Tagalog (Filipino) * Thai * Turkish « Vietnamese « Welsh

Rosetta Stone* brings you a complete language-learning solution, wherever you
are: at home, in-the-car or on-the-go. You'll learn quickly and effectively, without
translation or memorization. You'll discover our method, which keeps you excited
to learn more and more.

* YYou'll experience Dynamic Immersion- as you match real-world images to words
spoken by native speakers so you'll find yourself engaged and learn your second
language like you learned your first

= Qur proprictary Speech Recognition Technology evaluates your speech and
coaches you on more accurate pronunciation. You'll speak naturally. SAVE 10 /O. __

* Only Rosetta Stone has Adaptive Recall; that brings back material to help you 100% GUARANTEED
where you need it most, for more effective progress. SIX-MONTH MONEY-BAC
* And Rosetta Stone includes Audio Companion- so that you can take the Level 1 Reg-$259 NOW $233
Rosetta Stone experience anywhere you use a CD or MP3 player. Level 182 Reg-$419 NOW $377
Innovative software. Immersive method. Complete mobility. It's the total solution. Level 1,2&3 Reg—$549 NOW $494
Get Rosetta Stone—The Fastest Way to Learn a Language. Guaranteed. \ J

@I008 Rnsetta Stone Lid. All rights reserved. Offer applies o Personal Editian only, Patent rights pending. Offer canmot be combined with any ather offer, Prices subject to change without notice. Ste-Month Money-Back Guarantes is limited fo product purchases made directly from Rosetta Stone and does
nok include retwm shipping. Guarantee does rot apply tn 2n anline sebscription or fo Audin Campanion purchased separately from the CO-ROM peoduct. AN materials included with the product at the time of purchase must be retumed tngether and undamaged fo be eligible for any exchange ar refund,

RosettaStone @

(866) 426-2394 RosettaStone.com/ozs079

Use promotional code 0zs079 when ordering.
Offer expires October 31, 2009.

Call Online ‘
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Calendar Weather \WeatherCal puts the weather on your calendar with ease.

desktop, you can drag most documents
onto the printer icon to save a PDF version
automatically in your CUPS-PDF folder.
The biggest drawback to CUPS-PDF is
that the PDF files it creates are larger than
those that OS X’s built-in Save As PDF
feature creates—sometimes twice as big.
But for me, that difference is offset by the
convenience of automatic PDF creation.

LIFESTYLE

WeatherCal1.0

rating: §88: price: $10 company: Bare Bones
Software uRrL: www.barebones.com

If you use OS X’s iCal, or any calendar app
that syncs with iCal, WeatherCal makes it a
snap to add local weather to your calendar.

WeatherCal works as a System
Preferences pane. It's easy to add or
remove a city, and once you've added a
city, WeatherCal creates a calendar in
iCal for it. In that calendar, WeatherCal
adds an “all-day” event for the current
day and for each of the next five days;
the name of each event is that day’s
forecast, taken from WeatherUnder-
ground.com. An icon, such as a cloud,
represents the day’s conditions.

If you view the details for a weather
event, you'll see a link that leads you to the
city’s full forecast and weather conditions
on the Weather Underground site.
WeatherCal checks for forecast informa-
ton every hour, updating your calendar
events with any changes; it deletes prev-
ious days’ forecasts so that they don’t
clutter up your calendar. Because Weather-
Cal uses Leopard’s CalendarStore database,
you don't have to keep iCal running for
such updates to occur, and you can imme-
diately sync the changes WeatherCal
makes to any devices or other Macs you've

Our Mac User Support

MacHighway’

Real Web Hosting for Mac Users,
by Mac Users, Since 1997

Their Mac User Support

We've been providing web hosting to thousands in the Mac

photo: Sean Harigrove (www.seanharigrove com) MacHighway s a registered rademark of Calegory 89, Inc. All Rights Reserved. Mac is a registered trademark of Apple. inc

community with unsurpassed quality and service for more than 12
years. Host your site for as lillle as $29.95/year. All customer
support is handled by our slaff in Denver, Colorado, USA

www.MacHighway.com | 1-800-4604-99460

ity L By

renewable cholce
ENERGY




set up to sync with iCal. WeatherUnder-
ground.com provides roughly similar
functionality via iCal calendar subscrip-
tions, but WeatherCal’s approach offers
better reliability and ease of use.

:Chp Lyrics1.3.3

raTinG: $$§ price: free company: Luigi

Cavalieri urL:w

Adding lyrics to your iTunes music is a
hassle; select the track, choose File » Get
Info, click on the Lyrics tab in the Info
window, type or paste the lyrics into the
large text field, and then click on OK. So
instead, I turn to iClip Lyrics.

For each track that plays, iClip Lyrics
shows the lyrics if they exist in iTunes;
otherwise, it uses the track and artist
names to search LyricWiki.org. If it finds
lyrics, iClip Lyrics displays them and
adds them to the current track’s ID3
tags. If you leave iClip Lyrics running all

iClip Lyrics

Ana Ng

Make a hole with a gun perpendicular

To the name of this town in a desk-top globe
Exit wound in a foreign nation

Showing the home of the ane this was written for
My apanment looks upside down from there
Water spirals the wrong way out the sink

And her voice is a backwards record

It's ke a whirlpool and it never ends

Ana Ng and | are getting old

And we still haven walked in the glow of each
olher's majestic presence

Listen Ana hear my words

They're he ones you would think | would say i
there was a me for you

All alone al the 84 World's Fair
Eighty dolis yelling “Small girl afer all”
O AT R e

i

Lyrical Searches With iClip Lyrics, getting
the lyrics to your favorite songs into iTunes s
abreeze.

the time, you end up gradually adding
lyrics for much of your music.

If LyricWiki doesn’t have the lyrics, a

click on the search button searches

Google and opens a Clipboard drawer. If

you find your track’s lyrics via the Google
search, just select and copy the text; it's
automatically pasted into the iClip Lyrics
Clipboard drawer. Assuming the text is
correct, a click on the Paste Lyrics button
applies it to the current track.

For faster addition of lyrics, you can
use the No Lyrics To Playlist 2.0 script
from Doug’s AppleScripts for iTunes
(dou

gscripts.comjfitunes) to create a new
iTunes playlist containing all tracks that
don't have lyrics, and then use the
Needle Drop script, from the same site,
to play just a few seconds of each song in
that playlist, letting iClip Lyrics do its
thing all the while. Until Apple finally
strikes a deal with the music industry to
let iTunes grab lyrics for the tracks in
your library, iClip Lyrics is a great tool to
have in your music toolbox. &

Senior Editor Dan Frakes is always looking
for great, low-cost products. Send him your
comments and suggestions at macgems@
macworld.com.
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How to diagnose and fix common Mac
problems without visiting an Apple Store

TROUBLE-
SHOOT

LIKE A GENIUS

ou can count onit. Sometime, probably when you least expect it,

something will go wrong with your Mac. If you can’t figure out howto

fixthe problem yourself, you'll be forced to beg for help from alocal
computer genius—whetherit’safriend or relative or, if you live near an Apple
retail store, someone who dispenses advice from behind a counter.

But I'lllet you in on a little secret: you, too, can be a Mac genius. Trouble-
shootingisn’t magic. It’sa skill that any experienced Mac user can cultivate.
By arming yourself with the tools and tidbits that I've compiled in this
article, you willin many cases be able to fix your computer by yourself
rather than havingto ask for help.

Ill show you how to diagnose and remedy common problems on your
own, as well as figure out when matters have gotten beyond your capabili-
ties. Andin case you really do end up needing to take a trip to the Genius
Bar, I'll also show you how to prepare so that you can maximize your results

inaminimum of time.

ByTed Landau ILLUSTRATIONS BY HUAN TRAN
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ne thing every good genius
O knows is that sometimes what

looks like a complete computer
meltdown actually has a simple fix. Here
are a few tried-and-true remedies you
shouldn’t forget in the rush to try
more-complicated and possibly unneces-
sary troubleshooting techniques.

Restart Yup, simply choose Restart
from the Apple menu. It's amazing how
often this can eradicate whatever was
bothering your Mac. Always try it first.

You may be able to save time by
instead quitting all the applications that
you don’t need to keep open. If the
problem you're experiencing comes
from your Mac’s having too little free
memory, this might be sufficient to get
the gears turning again. Web browsers
in particular can eat up a lot of memory.

Repair Your Disk If it doesn’t appear
that a single application is causing your
troubles—for example, if all applications

QUICK FIXES

YOU SHOULD NEVER SKIP

crash on launch—try repairing the drive
using Disk Utility (/Applications/
Utilities). Open the utility, click on the
First Aid tab, and then click on Repair
Disk (see “First Aid for Failing Macs”).
Unfortunately, if the problem drive is
your startup disk (which is almost always
the case), you'll run into an immediate
dilemma: the Repair Disk button will be
dimmed and you won't be able to select
it. To find out how to circumvent this
obstacle, see “Repair Your Startup Disk.”
Make Sure Things Are Up-to-Date Does
a particular program consistently crash
whenever you try to perform a partic-
ular action, such as saving a file? If
the symptom doesn’t occur with any
other applications, check to see
whether there’s a newer version of the
problem software. Oftentimes, the new
version fixes some bug (or some
conflict with other software) that is
causing the symptom.

= [Fnemid . i —
5 233.5 GB Mator 7¥250M0 e A0 Aewens
SIONA2 ¥ you're having trouble with the selected disk:
» Click Repair Dk If the repalr fails, back up and erase the dik.
2 233.5 GB Maxtor 7Y250M0 -a?&mnmmmmnrﬁ?MMmﬂummm
DNA
_’ W you have & permisiioni probiem with a e imstalied by the Mac O X imtaller, click Repair
3 Darwin Permessions.
£1232.9 GB LaCie Group SA
Il Muttimedia W Show details
£1232.9 GB LaCie Croup SA  Checking Dxtents Overfiow Fle. =
. ) - Checking Catalog file
. B8 Ml o Checking muln- linked files
% T35Tcorp CO/DVOW SH-W... Checking Catalog higrarchy.
| /5 MATSHITA DVD-RAM SW-9... Checking Extended Atiributes .
Checking volume bitmap.,
Cheching volume information.

i Mount Point . /Voumes/Darmin 2
Format : Mac O3 Extended Journaled)
Owners Enabled : Yes
@ Number of Folders : 28,955

2 appears 10 be O

[ Mwpair Dak Permizuom |

-

+ 122.5 CB{131,544.068.096 Bytes)

Capacity
Avallable : 28.6 GB (10,694,780,352 Bytes)
Used : 3.9 CB (100,548,287 744 Bytey)
Number of Files : 159,126

First Aid for Failing Macs Often you can solve seemingly complicated problems with simple
techniques. For instance, use Disk Utility’s First Aid feature to check whether a drive’s directory isin

working order.
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Many programs can now automati-
cally check for updates upon launch.
Take advantage of this option—if you see
a dialog box asking whether you want to
check for updates, accept the offer. Other
software comes with a separate update
utility that can launch on a schedule—
say, once a week. For example, look for
the Microsoft AutoUpdate program in
your Applications folder if you want to
check any of your Office programs right
away or set up a schedule.

To check for updates from Apple,
select Software Update from the Apple
menu. You can set Software Update’s
preferences to alert you to new updates
when they're available.

For a program that doesn’t offer this
sort of help, use your Web browser to
check for an update, by going either
to a site such as VersionTracker (www
versiontracker.com) or to the company’s
Web site.

Reinstall If the misbehaving software
turns out to be the latest version, there’s a
chance your copy of it may be corrupted.
In that case, it might help to reinstall the
software, by either downloading it from
the Web or pulling out your original CD.

Unfortunately, reinstalling won't fix
problems involving a program’s support
files. For example, numerous programs
place files in youruserfolder/Library/
Application Support. Simply replacing



the main program won't replace these
support files. Sometimes even using an
application’s installer won’t root out the
problematic files.

If the program came with an uninstall
utility, uninstall and then reinstall the
app. Otherwise, you may need to search
for support files (in Spotlight, search for
items that contain the application’s
name) and remove them before you
reinstall the software.

DoaSafeBoot If your Mac crashes
when you turn it on, hold down the Shift
key at startup until you see the words
Safe Boot appear on screen. In Safe Boot
mode, the Mac performs checks and

ou've tried all the quick fixes,
Y with no luck. How can you

sidestep the complicated parts of
the troubleshooting process and zero in
on an easy solution? Search the Web.
With a bit of luck and a dash of persis-
tence, you will succeed most of the time.

Start with Google If you can type in
the exact text of your error message or
otherwise summarize your problem
using a few keywords, you're especially
likely to get helpful results using Google.
Use quotes to enclose exact phrases; this
reduces the number of unwanted
results. For example, if you type in the
error message "the Preferences
File Could not be opened. The
end of file was reached. -39",
you'll get the useful Microsoft Entourage
Help Page (macworld.com/4600), which
tells you what to do if you have a dam-
aged Identity database file. If you instead
just type Entourage -39, you'll have to
wade through a lot of information about
HBO's Entourage series.

Try Support Sites If Google comes up
empty, search the support sites for the
products that are giving you trouble. For
0S8 X in general, or for any Apple

makes repairs, much as it does when
you run Disk Utility’s Repair Disk
feature. It also deletes the dynamic
loader shared cache, a known cause of
some “blue screen” startup crashes.

Safe Boot may restore your Mac to its
old self with the next normal restart—even
if you do nothing else, It's at least worth
a try. Even if your problem remains,

a successful Safe Boot enables you to
temporarily bypass the startup crash so
that you can now do further troubleshoot-
ing—muodifying or moving files as
described in the remaining sections of this
article. After you're done troubleshooting,
restart your Mac normally.

THE BIGGEST TROUBLESHOOTING

SHORTCUT

products, there's no substitute for
searching Apple Support (www.apple
.com/support). The Discussions threads,
for instance, often include reader tips for
fixing problems that Apple may not yet
have officially acknowledged.

The Apple Support site gives you a
number of ways to home in on the

'TED’STOP @ |

TIPS

Here are the two things I’d recom-
mend if you want to become your
own Genius:

Expand Your Knowledge Some-
times your Mac’s hardware or
_./-_

software isn’t the problem.
Rather, you just don’t
know enough about
how the program or
device works. As
one example,
here’s a Finder
“problem” that
often perplexes
users:; when you
inserta CD, the
disc’s icon does not
appear on the desktop.
What's going on? Often
the solution is simple—as in this
case. Navigate to Finder » Preferences,
click on General, and enable the option
to show CDs, DVDs, and iPods. Try
searching your Mac’s or the program’s
help files to find these sorts of answers.
Restart, Unplug, Replug
Restarting your Mac can be a cure
for awide range of symptoms. The
same principle applies to any other Mac
hardware: a good first troubleshooting
step is to unplug the component and
then plug it back in, This is typically the
equivalent of a restart for that device.
For example, for any USB or FireWire
device (such asa Web camoran
EyeTV), disconnect it from its USB or
FireWire port, and then reconnect it. If
that doesn’t fix things, and the device is
connected to AC power, disconnect
and reconnect its power source. As you
are doing this, you can check in with
System Profiler (/Applications/Utilities).
If you don't see the device listed, it
means the Mac is currently unaware
that the device is connected. After each
unplugand replug, select Refresh (3£-R)
from System Profiler’s View menu to
see whether the device appears. It
usually will. If not, you may have a dead
port,abad cable, or a defective
peripheral device.
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Find Answers with Apple Support Looking for help? The Web might hold the answer. The Apple
Support site lets you search using Boolean search operators such as AND, NOT, and OR. To drill down
further, you can limit your search to a certain product family @Y. The site also gives you visual clues
about what sorts of information you've uncovered. For instance, speech bubbles indicate informa-
tion from the user forums, while a stethoscope icon indicates troubleshooting documents (B}

answers you seek. For example, like most
search engines, it allows you to use
Boolean operators. Include the word AND
when you want to search for documents
that include both of your search
terms—machook AND battery.
Likewise, use OR to find either of two
terms and NOT to exclude a certain term.
Enclose specific terms with quotation
marks. Also take advantage of the site’s

REPAIR YOUR @

STARTUP DISK

Disk Utility’s First Aid feature represents
one of the oldest and most helpful repair
utilities available for your Mac. But before
you launch the application, a word of advice:
First Aid cannot repair an active startup
drive. That’s why you won’t be able to click
on the Repair Disk button when you select
your startup drive for repair. There are
several ways to deal with this issue.

Click on Verify Disk The Verify Disk
button usually works even if Repair Disk
doesn’t. Click on it if the option’s available. If
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ability to limit your search to certain
products. After you type in your search
string, you may see a blue circle with a
plus sign (+) in it next to the words
“Improve your search by selecting a
product.” Click on this to reveal images
of Apple’s product line. Choose one to
limit your search to just that product.
You may also find it useful to
familiarize yourself with the icons

the results say that everything is OK, you

can bypass Repair Disk. Unfortunately, using

Verify Disk for the startup drive is a bit
buggy; you may find that the program stalls
and never gives you any results.

Start Up from Another Drive Start up
from the install DVD that came with
your Mac (or a more recent
version, if you’ve purchased
one). Select Utilities » Disk
Utility. From here, you can
choose Repair Disk for your
normal startup drive.
Alternatively, you can start
up from a secondary
bootable drive if you have
one with Disk Utility installed.

articles you've uncovered with your search
(macworld.com/4601). For instance, if one
of your results has a stethoscope icon next
to it, it's a troubleshooting document (see
“Find Answers with Apple Support”).

Be Prepared for Some Frustration Not
every fix you find online will actually
work, at least not for your particular
variation of the problem. And don’t
assume that just because a user posting
says you must do something extreme,
such as erase your hard drive, it's
absolutely necessary. Less radical
solutions may exist. Read through
several postings on a subject before
deciding on a course of action. Start with
the simplest, least time-consuming
solution, especially if there appears to be
a consensus that it works.

Using the Web, you'll find solutions that
you would never discover on your own,
no matter how many hours you spend on
do-it-yourself troubleshooting. For
example, an Apple support article
(macworld.com/4602) describes what to do
if the Finder refuses to let you rename a
file, claiming that you don’t have “suffi-
cient access.” Part of Apple’s solution
requires that you enter the following com-
mand in Terminal (/Applications, Utilities)
and press Return: sudo chmod -RN ~
Unless you're experienced with Unix (and
perhaps not even then), this isn't some-
thing you'd think to do on your own.

If First Aid found problems and success-

fully repaired them, it should automatically

run a second time. Afterward it should
report that all is OK. Keep running Disk
Utility until the results state that no repairs
are needed or until it claims to
be unable to fix the problem.
Use Single-User Mode If
you can’t locate an install
DVD and you don’t have a
second bootable drive, you
can attempt to start up from
your default drive in single-
user mode,
To do so, hold down #£-S at
startup. If all goes as expected, the
Mac enters a command-line mode that



not ready to quit, it's time to focus

on finding the cause of the problem
instead of just getting rid of the
symptoms. With any luck, what you
find may eventually point the way to a
solution. At the very least, you'll gather
diagnostic information that may prove
valuable if and when you wind up at the
Genius Bar.

Usea Troubleshooting Account When
your computer is running smoothly, it's

I f the Web fails you and you're still

a very good idea to set up a separate
troubleshooting account using the
Accounts preference pane. Leave this
account untouched and unused until
things start to go awry (see “Try a
Different Account”).

Suppose an application keeps
crashing on launch. Log in to your
troubleshooting account by selecting
Log Out username from the Apple
menu and then selecting the account
from your login screen. Launch the
troublesome application. Does it
launch successfully now? If so, you've
discovered a critical piece of informa-
tion. The cause of the crash is almost
certainly some file within your Home

TRACKING DOWN THE

SOURCE OF TROUBLE

directory—the folder that holds all the
files for your usual user account. (Your
Home directory is labeled with a
house icon and your user name.) You
can move on to the next troubleshoot-
ing step.

Know When to Quit On the other
hand, if you use a different account and
the crash still occurs, you've learned that
the source of the problem is probably
outside your Home directory. As you've

My ALCOW
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Test Case
Asbrw.m

presumably already tried reinstalling the
application to no avail, the problem is
most likely in either the /System/Library
or the /Library folder—or perhaps one of
the invisible Unix folders. Fixing these
types of problems can be tricky. If you're
feeling intrepid, one of OS X's trouble-
shooting utilities may help (see “Apple’s
Advanced Troubleshooting Utilities”).
For many people, though, a problem of
this type merits a visit to the Genius Bar.

L Guest Account

User Name: Test Case

MobileMe User Name:

[ Enable Parental Controls

(&} Login Options

-

d‘ Click the lock to prevent further changes.

™ Allow user to administer this computer

Open Parental Controls...

Try a Different
Account Toseeif
the source of a
problem extends
beyond your
Home directory,
logintoa
troubleshooting
account (such as
@ the Test Case one
shown here).

looks as if you’re running an odd version of
Terminal. Happily, you don’t need to know
any Unix to get the job done. All you have to
doistype /sbin/fsck -fy.The
resulting output will be similar to what you
see when running Repair Disk from Disk
Utility. If the utility reports that your drive is
OK, or that it successfully made repairs,
type reboot and you’re back in business.

Kristofer Widholm’s free AppleJack
(§88¥; macworld.com/4249) makes
single-user mode a bit more user-friendly. If
you had the foresight to install it, type
applejack at the prompt. From the menu
of options that appears, select repair
disks. Its other menu choices offer
additional repair options.

Try Safe Boot When you hold down the
Shift key at startup, your Mac does a Safe
Boot. The directory check this routine
performs is essentially the same as running
Repair Disk, except that you don’t get any
feedback as to the results. That means you
can’t confirm whether your Mac needed
repairs or whether repairs were successfully
made. Still, as long as performing a Safe Boot
cures your Mac, that probably doesn’t matter.

If Nothing Works If one of the utilities
reports a problem but can’t repair it, use a
more robust repair program, such as
Alsoft’s $100 DiskWarrior 4 (§$§§¥;
macworld.com/2503) or Micromat’s $98
TechTool Pro 5 (§$##; macworld.com/
4606). If this fails, reformat your drive and

restore from backup. If you can’t reformat
the drive, you need to replace it.

Skip Repairing Permissions Disk First
Aid includes an option to Repair Disk
Permissions. This is a different and entirely
separate procedure from Repair Disk.
Essentially, Repair Disk Permissions returns
to their default values the Unix permissions
that Mac OS X installs for all files. This
operation can remedy cases where you
can’t open, move, or delete files because of
insufficient authorization. Otherwise, it will
likely have no beneficial effect. | rarely
bother with it. (To learn more about exactly
what repairing permissions does, see
“Repairing Permissions: What You Need to
Know” at macworld.com/3563.)
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f you've confirmed that the problem
I is within your Home directory, you

may be able to fix things on your
own. Here are several common sources
of trouble and ways to deal with them.

Root Out Corrupted Preferences Files
To find the preferences file for an
application, look in youruserfolder/Library/
Preferences. Once you've opened this
folder, press -F and then limit your
search to this folder by clicking on
Preferences in the Search bar. Type the
name of your program in the Search field.
Look for a file with a name in the format
com.vendorname.programname.plist. For
example, for iTunes you'll see one named
com.apple.iTunes.plist (see “Search for
Troubled Preferences”).

Drag this file outside its folder and
relaunch the application. If the crash
disappears, congratulations—you've
found the culprit. Delete the .plist file
you just removed.

You may next need to redo any custom
preferences you set up for the applica-
tion. If the crash still occurs, return the
apparently OK file to the Preferences
folder. If additional preferences files
include the name of the application (as is
the case with iTunes), you can try
removing them next, one by one, to see

if that has any effect on the crash.

Dump Corrupted Cache Files Go to the
Cache folder in your Library folder.
Again, check for folders or files with the
name of the crashing application. If you
find them, delete them. If you can
launch the application, a faster way to
accomplish this task is to use the Empty
Cache command that’s built into some
applications. For example, in Apple’s
Safari, select the Empty Cache command
from the Safari menu.

PROBLEMS YOU CAN USUALLY

SOLVE YOURSELF

Purge Problematic Plug-ins It's
possible that there’s a conflict between
your crashing application and some
third-party plug-in designed to work
with it. For example, if you use Safari
plug-ins, you'll find them inside
youruserfolder/Library/Internet Plug-ins.
For Mail plug-ins, check youruserfolder/
Library/Mail/Bundles.

Remove plug-ins from their folder to
see if this fixes the problem. If it does,
check for updated versions of those
plug-ins. Otherwise, determine which
particular plug-in is the culprit and stop
using it until there is an update.

Rebuild the Program’s Database If your
program uses a database or library, the
problem may be a corrupted database.
Many programs of this type offer a way to
rebuild the database. For instance, with
iPhoto, hold down the &-Option keys
when launching and select Rebuild The
iPhoto Library Database From Automatic
Backup in the dialog box that appears.

If any of the other rebuild options seem
relevant to your symptoms, try them as
well. Similarly, hold down the Option key
when you launch Microsoft Entourage to
access the Database Utility. For iTunes, it's
a little bit more complicated; see this Apple
support article for details (macworld.
com/4603). For other programs, search the
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and remove it from
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This can provide an
instant cure.



help info or read the documentation to
find out whether a simple database-
rebuilding procedure exists.

Check Your Login Items If your Mac is
crashing at the end of the startup proce-
dure while the desktop is loading, one of
your login items may be to blame. Open
System Preferences and choose the
Accounts preference pane. From here,
select an account, and click on Login
Items to see the list.

The easiest way to deal with login-item
problems is to install Marcel Bresink’s
free TinkerTool (§¥¥¥; macworld.com/
1214). Using this utility, you can easily
deactivate and reactivate login items via
the simple interface (see “Check Login
Items”). If you log out and back in after
each deactivation, you'll eventually

determine which, if any, login item is the
source of your trouble.

APPLE’S ADVANCED @
TROUBLESHOOTING

UTILITIES

If you're determined to find the cause of
whatever ails your Mac before you throw in
the towel and head over to the Genius Bar,
Apple offers numerous diagnostic utilities.
Most of them are located in the /Applications/
Utilities folder. Here are the ones that | turn
to the most:

Network Preference Pane and Network
Utility If you're having trouble with an
Internet connection, your first stop should
be the Network preference pane. Click
on the Assist Me button. From the dialog
box that appears, select Diagnostics. If
you still need more help and you have
sufficient technical skills, try Network
Utility. See “Inside Network Utility”
(macworld.com/4607) for a guide to its
most useful features.

Activity Monitor When you’re wrestling
with systemwide problems, such as your
Mac slowing down, Activity Monitor is the
first place to turn. This program lists all your
open processes, including applications as
well as those behind-the-scenes activities
that you don’t see in the Finder.

These items will open automatically when you log In

Hide | Rem King
' AFlleXaminer Hot Keys  Application
1 % Snapz Pro X Application
! PDXMA (P6000D HID Application
# SEyeTV Helper Application
T EdArchive Assistant Application
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™ NTI Shadow Application
B AlrPort Base Station Application
! & LaunchBar Applicaton
1 aiSeek Launcher Application
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the Kems.

To temporaniy disable an tem keeping it
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Check Login Items [f your problems appear during or immediately after loggingin, a login item
may be the culprit. To find out, use TinkerTool to deactivate each item in turn and see whether any of

them is the source of trouble.

Fix Your Keychain If programs
inexplicably reject your passwords or
you're having a problem that seems to be
password related, launch the Keychain

Access utility (/Applications/Utilities).
From the Keychain Access menu, select
Keychain First Aid and try to repair the
malfunctioning keychain.

Start by checking Activity Monitor’s CPU
column. If one application is consistently
showing an especially high percentage
(anything over 30 percent would certainly
qualify), it may be the source of your
problem. If it’s an application you know you
can safely quit, highlight it and click on Quit
Process. Otherwise, if you don’t want to
chance quitting something that’s unfamiliar
to you, restart your Mac. For more
information, see “Monitor Misbehaving
Macs” (macworld.com/3157).

Console You can’t fix anything with
Console, but with a little determination you
can use it to learn what needs fixing. Check
the (admittedly arcane) Console and
System logs. Here you might see the name
of an open application, together with some
error message that sounds as though it
could be related to your symptoms, Even if
the mentioned application doesn’t appear
to be related, quit it (especially if the
timing of the message concurred with the
symptom’s appearance). If the problem
goes away, you now know where to focus

your energy as you do further trouble-
shooting. For more information, see
“Tracking Down Trouble with the Console”
(macworld.com/3302).

System Profiler The simplest and most
straightforward utility of the lot, System
Profiler provides a wealth of detail about
the status of your hardware and software.
Want to do a quick check to see if your
Mac’s RAM is installed properly? Need to
know whether you’re running the latest
version of your printer’s driver? Want to
find out who manufactured your DVD
drive and whether it can read +R DL
(double-layer) discs? System Profiler can
answer all of this and more. This utility
also lists the serial numbers and firmware
numbers of your hardware components—
from the Mac itself to USB and FireWire
peripherals. These numbers can often
assist a Genius in diagnosing your
problem. If you’re not bringing all your
devices with you, jot down the serial
numbers for hardware you suspect may be
related to your problem.
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t some point, if you work your way

through these suggested fixes

without success, you'll exhaust
your patience. The time has arrived for a
trip to the Genius Bar. Here are a few
suggestions for getting good results:

Bring Apple Problems to Apple Not
surprisingly, the Genius Bar is best suited
for problems with Apple products.
Geniuses are less likely to help—and may
even refuse to do so—with problems
involving third-party hardware and
software. If you know your problem is
with Adobe Photoshop or a Canon
printer, for example, you're usually better
off contacting the makers of those
products. If in doubt, you can always let
the Genius sort out whom to ask for help.

Make an Appointment Don’t drop in
at an Apple Store unannounced unless
you're prepared to wait several hours.
You'll be much better off if you make
an appointment via Apple’s Web site
(macworld.com/4604). Arrive a few
minutes early and check in with the
concierge. In most cases, they'll call you
up within minutes of your appointment.

Check Your Warranty Apple products
generally come with a one-year warranty.
If you purchase AppleCare (macworld

— ~
I

BEYOND THE @]}

'GENIUS BAR

The Genius Bar isn’t the only place you can
turn for help. Whether you lack an Apple
Store in your town or you're just not ready
to jump in the car, you have options:

Try the Telephone You can still find
old-fashioned telephone support at
800/275-2273. It’s free for go days for most
Apple products, and for two years if you
purchased AppleCare. You can avoid waiting
on hold by placing your phone request on the
Apple Expert page (macworld.com/4608).
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.com/460s5), that extends it for another
two years. For a product that's still under
warranty, there's a good chance that
Apple won't charge you for repair or
replacement. Occasionally, the company
may offer a free repair or replacement
even if the warranty has expired.

If you expect to be paying for any
repairs, you may face some difficult
decisions. Many repairs cost almost as
much as a replacement. Would you

Choose Online Chat Apple offers online
chat help for a few products, notably
MobileMe (macworld.com/4609).

Check Repair Options To find out about
your warranty status and what repair
options are available for any Apple product,
check out Apple’s Online Service Assistant
(macworld.com/4611).

Learn More about Your Mac If what you
need is general tutorial help rather than a fix
for a specific problem, the Apple Store can
still be of value. Skip the Genius Bar and
instead select one of the many free
workshops, from an iLife *og introduction to
a session about using Final Cut Pro. Each
store maintains its own schedule. Or, for

rather spend $8o0 to fix your three-year-
old MacBook or get a new one for
$1,000? Give this some thought before
your visit.

Bringin the Hardware If possible, have
on hand all the hardware required to
demonstrate your problem. At the least,
have the model names and serial
numbers of the additional products.

Be Prepared to Leave Everything If it
turns out that your Mac needs a repair,
you'll probably have to leave it with
Apple. Don't even make an appointment
for the Genius Bar until you know you
can do without your computer for a few
days. And back up the drive before you
take off for the store.

The Bottom Line

Make an effort to solve problems on your
own, and you'll often save yourself the
time and hassle of a visit to the Genius
Bar. If a trip does become necessary,
prepare in advance and you'll likely go
home smiling—with a Mac that's
working again, &

Senior Contributor Ted Landau is also
the author of Take Control of Your iPhone
(www.takecontrolbooks.com).

more personal help, spend $99 and get a
year’s worth of training sessions via Apple’s
One-to-One program (macworld.com/
4612). You'll find details about what’s going
on at the store nearest you by visiting its
Web site (such as this page for the San
Francisco store: macworld.com/4613).

Find an Apple Authorized Service
Provider Lastly, you may want to consider
bypassing Apple altogether and heading
to an Apple Authorized Service Provider
(macworld.com/4614). These providers may
be more conveniently located than the near-
est Apple Store. They are also typically less
expensive and not as busy (so you are more
likely to get help as a drop-in visitor).



Allows the master outlet to
sense when your computer
has either been tuned off
or gone into sleep mode,

sa it can shut off power to
peripherals plugged into the
controlled outlets—saving
you power and maney.

Uses up to 5x less power in normal operation than any other battery backup.

Let’s protect what’s important.

What's in your computer? Photos,
music, personal files, financial data,
broadbhand access, videos, and more.
Your computer has never been more
important, and yet it has never been at
higher risk tor damaging power surges
and other disturbances.

So like most people, you need to protect
your assets, But like most people, you'd
also like to protect the environment.

With our new energy-conscious products,

you can do both. Energy efficient by
design, our new smart products protect
the power going into your computer,

at a cost that is quickly oftset by big
energy savings. How? Not only do the
new Back-UPS® ES and SurgeArrest”
use power wisely, they also boast a
master/controlled outlets feature that
automatically powers down idle devices
to conserve energy.

APC power protection products are available at:

W oW T3
PC Connectior

“The price tag on the new UPS is $99. While

I'm not in the habit of endorsing products
in this blog, if you're in the market for a
workstation-class UPS, why nat opt
for the greener option?”
- Heather Clancy,
Z0Net.com

In fact, while protecting your power
supply, we're up to 5 times more energy
efficient than any other solution. By
saving you $40 a year in energy costs,
our Back-UPS ES pays for itself in 2
short years. The high-frequency, low-
copper design has a smaller transformer
and environmental footprint. Even the
packaging has been carefully selected
and manufactured to maximize use of
recycled materials and minimize waste.

In this world, every decision you make
counts. So protect your power with a
battery backup that works to protect
the environment. It conserves power,
pays for itself, and is backed by APC's
20-plus years of Legendary Reliability®.
For more information on this

or our other great products, ‘
or for information about :
environmentally responsible
disposal of your old battery,
visit www.apc.com.

2008

Enter to Win a Back-UPS”ES 750G! (1 $99 value)

Also, enter key code to view ather special offers and discounts.
Visit www.apc.com/promo Key Code j127w or Call 888.289.APCC x4013 or Fax 401.788.2797

Energy-efficient solutions
for every level of protection:

Save S5 per year'on
your electric hill!

Surge Protection
Starting at $34
Guaranteed protection
from surges, spikes
and lightning.

7 outlets, phone/fax/modam
protection, master/controlled outlets

SurgeArrest

PIGT

Save SAJ(] per year'on

: your electric bill!
Battery Back-UPS®
i §
Starting at 99 i
Our most energy- ES 7506
efficient backup for
home computers.

10 outlets, DL and coax
protection, master/controllad
autlets, high frequency design,
70 minutes of runtime’

AFC can help with your ather power-protection needs.
Visit apc.com to see our complete ling of innovative o

ArC

Legendary Reliability*

@ 20089 American Power Conversicn Corporation. A trademarks are owned by Schreider Blectric Industies 5.A.5., APCC, or their affiliated companies
e-mail: esupport@apc.com # 132 Fairgrounds Road, West Kingston, Rl 02892 USA « 30B-0967 "Runtimes may vary deperding on load.
*hverage savings are based on comparable competitive medels, and are comprised of two energy-saving features: an ultraeffickent electrical design, and the masterfcontrolied outlets feature.






Is your connection
stuck in the slow
lane? Here’s how to
kick it into gear.

Speedy

ILLUSTRATIONS BY HARRY CAMPBELL I he

Is your broadband Internet connection fast enough? Is it
)) reliable? Is its price right? For many, at some point the
answer to at least one of those questions is no.

When that's the case, you've got two choices: fix what's wrong with
your current connection, or ditch it for a new one.

If you decide to ditch, there is good news: In the past year, consumer
broadband plans with downstream data rates as high as 101 megabits
per second (Mbps) have become common in populated areas of the
United States (albeit at $100 to $165 per month). And services running
at 6 to 15 Mbps have become both more affordable and more widely
available in urban, suburban, and even some rural areas.

Whether you switch to a new Internet service provider (ISP) or stick
with the service you've got, there are several things you can do to make
the most of that connection. Specifically, you can make sure your local
network, your router and modem, and the line between your home
and your Internet provider are all running as fast as possible.

In the pages that follow, we'll tell you how to troubleshoot your Net

connection and, if that doesn’t help enough, how to find a new broad-
band service that’s fast and reliable, without breaking your budget.
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Troubleshooting Your

Broadband Connection

our Internet service provider
tells you that your service
should provide “up to” 8 Mbps

downstream. But an online speed test
says you're getting 1 Mbps. Who's to
blame here?

To figure that out, you have to look
at four components of your Internet
connection: your local area network
(LAN), the gateway (typically a router)
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that connects your LAN to your broad-
band modem, the modem itself, and the
wide area network (WAN) that connects
that modem to your ISP.

The Local Network

Because you control your own LAN, it’s

a good place to start troubleshooting a

problem with your broadband. (In

addition to following this article’s

advice, you can

consult some

. of our previous
networking how-to
coverage: “Trouble-
shooting AirPort
Interference”
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plenty of ways to test the

speed of your Net con-

nection; Speakeasy is

one of the most popular
+  testers, Most will test
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both the downstream
= and upstream speed.

Testing Internet

Spee

) To test whether you're getting
the speed your ISP has prom-
ised, you can use one of many Web-
based speed testers. Broadband
DSLReports.com has a complete list
(www.dslreports.com/speedtest). (If
you create a free account at the site,
you can store your test results there.)

Speed testers download and
upload one or more files—often a
series of files that start small and
increase in size—to test both
throughput and latency. (Think of
throughput as the amount of water
a pipe can hold; latency is how long
it takes for water to come out after
you turn on the faucet.)

To use a speed tester correctly,
make sure that nothing else is
happening on your network—no
automated backups over the LAN
or Internet, no file downloads, no
streaming video or even e-mail
checking. If at all possible, plug the
computer directly into your
broadband modem.

Many ISPs offer their own speed
testers. Even those that don’t
should take the numbers you get
from a good tester seriously. Some
ISPs will even perform tests of
their own by connecting to your
modem remotely.

[macworld.com/4861] and “Improving
AirPort's Range” [macworld.com/3857].)
Upgrade Your Switches An Ethernet
switch is like a phone exchange; data
traffic from your computers and other

devices is routed through the switch
to its destination. If you've got a lot
of local traffic or a fast broadband
connection, an older switch can slow
you down.



First, make sure all your switches
support Gigabit Ethernet. If you have an
AirPort Extreme base station, that means
making sure it was released sometime
after September 2007. All Time Cap-
sules support Gigabit Ethernet. If your
Ethernet switch doesn’t, upgrading is
relatively inexpensive: about $40 to $50
for a five-port switch.

Watch the switch to figure out
whether your network is working at
Gigabit Ethernet rates. Almost all
switches have a color LED that
indicates the Ethernet link speed: it'll
show orange or yellow for 10 or 100
Mbps, and green for 1 Gbps. If you
expect Gigabit speed but see orange or
yellow, you need to check the cable (as
described in the next section).

Some switches also have lights that
indicate collisions on the network.
Ethernet collisions occur when multiple
devices start “talking” at the same time.
When such a light flickers, that's also an
indication of cabling problems.

Check Your Cables Ethernet cables
are often the weakest link in the net-
work chain.

To begin with, make sure you have
the right cables. Gigabit Ethernet
requires Category 5E cable (for short
runs) or Category 6 (for long runs).
Most cables have their type printed
repeatedly in small letters along their
length. Neither type of cable is expen-
sive: a 14-foot Category 6 cable is $2.69
at Cyberguys.com (www.cyberguys.com),
for instance. If you have the wrong
cable, replace it.

Ethernet cables can also
be surprisingly :
fragile, especially ; “* .
after years of use. If 3
you suspect a cable -
problem, inspect your £
cables for bends or
kinks. An Ethernet
line should never be
folded over itself; if you coil
it, make sure the loops are
several inches in diameter.
The insulation should be
smooth and rounded, with no
twist marks or stretching. If you

What Does ‘Broadband’ Really Mean?

Time to Download (hours:minutes:seconds)

10N SPEED INO ROYALE

CASINO ROYALE
(5D MOVIE, 2.01GE)

CASINO ROYALE
(HD MOVIE, 4.68GB)

0:02:41 00614
0:05:22 0:12:29
r13:24 03112
02648 1:02:24
1:29:20 32800
4:28:00 10:24:00

* As with all networking specs, speeds are variable. Service that's supposed to be “up to” can deliver far less or, in some cases, more than that.

see these signs of wear, replace the
cable. And if you're storing Ethernet
cable, don’t coil it tightly. You should
especially avoid “ribbon wrapping” a
cable—tightly wrapping a loose end
of a coiled cable around the middle of
the coil to keep it together. Rather, you
should roll cable loosely, letting it fall
into a loop.

You can use your Ethernet switch to
test your wires: First check the switch's
activity lights when a cable you know to
be good is connecting the computer and
the switch. Then connect the cable you
want to test, and check the lights again.
If the suspect cable causes the switch’s
status light to change color when data is
flowing, ditch the cable.

Make Sure You’re Using 8o2.11n The
most common cause of problems with
wireless networks is mixing older Wi-Fi

equipment with more-modern hardware.

course, even slower. (Net throughput is
the amount of real data—such as the
bytes in a digital image—that gets
through, as opposed to raw rate through-
put, which includes the bandwidth
consumed by error correction, signaling
data, and other network overhead.)

So even if you have a nice, new
802.1n gateway, any 8o02.11g or 8o02.11b
equipment on your network can slow
down your Net connection. If the
connection isn’t that fast to start with
(say 10 Mbps or slower), this older
equipment may not affect perfor-
mance. But if your broadband connec-
tion is 10 Mbps or faster, you'll want to
replace older Wi-Fi equipment.

Apple has made that easier by
enabling its newest AirPort base stations
to use two wireless bands (2.4GHz and
5GHz) at the same time. This allows you
to segment your network into fast and

Ethernet cables can be surprisingly fragile.
If you suspect a cable problem, inspect
your cables for bends or kinks.

L The latest

has a net through-
put of 30 to 150

was used in AirPort

Extreme hardware

from 2003 to mid-
20006) and 8oz.1a
(included in first-

generation Intel Core
Duo systems) have a net
throughput of about 25
Mbps; and 8o2.ub is, of

8o2.1un equipment

Mbps; 802.1g (which

slow sections: your 8o02.1g and 8o02.1b
hardware can use the 2.4GHz band,
while your faster equipment can
communicate over the 5GHz channel.
(See “New AirPort, Old Network” at
macworld.com/4862 for details on setting
this up with older gear and making sure
adapters don’'t automatically switch
between the two bands.)

You can upgrade older Macs with
802.1n adapters. These adapters work only
in the 2.4GHz band, but you'll still boost
your network speed. Newer Technology
(www.newertech.com) has the least-expen-
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sive 8o2.un adapters, at $50 each; these
USB, PC Card, and PCI Card adapters
work with OS X 10.3.9 and later.

Speed-Test Your Wireless Network
Interference can also slow down your
wireless network. If a computer or
another device is connected to a nearby
base station but the data rate is less
than the maximum (11 Mbps for 8oc2.ub,
54 Mbps for 8o2.11g, 130 Mbps for
8o02.11n using the 2.4GHz band, and
270 Mbps for 802.11n using 5GHz
with wide channels), interference may
be the culprit.

To find out how quickly a Wi-Fi
adapter is connecting to a base station,
launch AirPort Utility, select your base
station, and click on Manual Setup.
Then select the Advanced tab, and click
on the Logs & Statistics button. In
the Wireless Clients tab, you should
see the unique MAC (Media Access
Control) address of each adapter and
the speed and standard that it’s using
to connect.

To identify which client is which,
click on the DHCP Clients tab, which
shows the Bonjour name or the DHCP
Client ID for each. Alternatively, you
can open the adapter settings in the
Network preference pane, click on the
Advanced button, and then click on

TCP/IP. The AirPort ID is the MAC
address that you'll see in the list.
(You can also use this method to
test how fast your network works
with a given laptop or mobile

device at various places in a home
or an office.)

The Gateway

The second Internet-connection
component that can slow down your
Internet connection is the gateway.
Typically, that’s a router, such as an
AirPort base station, connected to your
broadband modem.

Double-Check Your NAT If your
service is 30 Mbps or faster, and your
gateway is configured to hand out
private network addresses to your local
network, that gateway might become a
bottleneck for data.

The problem is that network address
translation (NAT), which lets multiple
devices on a local network share a single
gateway IP address, requires constant
computation. Every hunk of data passing
in or out needs to have the addresses
rewritten. If that data is coming in at
high speeds, your gateway’s NAT may
not be able to keep up.

If you have a superfast Internet account,
the workaround is to pay for static IP
addresses from your ISP and manually
assign one to each of your Macs. You can
then turn off NAT in your gateway.

Disable WDS If you connect multiple
base stations via Wi-Fi using the
Wireless Distribution System (WDS)—
in Apple base stations released starting
in 2007, this functionality is called
Extend A Wireless Network—you could
be shortchanging your bandwidth. When
WDS is turned on, each byte of data sent
has to be retransmitted for each base
station. So if you have two base stations,
your network’s bandwidth is cut in half;
if you have three, it’s cut in thirds; and

if c}(our gateway is handing out private
addresses to your local network, that
might be a bottleneck.
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) Fully up-to-date cable

operators can usually deliver
consistent bandwidth. That’s
because the signal path goes
straight from a fiber-backed node
near your home to your cable
modem. DSL providers aren’t quite
so lucky.

DSL providers pass the connec-
tion from your modem to their
central office through a DSL access
multiplexer (DSLAM). Typically, a
DSLAM consolidates connections
from dozens to hundreds of
accounts, combines all that traffic,
and passes it off to a higher-level
network (almost always over
fiber-optic links).

Older DSLAM hardware can
become congested, so if there’s a lot
of traffic among customers con-
nected to one DSLAM, everyone may
experience a slowdown.,

| experienced this several times in
the years | had Qwest DSL service.
My 3-Mbps service would often drop
to 1 Mbps in the evening. | would call
Qwest; then a customer rep would
apologize, put me on hold for a bit,
and return to say a technician had
put me on a less congested leg of the
network. Sure enough, I'd test my
speed and find | was back at nearly
3 Mbps—for a few weeks, at least.

Eventually, | moved to cable.

so on. Disabling WDS and instead using
Ethernet or powerline networking to
connect your base stations should
restore your full speed.

The Modem
The biggest problem with modems is
that they get old.

Make Sure Your Modem Is Modern
If you haven’t bought a broadband
modem or received a new one from
your ISP within the last three years,
call your ISP to make sure the one you
have is up-to-date enough to handle
your connection.



Some early DSL modems still in use
don’t support the faster speeds of newer
DSL lines—their slower CPUs can
throttle downloads. Newer hardware can
work faster.

Similarly, older cable modems that
support the DOCSIS 1.0 standard won't
be able to keep up with networks that
encode data with DOCSIS 2.0 (or, as is
increasingly the case, DOCSIS 3.0).
Check your cable modem’s manual to
see which standard is in use.

Your ISP might swap your old modem
for a new one at no cost. If you're
renting the modem, you should (politely)
demand that upgrade. If your initial
contract term is up, you can often renew
and get a new modem at no cost. If
you're within a contract term, suggest
that you're thinking of switching
providers; you could very well get a new
modem in response.

Check Your Connections Because a
broadband modem has one input for a
phone line or a coaxial cable, a bad hunk
of cable or a wobbly plug can mean
inconsistent service, with frequent drops
or slowdowns.

Watch the Lights As with your
gateway, keep an eye on your modem’s
status lights if the network slows down.
One DSL modem I had crashed every
time a Mac connected to its Web
interface, but I'd never have known that
if T hadn’t been watching its status
lights. If something like that happens,
call your ISP to start troubleshooting.
(Mine was unable to solve the problem; I
ended up switching ISPs.)

The Wide Area Network

If you've checked your local network,
gateway, and modem, and they all seem
to be up to snuff, you should check one
more potential source of Internet
slowdowns: the wires between your
modem and the Internet.

If you haven’t received anew
modem fromyour ISP in3years,

call to make sure the device can

Again, Check Your Cable The cable
from the back of your broadband modem
to the nearest phone or cable wall jack
can suffer from the same problems as any
Ethernet cabling on your local network.
Check it for bends and kinks, and make
sure the insulation shows no signs of
wear. If it does, replace it. With coaxial
cable, make sure the hard-to-turn
hexagonal nut around the connector is as
tight as it can be. To be sure, lift the cable
to release tension while turning the nut.

Call Your ISP If you suspect that the
line outside your house is causing
connection problems, call your ISP and
ask for a line test. Such tests aren't as
useful as they might be: they can detect
only whether your modem is respond-
ing. (If you have DSL, your provider may
also be able to check the impedance on
the line and use that to figure out if it is
achieving the proper signal-to-noise ratio
for your line speed.)

Watch the Weather A demarcation
point is where the wire from your house
meets a connection from a utility pole or
a buried line. That connection is typically
exposed to the elements. If your band-
width sags when the wind blows, call
your ISP for a service call to check the
wire. When service is erratic, calling
your ISP is especially useful; a techni-
cian may be able to test the line and
witness a problem. (Keep in mind that if
the ISP doesn’t find a problem, you may
have to pay for a service call.)

CallanElectrician If you're certain that
there’s a problem between your modem
and the Internet, but you're also certain
that the problem doesn’t lie between
your modem and the wall jack or
between your house and the ISP, you
may have a problem inside your walls.
(For example, I once had a wasps’ nest
in an exterior wall, and the insects ate
the insulation on the cable coming into
the house.) Indoor wiring is your

— - — .
— 1201l your connection.

responsibility; if you're sure that's where
the problem lies, you'll have to either
hire a professional (in some states, that
means an electrician) or pull some new
wire yourself.,

3G Existing cellular data network.

4G Next-generation cellular data
network: WiMax is already available
in some U.S. cities and in parts of
South Korea; LTE will begin to be
rolled out in late 2009 or in 2010.

cable Using existing cable tele-
vision wiring, runs broadband
signals over unused local channels.
Current DOCSIS 2.0 technology
can theoretically deliver download
speeds up to 40 Mbps; DOCSIS 3.0
ups that to 100-200 Mbps.

ADSL Uses existing telephone
wiring to deliver Internet signals.
Theoretically capable of download
speeds up to 24 Mbps, maximum
speeds in the 6 to 7 Mbps range are
maore commaon.

fiber Fiber-optic cable, which
contains bundles of thin strands of
glass that can stretch over hundreds
or thousands of miles, carrying
laser-driven optical signals at
extremely high speeds.

fiber to the home (FTTH) Fiber
lines running from a telephone
company’s network center to
neighborhood nodes and then to
boxes in people’s homes.

fiber to the node (FTTN) Fiber
lines running from a telephone
company’s network center to
neighborhood nodes; from there,
Internet signals travel over very
high-data-rate DSL wiring to
people’s homes.
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Upgrading Your
Broadbangd

improve your Internet connection,
but it still isn’t fast enough, perhaps
it's time to get a new one.

The key to choosing a new broadband
ISP is ignoring the come-ons and
knowing what you'll have to live with
after the honeymoon. That means
research. And the best sources are other
people: Which broadband provider do
they use? Do they like the service?

Karl Bode, who runs Broadband
DSLReports.com (www.dslreports.com),
a site that provides user reviews of both
cable and DSL providers, says, “I think
other customers are the only truly
honest source of information broad-
band customers have when shopping
for a carrier.”

User reviews are one of your best tools
in picking a new broadband service.
Another is a general knowledge of the
advantages and disadvantages of the
various types of broadband technology.
Here's a short summary of the pros and
cons of each broadband technology today.

I f you've done everything you can to
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DSL

DSL is generally slower than cable. And
while DSL providers advertise speeds as
high as 8 Mbps, the speed you actually
get will depend on how far you are from
the central office. DSLs one advantage is
that its prices are generally lower than
those of other options.

While many companies offer DSL,
only local telephone companies own the
wires that connect to people’s homes. So
DSL service from anyone else—Earth-
Link, Speakeasy, or other resellers—will
often cost much more than if you'd just
signed up with your local telco. Resolv-
ing technical issues can also be more
difficult with resellers, because they
don't own the wires.

Cable

Cable has come a long way since its
relatively rough start. Many cable operators
now have fiber connections to neighbor-
hood distribution points (with coaxial
cables making the short run from there to
people’s homes); this allows for high

Sw|tch|ng —

ISPs

) Whatever the reason you're
switching ISPs, the actual
switch can be tricky:

E-mail Address You can’t take it
with you. So if you're thinking of
switching ISPs, it can help to move
your e-mail to an ISP-independent
service like Yahoo, Gmail, or Apple’s
MobileMe first. Or you could register
your own domain name with a third
party, and then use that address
when you switch. In any case, it can
help to send out a form message to
friends, relatives, and colleagues well
in advance, to let them know your
new address and that communica-
tions could be disrupted for a bit.

Overlapping Service | recom-
mend having the new service installed
before the old is removed, at least for
afew weeks. If that’s not possible—
such as when you’re changing DSL
providers—make sure you make the
change when you have access to
alternative sources of high-speed
Internet, in case of problems.

Equipment Rental Confirm
which broadband hardware you
bought and which hardware you’re
renting from the provider. Some
providers charge hefty fees—up to
$150—for ancient modems if you
fail to return them, and they may
not explicitly tell you to do so.

speeds. The latest cable data technology—
DOCSIS 3.0—is rolling out now, boosting
minimum speeds in many markets to 12
Mbps; top rates could pass 200 Mbps.

Cable is also widely available, and the
price relative to throughput is low. Cable
operators aren't legally required to resell
access to their networks, so there are few
third-party vendors; when you have a
problem, yow'll be dealing with the
people who own the connection.

Fiber

Fiber offers the potential for superfast
Internet connections. But it's not yet
widely available.



Two fiber technologies are currently in
use: fiber to the node (FTTN) means tele-
phone companies run fiber to central
neighborhood locations, and then run spe-
cial DSL connections from there to homes;
it's the technology AT&T and Qwest offer.
Fiber to the home (FTTH) means the fiber
goes directly into homes; Verizon is the
only major vendor offering it.

Current FTTN speeds range from
about 1.5 to 25 Mbps, with prices
generally in the same range as cable.
FTTH is faster—io to 50 Mbps down-

stream, and 1-Gbps rates are on the way;
FTTH is significantly faster upstream
than FTTN. Again, prices tend to be
similar to cable prices.

Wireless
Wireless is a catchall term for many kinds
of services. The most popular is satellite
Internet. Because its speeds are low and
its prices comparatively high, I can’t rec-
ommend it unless it's your only choice.
Sprint Nextel and Clearwire recently
merged their separate efforts in fixed

Broadband Compared

A sampling of who supplies what, and for how much

DOWNSTREAM
TYPE (Mbps)

cable 150

PROVIDER

Cablevision

cable 150

DSL 08

D5L 15

DSL 10

FTTH 100
200
200
50.0

FTTN 11
30
6.0

Verizon

180
FTTN 120
Clearwire fixed wireless 08

30

6.0
satellite 1.0
16
30
14-1.7

m 36 lfale

UPSTREAM (Mbps) ;:*CII ;J?l' ;EH FIND CODE *
20 $50 4863
50 $65

30 $43 4864
40 $53

50 $63

100 $140

04 $20 4865
04 $25

05 $30

08 $35

09 $53 4866
09 $63

04 $20 4867
08 $30

08 $43

1.0 $60 4867
50 $70

200 $78

200 $165

1.0 $25 4868
1.0 $30

10 $35

15 $55

15 $65

09 $52 4869
09 $65

01 $20 4870
04 $30

05 $40

0.1 %60 4871
03 $80

03 $150
BOOKbps—1.2Mbps ~ $60 N/A

M/A =not applicable. * Typing a find code after macworld,com/in your browser’s address field will take you to mare information about a listed service,

wireless; the resulting service (also called
Clearwire) has launched only in
Baltimore and in Portland, Oregon, so
far; it offers download speeds between 1
and 6 Mbps for home users. The
company plans to expand to dozens of
major cities in 2009 and 2010.

There are also many 3G data plans
available from cellular carriers, which
require that you install a dongle in your
Mac. These, too, tend to be compara-
tively expensive for the speed they
provide, but they do have the advantage
of being entirely portable; they're worth
considering if you're on the road much
of the time. &

Glenn Fleishman is the author of several
Take Control e-books on networking
(takecontrolbooks.com) and is a frequent
contributor to Macworld.

TheTripleand

_QuadruplePlay

) Should you put all your phone,

data, and TV dollars in one
pot? Providers would love it if you
would, by choosing one of their triple
plays, which deliver all three services
over one wire or cable, with one
monthly bill. There are quadruple
plays, too, which add wireless phone,
mobile data, or mobile TV.

Are triple-play services a good
deal? It depends on how much you're
paying now. For example, my wife
and | were paying $64 per month for
satellite TV service, $50 for Qwest
broadband, and $40 for Qwest local
calling. We paid an additional $15 per
month for long-distance calls. That’s
atotal of roughly $170 per month.

A similar package from Comcast—
with four times the broadband speed,
unlimited calling, and HD video—
would have cost us $130 per month.
So we could have saved some money.

Ultimately, though, we chose to
save even more: we dropped our TV
entirely, kept a home phone line
without voice mail, and switched to
Comcast’s cable broadband, for a
new total of about $g90 per month.
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Needs NoteBook. Has NoteBook.

Stickies, scraps of paper, web clippings, meeting notes, reminders — take control of it all with Circus Ponies
NoteBook, the award-winning application for managing information. Get organized using a familiar note-
book interface, with pages and tabs, sections and subsections. “Clip” web research, e-mails and other
content to your Notebooks for later reference. Create voice-annotated notes and review them from your
computer or iPod. Diagram and sketch when words won't suffice. Find anything instantly using NoteBook’s
patented Multidex™. Share your Notebooks as PDFs or as websites. And much more. NoteBook has every-
thing you need to get organized.

Download NoteBook right now and try it for yourself, FREE for 30 days.
www.circusponies.com/trialmw
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Turn your Mac
miniinto your
entertainment
headquarters

By Christopher Breen

early three years ago, | gotabrightidea: turn  tour of our new media center, she pointedly

= aspare 1.66GHz Intel Core Duo Mac mini remarked, “Let me know when our old stuffis back,”

H intoamedia center, one that could play and left the room.

% music, record and play TV programs, act as a radio, And it wasn’t long before the old stuff was back. It

: and play DVDs. was simply easier to use our satellite receiver, TiVo, AV
% While | was ultimately successful in my quest (see receiver,and DVD player (and, later,an Apple TV) than
i’ “My Multimedia Mac Mini” [macworld.com/2284] for ~ totryto make the minireplicate them.

g the gory details), it took some doing and the results But things have changed in the past three years. For

weren’t terribly family-friendly. When | gave mywifea  onething, video-on-demand is much more common.
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You can buy or rent movies and TV
shows from the iTunes Store. NetFlix
(www.netflix.com) lets you stream some
TV shows and movies. Content from
major television networks and terres-
trial radio is streaming over the
Internet. Free media-center software
has appeared that makes it easier to
watch that content. Apple’s Front Row is
more robust than it once was. And, with
an iPhone or iPod touch in hand, you
can easily control a Mac from the
couch—no more Bluetooth keyboards
and mice or limited Apple Remotes.

The Mac mini itself (§$#8; macworld
.com/4486) has also improved. With its
faster CPU and graphics card, it's
powerful enough to manage media. It
also offers plenty of connectivity (five
USB 2.0 ports, a single FireWire 8co
port, a mini-DVI port, a Mini DisplayPort
connector, 802.11n wireless networking,
Bluetooth, and Gigabit Ethernet).

Given all these changes, I began to
think: Would it be easier now to build
and use a Mac mini-based media
center? Was now the time to replace
most of my AV components with a mini?

I set to work to find out.
Upgradingthe

e

I started with the mini's hardware. At
$599, the least-expensive Mac mini is a
capable computer, but has two ebvious
weaknesses: its RAM is too meager and
its hard drive is too small (120GB) and
too slow (5,400 rpm). Those drawbacks
would hamper the mini as a media
server for a couple of reasons.

For one thing, the current mini's
graphics card—while faster than its
predecessor—still shares the on-board
RAM. The $599 mini comes with 1GB of
RAM, and the GeForce g400M gobbles
up 128MB of that; put 2GB in the mini
and 256MB will be used for video. Fig-
uring that a media center would require
that 256 MB, and that RAM is inexpen-
sive these days, I bought 4GB of RAM
(the maximum the mini can hold) from
Crucial for $68 (www.crucial.com).
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Then I addressed the hard-drive issue.
In the course of his Mac mini review
(¥¥8¥; macworld.com/4499), my col-
league Dan Frakes observed that the
mini runs faster when booted from an
external FireWire drive. A trip to Fry’s
Electronics netted me a 1TB, 7,200-rpm
Seagate FreeAgent hard drive (freeagent
seagate.com/fen-us), with a FireWire 8co
interface, for $135 (on sale).

My new hardware in hand, I grabbed
a couple of putty knives and a Phillips
#0 screwdriver and had the old RAM
out and the new RAM in within half an
hour. (For guidance, I watched Other
World Computing’s Mac mini RAM
installation video [macworld.com/4847];
if you prefer still pictures, iFixit.com
offers a thorough upgrade guide
[macworld.com/4848].)

Once the mini was back in one piece,
I connected the Seagate hard drive to the
comptter, booted the mini from the
internal drive, formatted it with Apple’s
Disk Utility, and cloned the internal
drive to the Seagate drive with Mike
Bombich's free Carbon Copy Cloner
($$8¥3; macworld.com/3156). With that

done, I used the Startup Disk system
preference to designate the fast Seagate
drive as my startup disk.

Making the
Connections

(THTTET o s e

My strategy when it came to connecting
my Mac mini to my home entertainment
hardware was to integrate my old
equipment when it made sense, and
replace that equipment when it didn’t.

Audio The Mac mini supports 5.1 Dolby
surround-sound audio via its sound output
port (which can operate as both an analog
and a digital audio output). To get digital
audio out of the mini, you need a Toslink
cable that includes a mini-jack adapter.
Attach the adapter to one end of the cable,
plug the adapter into the Mac, and plug
the other end of the cable into an AV
receiver’s optical audio input.

I used XtremeMac's $20 2-meter
Toslink audio cable (macworld.com/4849)
for this purpose, plugging it into an
optical input on my Onkyo TX-SR606
AV receiver (macworld.com/4850).

Source Disk

|2 Macintosh HD EY| P

|lunlbbu:au¢ |

What Is going to happen:

dl Click the lock to prevent further changes.

The entire contents of "Macintosh HD" will be copied onto "FreeAgent Drive", merging the conlents of the two
volumes. ltlems on "FreeAgent Drive” will be overwritten by lems at the same path on "Macintosh HD".

Target Disk
| L FreeAgent Drive #

Cloning options:
[lmpm a
) Delete items that don't exist on the source

@ This volume will be bootable.

(@ ( saveTask ) (" Clone )

Clone the Drive Usinga utility like Mike Bombich's Carbon Copy Cloner, you can clone the Mac mini’s
relatively slow internal drive to a faster external one, thereby increasing the mini’s overall speed.



Network Although the Mac mini
houses an 8o2.1un AirPort card, [ wanted
the fastest network connection I could
get for streaming content from the Mac
Pro on which I store the bulk of my
media files. I already have a Gigabit
Ethernet switch for the Apple TV that
sits next to my TV; I simply cabled the
mini's Ethernet port to it.

Temporary Input | pulled an old Apple
keyboard and Mighty Mouse from my
collection of peripherals and plugged
them into the mini. I didn’t intend to
leave them plugged in permanently, but
rather to use them just while I configured
the mini. Once that was done, I planned
to switch to input tools I could use from
the couch (see “Remote Controls”).

Hiding the
Computer

The downfall of my first media Mac
mini experiment was that I operated it
just as I would any other Mac: I'd
mouse around, launch applications, and
so on. That was fine for me, but my
daughter and wife were less willing to
manage multiple apps just to be enter-
tained. This time, I swore to make my
media server’s software interface feel
less like a computer.

Apple’s Front Row seemed like a good
way to do so. Its interface is simple, yet
it provides access to the mini's entire
iTunes library (including music, music
videos, TV shows, movies, photos, and
podcasts), media stored on other Macs
attached to our home network (including
iPhoto libraries), and DVDs in the mini's
media drive.

The first step was to make Front
Row the mini's default interface. I did
so by opening the Accounts system
preference, choosing the administrator
account, opening the Login Items tab,
clicking on the plus-sign (+) button,
and selecting the Start Front Row
application, which youwll find in the
Applications folder.

Now when I log in to the mini, Front

Row appears without any input from me.

Beyond Front Row

Front Row is fine for managing local and networked content, but it’s not so good for
video streamed across the Web. Thankfully, a handful of third-party media center
applications—including XBMC (xbmc.org), Plex (macworld.com/4853), and Boxee
(macworld.com/4854)—can present these streams in a unified and friendly interface.
Of the three, Boxee is the roughest looking but it’s also the best implementation.
That said, Plex and XBMC are quite good, and all of them are updated routinely. Boxee
may get my approving nod today, but tomorrow it could be Plex or XBMC. It's worth
your while to check out each one and compare them occasionally to see what new

features their developers have added.

In addition to video, Boxee offers audio streams, including BBC, last.fm, NPR
(podcasts), Pandora, RadioTime, and ShoutCast. With Boxee installed on my Mac mini,

I had one of the most
powerful and far-reaching
radios on the planet.

In addition to playing
Internet content, Boxee can
play unprotected video,
music, and slide shows on
your Mac and any other Macs
connected to your local
network. (It can’t play movies
and TV shows or protected
music you've obtained from
the iTunes Store.) My one
complaint: adding networked
volumes to Boxee isn’t nearly
as easy as doing the same in
Front Row.

If I need to get out of Front Row and into
the regular Mac interface, I just use a
remote control or press Escape on an
attached keyboard.

Sharing
W™ Tunes

To access media on other Macs on my
network, I had to make sure that iTunes
sharing was turned on.

That meant going to each of my
networked Macs and opening iTunes’
preferences (iTunes » Preferences). I
then clicked on the Sharing tab and
enabled the Share My Library On My
Local Network option.

To play that shared iTunes media on the
Mac mini, I'd launch Front Row, navigate
to the Sources screen, and choose the
networked Mac. iTunes must be kept

Boxee With Boxee, you can stream video from all kinds
of sources over the Internet—and, potentially, from there
to your Mac mini media server.

running on the networked Macs for their
libraries to be visible to Front Row; file
sharing (in the Sharing preference pane)
doesn't have to be turned on.

One downside here: Front Row
doesn't give you any easy way to search
for content. Playlists can help.

One way I found to make my library
more navigable from Front Row was to
create some smart playlists that group all
my artists alphabetically. I created one
such playlist using the following criteria:

Match Any O0f The Following
Rules:

Artist Starts With A

Artist Starts With B

Artist Starts With C

I named this playlist “A — C.” I then
created more playlists to divide the rest of
the alphabet into digestible chunks.
Those playlists show up in Front Row and
make it easy to find the artists I want.
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Remote Controls

| was hoping to find one remote control to control
everything—my Mac mini, my TV, and my AV
equipment. Unfortunately, there is no such beast.

| could have used Apple’s own remote control to
control the Mac mini. But it can’t supply the
keyboard and mouse input that many media apps
require. A Bluetooth keyboard and mouse would be
too bulky. | found one potential solution: my iPhone
plus aremote-control app.

Apple’s free Remote app is one good alter-
native. Pair your iPhone (or iPod touch) with the
mini’s copy of iTunes, and you can control playback.
To make the video experience more seamless, | could
open iTunes » Preferences on the mini, click on the
Playback tab, and choose Full Screen from the Play |
Movies And TV Shows pop-up menu. —

But Remote does nothing for the rest of the Mac.
For general-purpose input and mousing, | tried RPA
Technology’s $6 Air Mouse Pro (§$#¥; macworld
.com/4856). It can do all the mousing, typing, and
scrolling most media apps require. Unfortunately, it
doesn’t work with Boxee, Front Row, or Plex.

Air Mouse The Air Mouse Pro
iPhone app gives you a good
general-purpose remote control
that’ll let you mouse, click, type,
and scroll, as well as control
Safari and iTunes.

For Boxee, | could have used the free Boxee
Remote (macworld.com/4857) iPhone app. It offers two ways to control Boxee. The
first is a four-way arrow pad with a central OK button and a Back button. The arrow pad
corresponds to the Mac keyboard’s four arrow keys, the OK button equals the Mac’s
Return key, and the Back button is the Mac’s Escape key. You can also manage Boxee
with a Gesture control—a large Boxee icon that you drag around the iPhone’s screen
to highlight and activate objects.

Evan Schoenberg’s $1 Rowmote (§§§¥3; macworld.com/4873) can launch and
control Boxee, as well as a host of other Mac applications, including Front Row, DVD
Player, iTunes, iPhoto, Keynote, PowerPoint, Plex,and VLC. It mimics Apple’s remote
with its four directional buttons, as well as Play/Pause and Menu buttons. Unlike Apple’s
remote, it'll let you pick the applications you want to control.

You could also remotely control your Mac mini (from the couch, from another room

Rowmote Withan
interface like that of the
Apple remote, Rowmote
can launch and control
awhole host of Mac
applications.
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in the house, or across the Internet) by implementing
screen sharing, Back to My Mac, or a Virtual Network
Computing (VNC) application such as Patrick Stein’s free
JollysFastVNC (macworld.com/3776). VNC apps allow you
to see the mini’s screen and control the mini’s functions
from any other Mac. There are plenty of VNC applications
for the iPhone and iPod touch, including Jugaari’s $25
Jaadu VNC (macworld.com/4859), ReadPixel’s $7
RemoteTap (§¥¥¥; macworld.com/4333),and Jan
Frydendal’s $6 Mocha VNC (macworld.com/3829).

Still, while these apps might let me control the Mac mini
from my couch, none would also control my TV or AV
receiver. For that, | turned to Logitech’s 3250 Harmony 880
Advanced Universal Remote (macworld.com/4860). It's
relatively easy to program and update, it handles every bit of
gear | own, it doesn’t require batteries (it has a rechargeable
battery and charging station), and it makes sense to my
family. Best of all, it can mimic the Apple remote’s functions,
so it works for many—but not all—of my mini’s media apps.

Sharing
iPhoto

Sharing photos from iPhoto is similar to
sharing media from iTunes: you open
iPhoto's preferences, click on the Sharing
tab, and enable the Share My Photos
option. Again, you can select your entire
iPhoto library or just certain albums.

To view shared photo libraries on my
Mac mini, however, I didn't use Front
Row’s Sources screen. Instead, with the
mini as the source, I'd choose Photos »
Shared Photos. In the resulting Shared
Photos screen, I'd see a list of all my
networked Macs that had iPhoto open
and sharing switched on.

On the same Shared Photos screen,
there is a Slideshow Settings command.
Choose it and press Return, and you see
the options for displaying your pictures
in Front Row: Time Per Slide, Music,
Repeat, Shuffle Photos, Shuffle Music,
Ken Burns Effect, and Transitions.

If you've configured the Sharing tab in
the programs to require a password,
Front Row will prompt you to enter it
with the on-screen keyboard, which you
navigate with a remote control or a
keyboard's arrow and Return keys. You
may need to restart iTunes or iPhoto
before you're prompted for a password.

Ripping
«  DVDs

I also needed access to other video
sources, including DVDs I own, live
television broadcasts, and content
streamed across the Internet.

We've covered the processes of ripping
DVDs (macworld.com/4852) and convert-
ing video for any device (macworld.com/
4566) before, and those instructions apply
to the Mac mini as well.

The mini is not a fast ripper. While I
can rip the main feature of a commercial
DVD with HandBrake (§§$#%3; macworld
.com/3651) in about an hour with my
dual-core Mac Pro and its two 2.66GHz
processors, the Mac mini takes three to
four times as long to do the same.



Smart Playlist

Mmatch [all 58 of the following rules
Playlist '”?i is _'-'-—} ®A-C '_E—l =
Genre .:_' does not contain :?] | Podcast | = &
Limit to ...’S items ﬂ selected by  random T‘
Match only checked items
# Live updating
Cancel ) (o OKo)

TV-Friendly Playlists Create playlists that group the artists in your library into smaller,
more manageable chunks (above); that'll make it easier to find them in Front Row (right).

Other tools might do the job more
quickly, but HandBrake is simpler: insert
the disc, choose the output format (I prefer
the Apple TV format so that I can later
access my movies from the set-top box in
my office), select the main feature, click on
Start, and go away for a few hours.

; Playingth
(@ Foyvee

Terrestrial radio stations are increasingly
streaming their content on the Web and
Internet-only radio is thriving. I was able
to find that content easily using iTunes
itself: after selecting Radio from iTunes’
Source list, I found 28 radio categories,
including Alternative, Blues, Classic
Rock, Jazz, Latino, Public, Sports Radio,
and Talk/Spoken Word. Within those
categories, I could choose from more
than 3,800 streams.

But because I was trying to stay away
from the OS X interface whenever
possible, I wanted to play those streams
without using iTunes. So I created a
playlist called Radio and dragged the
stations I like into it. That way, when |
wanted to listen to one, I could invoke
Front Row, choose Music, select
Playlists, and choose my Radio playlist.
I could then choose the stream [
wanted, and it would play through
Front Row.

I didn't find all the stations I wanted
in iTunes, though. So using Google, I'd
look up a missing station’s Web site.
Many stations stream their content;

there’s a fair-to-middling chance that
when you click on a station’s Listen Live
link, the station will appear in iTunes’

main window as an MPEG audio stream.

You can copy it to your Radio playlist.

In cases where that didn’t work, I had
to abandon Front Row and use a Web
browser to go to RadioTime (radiotime
.com), which streams more than 6o,000
stations from around the globe. To
enhance my RadioTime experience, |
could use Rogue Amoeba's $32 Radio-
Shift (www.rogueamoeba.com) and not
only tune in to live streams, but also
schedule recordings. Those recordings
are copied to an iTunes playlist, making
them available in Front Row.

e

—_— —

Over-the-
AirTV

Given the wealth of online TV streaming
(go to macworld.com/4851 for more on
that), I was hoping that the Mac mini
might also let me get rid of my satellite
dish. The one thing I wasn’t sure about
was local over-the-air programming,
which isn’t always available online.

One solution to that problem is
Elgato’s $150 EyeTV Hybrid television
tuner (§¥88¥3; macworld.com/2312). With
this USB dongle plugged into my mini,
I was able to pick up over-the-air TV
channels. Coupling the Hybrid with the
EyeTV software, I could record pro-
grams. The latest EyeTV Hybrid also
allows me to receive and record
over-the-air FM radio broadcasts.

_ _ Playlists

3 - 5 Minutes

4 Stars and Better

4G IPod nano Selection
90's Music

A-C

A - C No Podcast
Audiobooks

Beatles

CD Spin Doctor

The Bottom Line

The total cost of the hardware and
software for my Mac mini media server
was about $1,500. But I could have
skipped some of the niceties—the
universal remote, the EyeTV, and so on.
You could build a perfectly fine media
center for far less.

The upgrade took me about a day.
That evening, my mini was doing most
of what [ wanted it to. With iPhone in
hand, I could play music, videos, and
podcasts; watch slide shows; access
Hulu and Netflix; and purchase and
rent iTunes content from the couch
without much bother. | was confident I
could do without my DVD player, my
receiver’s radio, and much of the
content currently offered by my satellite
TV provider.

My wife and daughter didn’t share my
confidence. While our Apple TV acts
largely as an adjunct to iTunes—no
Netflix, no Hulu, no Comedy Central, no
PBS, no Pandora, and so on—it's a
device they're comfortable with. For
them the bottom line is, “Is this new
thing as transparent and easy to use as
our old thing?”

In this case, their answer is “No.”
As the family geek, however, my
answer is “Gimme that remote. This
thing rocks!”

Senior Editor Christopher Breen
blogs regularly about the digital lifestyle
at Macworld’s Playlist blog (macworld
.com/4872). Follow him on Twitter at
{@BodyofBreen.
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Working Mac

Trouble-Free Mac
Tech Support

Help your less-technical friends (without going crazy) BY CHRISTOPHER BREEN

ired of being the person your
I friends, relatives, and coworkers

run to when they’re faced with a
Mac problem? Providing help can be
gratifying, but repeated requests can be
frustrating: once you demonstrate your
technical prowess, you quickly become
the go-to person whenever someone’s
Mac hiccups or burps. You'll probably
never be completely free of some
tech-support duties, but with these setup
and maintenance tips, you can cut down
on the number of calls you receive.

Use Accounts to Minimize Hassle
If you think you're going to spend a lot
of time maintaining someone else’s Mac,
create an administrator account for
yourself. This gives you the power to put
things right if necessary, and it lets you
set up a limited account for the Mac’s
primary user, which can help prevent
that person from messing up the
computer. OS X 10.5 (Leopard) provides
two options for limiting users—standard
accounts and managed accounts.
Standard Accounts A standard account
limits users to creating folders and saving
files in certain areas of the Home folder
(so they can save files to the Documents
folder but not to, say, the root level of the
hard drive or the Home folder’s Library
folder). Standard users can access
programs, but they aren’t allowed to install
software or use potentially dangerous
preference panes, such as Sharing and
Network, both of which require an
administrator’s name and password for
access. This type of account is particularly
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good for Windows switchers, who are
familiar with computers but may get lost
in a new interface.

To set up a standard account in
Leopard, go to the Accounts preference
pane, click on the lock, enter your
password, click on the plus-sign (+)
button to add a user, and choose
Standard from the New Account pop-up
menu. Depending on the user’s skill
level, you may want to simplify the
interface. One way to do that is to

remove extraneous items from the Dock.

For example, if that person is never
going to rock out with Apple’s Garage-
Band, drag the GarageBand icon out of
the Dock to remove it. You can also drag

Dock items around to reorder them
more logically. For instance, put
frequently used applications on the left
and other programs farther down the
line. Or you can create aliases of the
most-used applications (Control-click on
a program icon and select Make Alias)
and place them on the desktop.

If you fear that a user will accidentally
venture into potentially dangerous areas
of the startup volume, go to Finder »
Preferences, select the General tab, and
disable the ability to view hard disks on
the desktop. Likewise, click on the
Sidebar tab and disable the Computer,
Hard Disks, and External Disks options.
Moving these items out of the way
makes them harder to stumble upon.

Managed Accounts Though generally
employed by parents to limit a kid's Mac
usage, ma:ﬂaged accounts (accounts
that have OS X's parental controls
applied to them) can also be helpful for
inexperienced users.

To set up a managed account in
Leopard, follow the preceding instruc-
tions for creating a new account, but this
time choose Managed With Parental
Controls from the New Account pop-up
menu. Once you've created the account,
click on the Open Parental Controls
button (you can later access these
options directly from the Parental
Controls preference pane).

The Simple Finder feature is great for
new users because it unclutters the inter-
face and prevents users from touching
things that might get them into trouble.
For instance, it removes the hard-drive

ILLLSTRATION BY JASON SCHNEIDER



icon from the desktop, simplifies menus,
and provides a stripped-down Dock
that contains only the Trash and three
folders—My Applications, Documents,
and Shared. To enable the Simple Finder
in Leopard, go to the Parental Controls
preference pane’s System tab.

You can also choose which applications
a person is allowed to use. Access these
controls at the bottom of the System tab
(see “Simplify the View”). If you're creating
this account for an adult, you needn’t
worry about filtering content, mail, and
chat identities or creating time limits.

Preempt Internetissues

Many new Mac users buy computers
primarily to surf the Web and check
e-mail. This can lead to late-night calls
that start with “I can’t get onto the
Internet!” or “My e-mail’s not working!”
Here how to keep these calls at bay.

Tweak Mail E-mail problems and
questions are inevitable. But if you
carefully configure Apple’s Mail, you
may save yourself some troubleshooting
work down the line.

Start by signing users up for a free
Gmail account (mail.google.com)—not so
that Gmail will be their primary e-mail
service, but to take advantage of Gmail’s

eon Parsetal Controis

outgoing mail (SMTP) server. This can
be helpful if a user is on the road with a
laptop. Some Wi-Fi services prevent the
primary account’s SMTP port from
sending mail. However, Gmail’'s SMTP
server supports multiple SMTP ports,
including those that are supposed to
work in this type of situation. By default,
Leopard’s Mail will attempt to send from
the primary SMTP server first; if that
fails, it tries other SMTP servers you've
configured on the Mac.

It's easy to configure a Gmail account.
Just choose File » Add Account, and then
enter the person’s name, Gmail address,
and password in the Add Account
window. With the Automatically Set Up
Account option enabled, Mail will fill in
the POP and SMTP server settings.

To help prevent junk e-mail from
overwhelming the user and to ensure
that it's moved to its own Junk folder,
open Mail » Preferences, click on the
Junk Mail tab, select the Enable Junk
Mail Filtering option, and then select the
Move It To The Junk Mailbox option.
Make sure the Filter Junk Mail Before
Applying My Rules option is selected.

Take Screenshots At some point you'll
likely have to reconfigure your newbie
friend’s Internet and network connec-
tions. Recording
the information
you need to do that
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Back Them Up

TIP As a seasoned Mac expert,
you understand the value
of abackup. When you set up some-
one’s new Mac, be sure to add an
external hard drive and then configure
Leopard’s Time Machine for that
drive. When you first plug in the drive,
the Mac will prompt you to use it for a
Time Machine backup. Go to the Time
Machine preference pane to configure
that drive or to choose a different
backup drive. If you need to remotely
recover something from the drive, you
can use iChat’s screen-sharing feature
to control Time Machine.

prefer to keep an electronic record for
yourself. In Leopard, navigate to the
Network preference pane, select the
computer’s connection type (Ethernet or
AirPort, for example), and take a screen-
shot. Click on the Advanced button, go to
the TCP/IP tab, and take another
screenshot. You should also take screen-
shots of the user’s e-mail settings, which
you can find under the Accounts tab of
Mail's Preferences.

Similarly, if the person you're helping
has a wireless router such as an AirPort
Extreme Base Station, save a configura-
tion file that you can reload later if
necessary. To do this, open AirPort Utility,
double-click on the base station to bring
up the settings, and then choose File »
Save A Copy As. You might also want to
click on the Settings window’s Internet
tab and take some screenshots of the
Internet Connection and DHCP tabs.

Deal with Passwords Between
banking, bills, e-commerce, and social
networking sites, Web users have to
create and recall many passwords. Help
them by devising a system for storing
and retrieving passwords.

It's a good idea to write down e-mail,
iTunes, and emergency administrator
passwords and ask the user to tuck
them away in a safe spot where you
both can find them later. For Web pass-
words, Safari will save some login
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names and passwords in a keychain if
you tell it to, but it won’t always prompt
you to save them. Instead, consider
Agile Web Solutions’ $40 1Password
($¥$¥:; macworld.com/3801), an
invaluable and easy-to-use tool that
allows you to save and retrieve pass-
words. You can also use it to autofill
credit card information.

Take Control from Afar

Regardless of how foolproof you believe
you've made a Mac, you're going to get
calls for help. And unless you have a real
fondness for the scenery on the drive
over to your cousin Norbert's house, it's
a good idea to configure his Mac so that
you can connect to it and control it
remotely. Leopard makes this possible
(and easy), thanks to Apple’s instant-
messaging client, iChat, which takes
advantage of the OS’s screen-sharing
capabilities. Here are the steps:

Sign Upwith AIM AIM is AOL’s free
iChat-compatible service. Go to the AIM
Web site (macworld.com/4621) and
register Norbert for an account.

Add AIM Account toiChat Launch
iChat. In the Account Setup window,
choose AIM Account from the Account
Type pop-up menu, and then enter the
screen name and password in the
appropriate fields. Click on Done.

Add YourselfasaBuddy In iChat,
choose Buddies » Add Buddy; in the

sheet that appears, enter your AIM or It's
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MobileMe account name, as well as your
first and last name.

Turn On Screen Sharing In iChat,
choose Video » Screen Sharing Enabled.

Troubleshoot Remotely Here we see aremote user’s Mac (with our Mac’s
screen in the bottom-left corner) through iChat’s screen-sharing interface.

Help Them Help Themselves

Configuring a new user’s Mac to make it easy to troubleshoot is a good first
step. But it’s also important to offer newbies some instruction.

Give an Overview Start by going through the basics of using the Mac,
such as how to open a window; what the red, yellow, and green window
buttons do; how the user folder is organized; and how to access items in
that folder (particularly the Downloads folder). You can then demon-
strate other tasks, such as throwing away a file and emptying the Trash;
inserting and ejecting a CD or DVD; cutting, copying, and pasting; launching
an application; using the Dock; sending and receiving e-mail; surfing the Web; and
syncing an iPod or iPhone.

Show Off Spotlight New Mac users need to know how to find files. Make it into a
game by creating a file, tucking it away in a location that Spotlight can search (anywhere
except the System folder or a Library folder), and asking the new user to find it with
Spotlight (by clicking on the magnifying-glass icon in the menu bar). Point out how
Spotlight shows the most-relevant files, whereas Search (#-F) displays all results. Show
newbies around the Search interface, demonstrating how they can use the parameters
at the top to select certain locations, as well as search by content or file name.

Introduce Help Open TextEdit, click on the Help menu, type font, and choose one
of the font commands (such as Font » Underline) to demonstrate how Leopard can
point to any selected command; all you need to do is type the command into the Help
field. To show off an actual help file, type Color Text into the Help field and choose
Changing Font Type, Style, Color, And Size from the menu that appears.

Warn Them about the Internet New computer users need to be aware of online
threats—particularly phishing e-mails. Instruct them never to provide bank account,
social security, credit card, birth date, or driver’s license information when it’s requested
online. Tell them they can verify a message’s legitimacy by calling the institution at the
number provided in the phone book or on the back of a credit card, rather than the
contact information enclosed in the e-mail message.

sharing in the Sharing preference pane if
you're viewing this Mac’s screen via iChat.

Add the Buddy to YouriChat On your
Mac, add Norbert as a buddy.

Start Sharing The next time Norbert
has a problem, ask him to launch iChat.
Select his screen name in your Buddy
list, click on the Start Screen Sharing
button at the bottom of the window (the

not necessary to turn on screen

= = ..E_ 230 overlapping screen icon), and select Ask

. m = . To Share nameofuser’s Screen. When the
onailaa il Bl = ool request appears on Norbert’s screen, tell
_3_ Q @ him to click on the window and then on

the Accept button. His screen should
now show up on your computer; tell him
to let go of the mouse so you can take
control and try to resolve the problem
(see “Troubleshoot Remotely”). It
couldn’t be easier than that. &
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Senior Editor Christopher Breen's friends
and relatives always thank him when he helps

them with their computing problems.
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earphones accurately reproduce the brilliant
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iPod touch (Gen 2), iPod nano (Gen 4) and iPod
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Adjust volume by pressing the
+and - buttons
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Navigate playlists & activate the VoiceOver
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generation), {Pod classic (12068)
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J Digital Photo

Working with Places

Get the most out of the new mapping features in iPhoto’09 BY DERRICK STORY

ith the Places feature in
iPhoto 'og (§¥¥¥; macworld
.com/4319), you can search

your photos based on where you were
when you snapped the shutter. Places
takes advantage of geodata—longitude
and latitude coordinates embedded in a
photo’s metadata. If you've been geo-
tagging your images using GPS hard-
ware or an iPhone, iPhoto reads that
data automatically. But for the rest of us,
the beauty of Places is that it lets us
quickly add location data by hand.

Adding Location Data

To add geodata to a photo, position your
mouse over the image’s thumbnail and
then click on the i icon that appears in
the lower right corner. This opens the
Photo Info pane. Click inside the Photo
Place field and type the city or state
where the image was captured. iPhoto
should offer at least one location in the
list below the search field, and display a
Google map with a yellow pin for your
location. If the pin is in the appropriate
spot, click on the Done button.

If the pin isn't in the right place, you
can refine its position. Return to the
Photo Place field and choose Find On
Map from the pop-up menu. This
opens the Edit My Places window.
From here you can enter a specific
address or use additional search terms.
Select a search result to see its location
on the map. You can now drag the
yellow pin to a more precise location—
say, to mark exactly where you were
sitting in the park.

Once you have the pin positioned, you
might want to refine the name you use
for the location in the list—for example,
you could label your home address as
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Mark Your Spot Start typing the name of a city in the Photo Info pane, and iPhoto will suggest

potential matches and mark them on the map.

“Home.” Just click on its name, type your
description, and then press return.

Doing this for places you frequent will
save you time later, as yowll be able to
locate them by searching for your custom
label rather than typing an address.

If you want your pin to encompass a
larger area, such as an entire park, you
can enlarge the shaded circle area around
the pin by grabbing its handle and
dragging outward. When you're done,
click on the Assign To Photo button.

Speed Tagging

You'll get the most out of iPhoto’s Places
feature if you assign location data to your
entire library. Here are some ways to
make that process go faster.

Workin Batches To add a location to
multiple images at once, shift- or ¥-click
on the photos you want before clicking
on the i icon on any selected thumbnail.
You can even tag an entire event in one

go. Simply click once on the Events icon
under Library in the Source list and then
mouse over an event's thumbnail to
reveal the i icon. One warning: if you
merge an event you've batch-tagged with
another, your photos may lose all of their
geotags. In that case, you're better off
tagging the photos individually.

Copy and Paste Locations If you've
tagged one photo, you can quickly apply
its location to others. Press 2-C to copy
the photo, and then control- or right-
click on a photo you want to tag with the
same location and choose Paste Location
from the contextual menu.

Create Locationsin Advance If you
know ahead of time that you'll be tagging
pictures at specific locations—at relatives’
homes, for example—you can create
geobookmarks for them in the Edit
My Places dialog box. Go to Window »
Manage My Places, click on Google
Search, and enter a location in the search



box. Select the result you want, and click
on the plus sign in the location label to
add it to the My Places list. Want to mark
several places in the same area? Click on
the Drop Pin button. This creates a new
pin that you can position and then add to
My Places.

Usethe Arrows You don’t have to leave
the Photo Info box to tag the next image
or event. Just use the left- and right-
arrow keys to navigate through your
photos. You can work on a series of
pictures much more quickly this way.

Under the Hood
When you specify a location, iPhoto adds
latitude and longitude coordinates, as well
as descriptive location labels that include
the country, state, and city, to the GPS
section of the image’s metadata. To see
these coordinates, select a tagged picture
in iPhoto and then press #-Option-I.
Because this valuable information is
now safely nestled in the GPS metadata,
it can travel with the image. To keep the
coordinates intact when you export
images, be sure to check the Include
Location Information box in the Export
dialog box (File » Export). You must also
give approval for images that you publish
to the Web; go to Preferences » Web and
turn on the Include Location Information
For Published Photos option.

Ann.

If you're uploading geotagged photos
to Flickr, you’'ll also have to open your
Flickr account’s Privacy & Permissions
section and set the Import EXIF Location
Data option to Yes, and make sure you've
updated to the latest version of iPhoto.

Of course, there may be times when
you don’t want this data to travel with
your pictures. For example, you may not
want the world to know where you live
when you publish photos of your son’s
birthday party. To make sure you never
accidentally publish geodata, consider
leaving the options for including
location data unchecked by default.

Putting the Data to Work

You can reap the benefits of your efforts
in many ways. Start by clicking on Places
in the Library pane, and then clicking on
the globe icon. Mouse over a pin, and a
label appears describing that area. To see
pins for all the images you've tagged,
select the Zoom All button.

To see the photos associated with a
specific pin, select the pin and then click
on the right arrow next to the pin’s label.
If you want to broaden your field, click
on the Show Photos button instead.
iPhoto will display thumbnails of all
images taken within the area you have
displayed on the map, even if they are
associated with different pins.
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Map It Select asingle pin to see the photos tagged with that location. The Smart Album button will
place the photos from all currently visible pinsin a smart album.

Find Missing
Locations

TIP Want to quickly find all of
the photos not currently

tagged with a location? Create a new
Smart Album (File » New Smart
Album}), name it something like “Needs
a Place,” and then set the conditions to
read: Photo Is Not Tagged
With GPS. The resulting Smart
Album will contain every photo you've
taken that doesn’t have a location
set—regardless of whether that
location was set via a GPS chip in the
camera, or by your manually setting its
location in iPhoto '09.—ROB GRIFFITHS

If you find the map difficult to work
with, try switching to Places’ list view
(the grid icon). Four columns appear at
the top of the browser: country, state,
city, and specific location. Click on any of
the labels in the list, and iPhoto displays
the affiliated images. This is the fastest
way to find images in a specific place.

Using Smart Albums

After you've added geodata to your
images, you can use smart albums to
pull photos together from this data.

CurrentView First, in any map view,
you can click on Smart Album at the
bottom of the interface. iPhoto will
create a smart album with all of the
photos from the visible locations. This is
useful for gathering photos of your
neighborhood, for example.

Custom Albums You can also create
smart albums manually. Select File »
New Smart Album, choose Place from
the far left pop-up menu, and then type a
country, state, or city in the text field on
the right. Click on OK, and iPhoto will
round up the appropriate images. Better
yet, the smart album will be automati-
cally updated as you tag images in the
future. Now that's a sweet place to be. &

Derrick Story publishes a photography
podcast (www.thedigitalstory.com). Look for
his iPhoto ‘o9 training series on Lynda.com.
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Securing the
Home Network

Reader Q&A: How to keep a mixed-platformhome network safe BY GLENN FLEISHMAN

eader Steve Hawley, from
R Issaquah, Washington, has a

home network with a mix of
Macs and Windows PCs. He wrote to us
for advice on how to configure his
network so that all of those computers
could securely share Internet access. He
also wanted to keep random hackers out
while maintaining secure remote access
himself. His questions and concerns
are common enough that we thought
the answers could help a lot of other
Mac users.

Cross-Platform Security

Because Steve’s network has a mix of
old 8o02.11b and newer 8c2.ug hard-
ware, he should use WPA (Wi-Fi
Protected Access) to protect it. An
8o2.1b device can be upgraded to work
with WPA, but an older device will
work much more slowly and could
impair overall network performance.

Tools Table Window #

TCoWiFiSec-1_6-11-gf.doc
999CBCB3BESS...070A8. 1 password
contents.js

Open My Dropbox
Web Interface (5.8% of 2.0GB used)
Recently Changed

Upgrade My Account
Preferences...
Quit

Dropbox Menu The Dropbox drop-down menu shows you the status of your synchronized files.

stronger encryption than WPA Per-
sonal). AirPort Extreme hardware made
since 2003 supports WPA2 Personal, as
does much third-party gear made in the
same time frame. But for most home
networks, plain old WPA Personal will
be fine.

To enable WPA or WPA2 Personal,
Steve should open AirPort Utility, select
the base station, go to the Wireless pane,

WPA Personal is useful in a mixed-platform
network, because Windows, OS X, and
iPhones can all use the same passphrase.

WPA Personal is particularly useful in
a mixed-platform network, because Win-
dows (XP and Vista), Mac OS X 10.3.8
and later, iPhones, and other platforms
can then all use the same passphrase
to access the network. Nearly all Wi-Fi
adapters made since 1999 have WPA
Personal built in or can be upgraded to
support it.

If Steve really wants to modernize his
network’s security, he could make sure
that all his networked gear is compat-
ible with the WPA2 Personal protocol
(which, among other things, uses
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select WPA/WPA2 Personal from the
Wireless Security drop-down menu, and
then enter and verify the password.

Barring Outsiders

The best way for Steve to protect his
network from outside intrusions is to
implement Network Address Translation
(NAT) on his router.

NAT assigns private IP (Internet
Protocol) addresses to the computers
and other devices on the network; those
private addresses cannot be reached
directly from outside the local network.

When devices inside his network tried
to connect with the outside, NAT would
open temporary connections to relay
traffic to them.

NAT-PMP (an Apple-designed
protocol built into all of the company’s
Wi-Fi gear since 2003) enhances NAT. If
Steve had an Apple gateway, he could
turn on NAT-PMP by launching AirPort
Utility, selecting his base station, and
clicking on Manual Setup. In the
Internet pane’s NAT tab, he should be
sure that Enable NAT-PMP is checked. If
not, he could select the box and then
click on Update. If he was using a
non-Apple gateway, he could implement
Universal Plug and Play (UPnP) instead
of NAT-PMP; typically, he’d use his Web
browser to change the configuration.

If Steve wanted more protection than
NAT alone can provide, he could install
firewall and network-monitoring
software on each computer that's
connected to the network. For Windows,
that might be something such as
McAfee Security Center (which offers
antivirus protection as well; macworld
.com/4739) or ZoneAlarm Pro (macworld
.com/4740). For Mac OS X, there are any
number of options (macworld.com/4741).



Remote Access

Steve’s final query had to do with
securely accessing his files from outside
his network, using either a Mac or a
Windows PC. Fortunately, there are
several ways to do this.

The first option is to host the files on a
computer on his network and then turn
on file sharing. To do so, he’d open Sys-
tem Preferences and select the Sharing
pane. Then he'd select the File Sharing
box and, in the Shared Folders and Users
lists, choose the volumes and folders he
wanted to make accessible and the users
who would have access privileges.

His second alternative would be to
host the files on an NAS (network-
attached storage) device—essentially, a
hard drive with an [P address. Depend-
ing on the model, NAS devices pravide
file sharing via AFP, FTP, Samba, or
some combination thereof.

Whether he stores the files he wants
on a single computer or on an NAS
device, he would also need to configure
his router’s port mapping to give him
remote access to the device. This would
require giving that hardware a fixed IP
address, from the range of private
addresses his router sets for the local
network (typically something like
192.168.1.XXX), and then mapping the
AFP port on the device to the router’s
public port. The steps for doing this vary
according to the router, so he would have
to check his documentation.

If he’s using a
Time Capsule or an
AirPort Extreme
base station (from
2007 or later), he
could share files
over the Internet
without any port
mapping. He'd
launch AirPort
Utility, select his
base station, and
press 36-L for
Manual Setup.
Then he'd click on
the Disks icon,
choose the File
Sharing tab, select
Enable File Sharing and Share Disks
Over WAN (if those options are not
already checked), and click on Update to
restart the base station if necessary.

Note that Apple also recently updated
its Time Capsule and AirPort Extreme
hardware to provide remote access to
internal and external drives via
MobileMe; that access, of course,
requires that Steve be running Leopard
(on the Macs from which he’s trying to
gain access) and that he have a
MobileMe account.

Put It Online

If Steve would rather not go to the

trouble of configuring remote access, he

could instead sync the desired files to
shared storage on
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Verify Pa

this

.com).

If he enabled

{ Wireless Options... |

WPA Personal The bestway to secure a network with a mix of Macs and
Windows PCs is by enabling WPA/WPA2 Personal encryption.

R e
iDisk synchroniza-
tion on his Mac (on
the iDisk tab of the
MobileMe prefer-
ence pane, click on

AlrPort Disks Guest Access: | Read and write

| Disks | File Sharing -

This pane lets you configure file sharing access for your AirPort disks.

™ Enable file sharing

Secure Shared Disks: | With AirPort Extreme password 18

o ber this d in my keychai

D

™ Share disks over WAN
[ Share disks over the Internet using Bonjour

These settings configure Windows File Sharing.

Workgroup: WORKCROUP
WINS Server:

WAN Disk Sharing To access drives attached to a base station from
outside the local network, you have to make sure WAN disk access is active.

Start under iDisk Sync), files modified on
his iDisk would be available from any
computer with access to that MobileMe
account. He could also store files in a
password-protectable Public folder.
Windows users can access files on
iDisk from Windows Explorer. Apple has
posted instructions for doing so (support
apple.comfkb/HT3264). The URL for
public access is http: //idisk.mac
.com/membername-Public, where
membername is the iDisk user name.
DropBox might offer Steve a simpler
alternative to iDisk. The service would
store copies of his files on its own
system, track revisions to files, and
constantly update any changed files to
anyone who subscribes to a given folder.
Steve could have his own private Drop-
Box folder and as much as 2GB of
storage at no cost, and then share any
folder within that main folder with any
other user. If he needed more room, he
could pay DropBox $10 per month or
$99 per year for 50GB of storage.
DropBox uses a secure process o
transfer file updates; and as long as he
was connected to the Internet, Steve
would have the latest version of any file
in any common folders on each Mac
0S X or Windows system he used. &

Glenn Fleishman is the author of the
e-book Take Control of Back to My Mac
(www.takecontrolbooks.com) and a frequent
contributor to Macworld.
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Gmail Power Tools

How to maximize your productivity in Google’s Web mail service BY GINA TRAPANI

ack in the day, Web mail meant
B flashing banner ads, spam,

and uncool addresses like
ninjapirate73@hotmail.com. Gmail
changed that. Google’s free Web-
based e-mail service offers a strong
spam filter, gigabytes of storage, cus-
tom addresses, and more, for free.

That's why I moved all my personal
and business e-mail to Gmail. If you use
multiple computers and handheld
devices (as I do), it just makes sense to
have all your messages and contacts in
one place, available from any Internet-
connected device.

At first, I used desktop clients like
Apple’s Mail to manage my Gmail
account. But I soon switched to Gmail's
Web interface, and I've never looked back.
One big draw is its impressive collection of
power tools. Here are some favorites.

GmailLabs

Last summer Google engineers opened
Gmail Labs, where they test advanced
features. On the Gmail Labs home page,
you'll find a list of experimental Gmail

Tasks: Gina's list - X

[JReplytoDr. S >
Related emai

() Draft OS X customization article
Related emai

[ Send Macworld Gmail/GCal
piece

« Jake screenshols
(] Final copy-edit
« Pickup the dry cleaning
+ 0=

Tasks After integrating your to-do list into
Gmail, you can turn messages into to-do items.

Actions »
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All Mai | Files.
Spam (10781) Subject: Adicls Send this message without attachments?
Trash # ~ Cancel 0K
Contacts Rich tormatting ¥
Tasks
+ & Gina Trapani I've attached the revision, let me know what you think
Search_add_or invite -

Don’t Forget the Attachment Gmail can automatically detect when you forgot to add an

attachment and remind you to do so.

features that you can selectively enable or
disable. (If you're already a Gmail user,
click on Settings and then select the Labs
tab.) Google warns that these features
may “change, break, or disappear” at any
time, but a few are well worth the risk:

Canned Responses If you find yourself
typing the same message over and over,
you can instead type it once, save it, and
then reuse it as needed. Tired of receiv-
ing mass e-mail messages? Create a
“Please remove me from your mailing
list” canned response and then use the
Canned Responses drop-down menu to
insert it into a reply message.

Forgotten Attachment Detector When
you compose an e-mail that promises a
document and press send without attach-
ing the file, this embarrassment-saver
asks if you meant to attach a file first. You
have to explicitly say in the message text
that you've attached a file for this one to
work, and it doesn't work every time—but
you'll be grateful when it does.

Google Calendar Gadget This feature
puts your calendar next to your inbox, so

you can view upcoming events and add
new ones. Coupled with the Tasks feature,
this makes Gmail your one-stop PIM.

Quote Selected Text Respond justtoa
point buried deep in an e-mail by
selecting the text and clicking on Reply (or
pressing R). Gmail will quote only the
selected text in your reply.

Tasks One of the most mature (and
requested) Gmail Labs features, the
Tasks gadget adds a to-do list that inte-
grates with Gmail. Gmail Tasks sup-
ports multiple to-do lists, subtasks,
notes, and due dates; as in Mail, you
can quickly turn a Gmail message into
a task. And, because it's Web-based, you
can view, add, and edit your to-do list
from your iPhone.

Mailplane

To get all of Gmail's Web-based
features, plus the perks of a desktop
client, try Mailplane (§8%#%; macworld
.com/4846) ($25). It offers tighter
desktop integration than your Web
browser, including new-mail notifica-
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Geek Factor

Google Calendar doesn't have all the Labs-based power tools of Gmall,
but it’s still got a few handy tricks.

Collaborative Scheduling Create separate calendars for
family, friends, and work, and invite others to view and edit events
on those calendars. Set permissions for each invitee, so, for
example, your softball team’s cocaptain can edit the game sched-
ule but players can only view it.

Subscribe to Public Calendars In addition to creating your
own custom shared or public calendars, you can subscribe to a
selection of public calendars that contain useful dates suchas U.S.
holidays, religious holidays, and Netflix release dates. In Calendar
Settings’ Calendars tab, click on Browse Public Calendars to sub-
scribe to read-only public calendars. Google Calendar canalso
subscribe to any public iCal feed.

Quick-Add Events in Natural Language Enteringanew event
into your Google Calendar doesn't require filling out a dozen form
fields. Use the Quick Add link on the top left of your calendar to
schedule an event in natural language—*“Lunch with Teddy at The
Cottage Tuesday at 1pm.” You can also use this format to schedule
events on-the-go: just text message Geal from your mobile phone
using short code GVENT (48368). (Visit the Mobile Settings area
to set up your phone and get all the available SMS commands.)

~
> Search My Calendars
(10 ( JQIL
endar
Croate Event Mar 24 - 27 2000 Rafresh
- March 2009 -

S M TWTF S

3 4 53 6
8 5 10 11 12 13 14 g Forecast for 92017 (68
15 16 17 18 19 20 21
22 23[[X12s 26 27 28
29 30 1

¥ My calencars

Today’s Weather In Google Calendar, you can get local weather
predictions for the days ahead.

Show This Week’s Weather Forecast on Your Calendar In
the Calendar Settings’ General tab, enter your zip code or city and
choose your preference for Fahrenheit or Celsius. When you return to
your calendar, a small weather icon will appear at the top left of each
calendar day, with sun or clouds and high and low temperatures.

You do the talking.

Speech recognition so good, about the only
thing it can't do is speak for you.

Your iPhone Idea to Cash Flow in 3 Steps

o) Bring your iPhone application idea to Zco

€) Zco develops, deploys** & supports your app
€) Sit back and collect monthly checks @

$&

20 years of providing high quality senvice
WWW.ZCO0.COm 603.881.9200

www.macsp

Available from MacSpeech, Apple, a
Wisit the MacSpeech website for

*We custom develop Windows, Mac, iPhone, Blackberry and Android softwone
**7co will place your app in Apple’s App store and provide customer support




tions in the menu bar, drag-and-drop
message attachments, Address Book
access, and easy account switching.

Centralized E-mail Accounts

Gmail’s built-in mail fetcher lets you con-
solidate all your POP3 e-mail accounts into
your Gmail inbox. In Settings, on the
Accounts tab, click on Add A Mail Account
You Own. From there, enter your other
accounts’ credentials; messages to those
accounts will then appear in your Gmail
inbox. Gmail lets you use your other
reply-to addresses when replying to mes-
sages, as well; in Settings » Accounts, set
up your e-mail addresses under Send Mail
As. You can fetch mail from up to five
POP3 accounts at a time. The only down-
side is that you can’t specify how often
Gmail checks those accounts for new mail.

Voice and Video Chat

Skip Skype or iChat entirely, and chat via
voice and video from inside Gmail. You'll
need a microphone, an iSight or other Web

cam, and the free voice and video plug-in
(compatible with OS X 10.4 and later). To
get that last piece, click on Settings » Chat,
click on the Learn More link, and down-
load and install the plug-in (mail.google
compvideochat). (It requires Safari 3.0 and
later or Firefox 2.0 and later.) Restart your
browser, select the chat contact you want to
call, and click on Video & More to initiate a
voice or video call.

Open Attachments

If you get a Microsoft Word attachment in
Gmail, Google can open it even if you
don't have Word installed. Instead of trying
to open a Word document, an Excel
spreadsheet, or a CSV file in its native
application, Gmail offers to openitasa
Google document. Clicking on the Open
As A Google Document link will open the
attachment in the appropriate Google app.

Search Autocomplete
The makers of the world’s leading search
engine put some killer search tools in its

e-mail product. As with Google’s Web
search, you can find most any needle in
the haystack that is your Gmail archive by
using advanced search operators such as
subject:, from:, or has:attachment.
If memorizing search operators puts you
off, enable Search Autocomplete in Labs.
With that done, start typing a contact
name or operator, and the search box will
make suggestions based on your contact
list and appropriate search operators.

Google Notifier

Managing Gmail deprives you of one (evil
but necessary) feature of a desktop client:
new-mail notifications. You can remedy
that by downloading the free Google
Notifier for Mac (macworld.com/2752) to get
Gmail and Google Calendar pop-up
notifications and/or audio alerts in your
Mac’s menu bar. &3

Gina Trapani (ginatrapani.org) is the author
of Upgrade Your Life: The Lifehacker Guide to
Working Smarter, Faster, Better (Wiley, 2008).
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Mac OS X Hints

The insider tips you won’t get from Apple BY ROB GRIFFITHS

Crop Multiple Pagesin Preview
Many PDFs—such as electronic versions
of product manuals—seem to come with
gargantuan margins. This is especially
annoying when you're trying to read on a
small laptop screen. You can zoom in, of
course, but you need to do so on every
page. A good alternative is to remove the
margins altogether, which you can do by
using the crop tool in Apple’s Preview.
Open the PDF you want to alter in
Preview; make sure that the program’s
sidebar is visible (View » Sidebar) and
that you've set the sidebar to display
thumbnails (using the pop-up menu at
the bottom of the sidebar). Click on the
Select tool in the toolbar (you can also
press -3 or go to Tools » Select Tool)
and drag a box around the region you'd
like to keep, trimming away the excess
margins. Leave that area selected, and
then click in the sidebar and press £-A
to select all the pages (see “Crop Multiple
Pages in Apple’s Preview”). If your
document has a mix of landscape and

Have a Hint to
l Share?
| Go to MacOSXHints.com
to submit it. This
month’s column is based
ontips from Joris de
Beer, Rob Campbell,
Bjgrn Herrmann, Bryan
Kelley, Ben Kurtz, Brad Lappin, and
anonymous contributors. Each month,
the author of our favorite tip receives
the Help Desk mug,
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Crop Multiple Pages in Apple’s Preview [f you're annoyed by wide margins in a PDF, use Preview

to crop the edges off many pages at once.

portrait pages, press the & or Shift key
as you click to select just those pages
you'd like to crop.

Once you've selected pages in the side-
bar, select Tools » Crop (#-K). Then save
your file (File » Save As) with a new name,
in case you need the original later.

Reclaim SpacefromiTunes

Whether you're using a first-generation
MacBook Air with a “teeny” 64GB drive
or you're just a pack rat, you need every
byte of hard-drive space you can find. If
you use an iPod or an iPhone, there may
be an €asy way to recoup S0me room.

When Apple’s iTunes downloads and
installs software updates for connected
iPods and iPhones, it keeps a copy of
each update on the hard drive. Over
time, you can build up quite the
collection—on my Mac Pro, there are 7
iPod and 13 iPhone updates, altogether
consuming more than 2GB of space.

To find these files, navigate to
youruserfolder/Library/iTunes. There
you'll see (depending on which devices
you use) folders named iPod Software
Updates and iPhone Software Updates.
Go ahead and remove these folders—
odds are you won't use these files again.

RAPHEY PETER BELANGER, KON BY PALL HOAWALT
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Reminder: Staff meeting at 1:00 PT today

iLife 09 Update causes publishing errors with iWeb

appears not Ollly in
Finder windows but
also in Open and
Save dialog boxes.

Mac Video Training|

Sticky Mail Links Dragan e-mail message onto a Stickies note to create

aclickable link that takes you right to that message.

Create aniPhoto Import Tool
If you get a lot of pictures via e-mail or
from the Web, you'll appreciate this slick
and easy way to import images into
iPhoto 'og or iPhoto ‘08 (both §§¥¥;
macworld.com/4219 and macworld.com/
3061, respectively; $79 as part of the iLife
‘og or iLife "08 suite, respectively).
iPhoto stores pictures in a bundle—a
folder that looks like a file in the Finder.
Inside this bundle is a special folder that
triggers iPhoto to automatically import
any images dropped into it. You're going
to “borrow” that folder to create your
own iPhoto auto-import tool.

In the Finder, navigate to your iPhoto
Library file, which is typically in your
Pictures folder (pouruserfolder/Pictures).
Control-click on the file and select Show
Package Contents from the contextual
menu. In the window that appears, you'll
see a folder named Auto Import. Create
an alias of this folder by holding down
the 3 and Option keys while dragging it
to your desktop (or another convenient
location). You should see a small arrow
icon on the folder while you drag.

Rename the alias iPhoto Importer.
When you want to import images into
iPhoto, drop their files onto this alias. If
iPhoto is running, it will import the
images. If it's not, it will import them
the next time you launch the program.

Set Up Program-Specific

Smart Folders

Do you often save or open files from one
particular set of folders? If you're
running OS X 10.5 (Leopard), you can
configure things so that each program’s
Open and Save dialog boxes provide
access to just certain folders. You'll use
the Finder's sidebar to do the trick. It

And its Saved
Searches section
displays smart
folders (saved
Spotlight searches).

Go to a Save
dialog box and use
the search box to perform a Spotlight
search for the folder you want to access.
Once the results come up, click on the
Save button under the search box. In the
sheet that appears, type a name for your
saved search and select the Display
Smart Folder For This Application Only
option. Your new smart folder should
appear in Open and Save dialog boxes
for the program in which it was created.
You can make different smart folders for
each program you use to quickly jump to
the locations you access most often.

Create Mail Links in Stickies

If you use OS X’s Stickies program to
save reminders, to-dos, and other bits of
information, you may already be aware
that the program supports embedded
URLs from Web browsers. This means
that if you drag and drop a Web address

WHAT’S ONLINE

Find Faces and Places
Use iPhoto 'og’s smart
albums to easily locate
pictures that need tags
(macworld.com/4598).

Securely Erase Free
Space You can do this quickly by
using Terminal (macworld.com/4538).

Improve PDF Speed in Preview
PDFs running sluggishly in Preview?
Speed them up (macworld.com/4599).

into Stickies, it becomes a clickable link.
This is useful for, say, creating a tempo-

rary holding spot for a list of URLs that

you need to reference for a project.

But Stickies also supports clickable
links from Apple’s Mail (see “Sticky
Mail Links”). Drag any message out of
Mail and drop it onto a Stickies
note—you'll have an instant link to that
message. So if you have an e-mail that’s
related to text on a note, drag and drop
the source message onto the note to
connect the two.

Senior Editor Rob Griffiths runs the
MacOSXHints.com Web site.

) POWER TIP OF THE MONTH

Expand Recent Places

When you select File » Open within an OS X application,
clicking on the drop-down menu at the top of the window
reveals both the path to your currently active folder and a list
of recently visited folders (in the Recent Places section).
Unfortunately, there’s only one list of recent folders for alf

>

applications, and it’s limited to 5 items, which is really not long enough to be useful.

Using Terminal, you can increase the number of items in the list. In this example, | upped
the limit to 10, which covers most locations | need without making the menu too long. Open
Terminal (in /Applications/Utilities), type the following command, and then press Return (or
you can copy and paste the command from our Web site at macworld.com/4596):

defaults write
-int 10

.GlobalPreferences NSNavRecentPlacesLimit

Replace the number 10 with however many entries you'd like to see in the Recent
Places section. This change takes effect immediately, although it will take time to build
up additional entries in the list. To go back to the OS X default, simply repeat the above
command but change the number at the end to 5.
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Mac on

Solutions to your most vexing Mac problems BY CHRISTOPHER BREEN

Back Up and Restore Mail
Archives
@ Howdol correctly back up my
® e-mail files on my old computer
and then restore them to my new
MacBook Pro?
Javier Campos

@ W'h{_‘n you set Llp your new

@ laptop, connect your old Mac to
your MacBook Pro via a FireWire cable
and let Apple’s Migration Assistant do
the dirty work. You'll be prompted
automatically to use Migration Assistant,
and then provided with instructions on
how to set it up. (If you choose not to
migrate when you first set up the laptop,
you can do so later by running Migration
Assistant, which lives in the /Applica-
tions/Utilities folder.) When the utility
copies your user data, it will bring along
your e-mail settings and messages.

You can also do the job manually by
archiving your messages within Mail
and then transferring those archives.
Control-click (or right-click) on the
Inbox in Mail and choose Archive
Mailbox from the contextual menu (see
“Archiving Mailboxes”). In the sheet that
appears, you'll be asked to choose a
destination for the exported mailbox
files (called “mbox” files). Pick a location
and click on the Choose button. Mail
will create as many mbox files as you
have accounts listed under Inbox.

Have a Problem?

Go to the Mac gn forum
(macworld.com/z2467) for
help with your misbehav-
ing Mac or applications.
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Archiving Mailboxes You can use Apple’s Migration Assistant to move all your Mail messages and
settings to a new computer, or you can archive Mail’s mailboxes individually, as seen here, and then

move them to the new computer yourself.

On the laptop, choose File » Import
Mailboxes in the Mail application. In the
Import window that appears, choose
Mail For Mac OS X and click on
Continue. In the resulting sheet, select
the folder that contains your mailbox
archives and click on Choose. A list of
all the mailbox archives Mail is able to
import will appear. Deselect those you
don’t want and then click on Continue.
Mail will place the archives in an Import
folder under the On My Mac heading in
Mail's Mailboxes list.

At this point, you'll want to click on
each mailbox to see what it contains and
then rename the mailboxes to accurately
reflect the account they're linked to—
AOL Archive, for example.

Access aMac When You Don’t
Know the Password
@ ! was given my mother’s iMac
@ because she passed away, but |
don’t know the password. How can | gain
access to this Mac?
Via the Internet

o This question is a little delicate

® because you could use the
method I'm about to describe to access
any Mac. But situations such as yours (as
well as problems that come up when you
purchase a used Mac that hasn't been
properly cleared) invite a response.

Locate that Mac’s installer disc or a

recent OS X installer disc—for example,
an OS X 10.4 (Tiger) or OS X 10.5



(Leopard) disc. Insert that disc into the
Mac’s media drive and hold down the
keyboard's C key to start up the Mac
from that disc.

When the Mac boots, you'll be asked
to choose a language. Do that and then
click on the right-pointing arrow icon to
continue. When the Welcome screen
appears, wait for the menu bar to
materialize and choose Utilities » Reset
Password. In the resulting window, click
on the Select A User pop-up menu and
then choose the user whose password
you want to change. Enter and confirm a
password in the appropriate fields and, if
you like, enter a hint for the password.
Click on Save to make the change.

“Oh, swell,” I hear parents saying.
“You've just given my kid the key to
taking over my Mac. Thanks so much!”
Fortunately, now that you know how to
break in to your Mac, you can make it
more difficult to do so. Boot your Mac
from that installer disc again, find your
way to the Welcome screen, and choose
Utilities » Firmware Password Utility. In
the window that appears, click on
Change, and then enable the Require
Password To Change Firmware Settings
option and enter and verify a password.
Click on OK, and your Mac is now
protected with a firmware password.

This means that if your kid starts up
your Mac with an installer disc in the
media drive and presses the C key to

Fﬂn FileVault  Firewall |

For all accounts on this computer:
¥ Disable automatic login

Miogoutafier 5 (3 minutes of inactivity
7 Use secure virtual memory

"I Disable remote control infrared receiver
TRIT COMPutEr wall work WiTh By Bviilabbe
remote.

dl Cack the lock 10 prevent Rarther changes.

" Require pasyword to wake this computer from theep or screen saver

M Require password to unlock each System Preferences pane

(——

hoot from the disc,

the Mac will ignore

H Mame: [ My Croeus Curar

that key press and
move to the login
screen. If the kid is
really savvy and
presses the Option
key to move to the
screen where you
choose a device

to boot from, a pad-
lock icon will
appear with a text
field below it. If
your child fails to
enter the correct

firmware password
in that text field,
the Mac will not
boot from the disc.

Convert GarageBand Tracks to
Electric Guitar Tracks
Q o ! have some old GarageBand

® projects that include electric
guitar parts | played with my MIDI
keyboard using GarageBand’s software
instruments. | now have GarageBand ’og
and would like to use the new guitar amps
and stomp boxes with these tracks. Is
there a way to convert these tracks so |
can use them with the new amps and
stomp boxes?

Glenn Henderson

o Apple’s

® Garage-
Band 'og (§¥¥¥:;
macworld.com/
4409) doesn’t
provide an obvious
way to do it, but
ves, it's possible.
Select the track you
want to convert in
GarageBand, and
choose Edit » Add
To Loop Library.
In the sheet that
appears, name the
track, assign to it

@

Blocking Access It's not very hard to get around a Mac’s password if you
have an OS X installer disc. But if you add a firmware password and set up
your Security preference pane properly, your Mac will be reasonably safe.

any descriptors you
like—Guitars,
Electric Guitar, and

ag

Kot atty Eonbeim 18 g

Converting a GarageBand Loop You must first convert software
instrument tracks to real instrument tracks before you can use Garage-
Band’og’s guitar amps and effects.

Grooving, for example—and then click
on Create (see “Converting a Garage-
Band Loop”). The track will be added to
GarageBand’s collection of loops.

Click on the plus-sign (+) button in
the lower left corner of the GarageBand
window to add a new track, select
Electric Guitar in the resulting sheet,
and click on Create to create a new
Electric Guitar track. Choose Control »
Show Loop Browser to expose Garage-
Band’s loops. In the Search field at the
bottom of the browser, enter the name of
the track you added to the loop library.
Drag this track into the new Electric
Guitar track. When you do, it will be
converted to a real instrument (digital
audio) track. Once you're in the Electric
Guitar track, you can apply Garage-
Band’s amps and stomp boxes to it.

If you have a real instrument track
to begin with rather than a software
instrument, you can simply create a new
Electric Guitar track, select the contents
of that real instrument track, and then
Option-drag them to the empty Electric
Guitar track to copy those contents to
the new track. &

Senior Editor Christopher Breen isthe
author of The iPod and iTunes Pocket Guide,
fourth edition, and The iPhone Pocket Guide,
third edition (both Peachpit Press, 2008).
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Macworld Superguides are available in 3 convenient formats: 1) Downloadable PDFs: Get

immediate access. 2) Printed Book: Order a handy, full-color printed book on high-quality
paper. 3) PDF on CD-ROM: Don't want to download the PDF, get it on CD-ROM.
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Other World Computing

Serving the Mac Universe since 1988

Why buy from OWC?

We don't just sell it, we tell you how to install and use it.

External Storage Solutions

www.macsales.com/firewire

Bus Powered Solutions
Fast, Reliable, Bus-Powered Plug and Play

Mouse not included

! M 3.5"x5.5"x1"

OWC® Mercury On-The-Go Pro™
Portable Solutions

Compact and versatile — powers right
away via FireWire® or USB 2.0 interface,
no external power required!

Available from
80GB to 500GB!

FW800/400+USB 2.0

320GB 7200RPM $139.99 355331
500GB 5400RPM$164.99 Wariantg
500GB 7200RPM $239.99

80GB to 500GB USB 2.0, FW400+
USB 2.0, and FW800/400+USB 2.0
interfaces from $84.99

': All OWC & NewerTech configured external drive solutions come ready to Plug and Play with all interface connection cables, include full versions Il
' of Intech® HD Speedtools™, NovaStor NovaBACKUP, Prosoft Data Backup 3, and Carbon Copy Cloner and are Leopard® Time Machine™ ready.

Live Sales/Support team
available toll-free.

AWARD WINNING SOLUTIONS
FROM OWC & NEWERTECH -

Hard Drive & Hub

Integrated Space Saving Powered Hub

Available from
80GB to 2.0TB!
Mouse nat included

NewerTech® miniStack®
Storage Solutions
Up to 2.0TB of performance storage

+ integrated space saving powered
FW/USB 2.0 hub!

Up to 2.0TB from $97.99

6.5"x6.5"x1.5"

500GB 7200RPM from $124.99 sY:ecg‘
1.0TB 7200RPM from $159.99 | Warranty

2.0TB High-Cap from $379.99

FW800/400+USB 2.0+eSATA
and FW400+USB 2.0 interfaces

www.macsales.com
800. 275 4576

Extremely fast delivery ' ) support...even

at a reasonable cost.

Live Chat

on weekends.

(= =7] h-'ll YERS

M2 P shes se e

Proteshop Uese
! *eeee

,{*3\ nlrulnf'}‘_

Performance RAID
Performance Hardware RAID Plug and Play

Available from
640GB and up
to 4.0TB!

Mouse not included 7 -
9.0"x2.9"x5.3" ! M
OWC Mercury Elite-AL Pro™ Dual
Drive RAID Solutions

High-Performance, Plug and Play
RAID solutions ideal for demanding
audio/video, editing, mass storage,
and any application where higher
data performance is of benefit.

Up to 4.0TB from $184.99 35Yralr'
2.0TB 7200RPM from $259.99 | _arranty
FW800/400+USB 2.0+eSATA

and FW800/400+USB 2.0 interfaces

Software
Included

T vy

5200
Value

Build Your Own Drive! 0GB 'Add your own hard drive’ kits available from $27.95. To see full selection of kits, visit www.macsales.com!storage}—

Your Online Mac Upgrade Center:
Internal Hard Drives H
www.macsales.com/harddrive

LAPTOP Hitachi® Seagate® Toshiba® Western Digital® ]
DRIVES 2.5" Serial ATA, IDE/ATA from 80GB to 500GBE

o oc

..- 500GB 7200RPM Seagate
2o 95mmnon$159.99

DESKTOP Hitachi, Seagate, Western Digital
DRIVES 3.5 Serial ATA, IDE/ATA from 80GB 1o 2.0TB

500GB 5400RPM Hitachi
9.5mmnow $97.99

@ - 1.076 Hitachi 1.0TB Hitachi | 1.5TB Westem
7K1000.B3.5" E7K10003.5" Digital 'Green
1 SATA I SATA Il Enterprise Power' 3.5" SATA Il
= ow$84.99 ow$139.99 ML now $154.99

At OWC Our Customers Come 1st!

QUALITY PRODUCTS @ COMPETITIVE PRICES EXPERT SUPPORT

The First and Only Tablet Mac
| Ww BEST OF SHOW

www.macsales.com/modbook
Draw, sketch, and write directly on the screen.

AxXIoTRON Mmodbook

CONFIGURE YOURS MODSERVICE
Complete Modbook 'Bring Your Own
fom $1999 MacBook' Upgrades
fom$1149

OWC installation videos
show you how to unleash the
full potential of your Mac.
www.macsales.com/installvideos

Award-winning support...
’23‘5" BizRate Circle of Excellence
5 straight years.

&%
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Visit: www.macsales.com Call: 800.275.4576



SPECIAL ADDITIONAL SAVINGS! ~ Customer Quote CORNER
Competitive Pricing + Additional Cash Back! EElh L eranaEAct i el
See offers at www.macsales.com/Rebates

.—_@ Free lifetime [#%Z7% Free online "Do-It-Yourself"
U.S. based D | videos for easy installation.
Expert installation services technical Check out our new page!

with fast turnaround. support. www.macsales.com/installvideos

More Memory = Faster Mac Memory for iMac®, MacBook®,
www.macsales.com/memory MacBook Pro, Mac mini (Intel)
Apple® Mac® Pro XEON™ - Max Any Model Up To 32GB!* 2,068 4.0GB Kits6.06BKits
Get the right memory for any 2006/2007/2008 model $29.99 $58.99 $194.99
pkdbacad Upgrade: : INEW!)8.0GB Kits
p H 7 Sl Aslowas 4GB Kit 32GBKit . 667MHz& 800MHz b (for 2009 Unibody' 17" and
74% | $23.12  (GBModulesx2)  (4GBModulesx8) .0GHz, 2.666Hz, 2.86Hz, Models | 15" 2.66/2.936GHz Only)
vs factory! _ per GB fom$94.99  from$779.00 | 3.06Hz and 3.26Hz Quad-Core, it : $667.99

Quad Core x 2 (8-Core) alfl models

NEW!|Memory for the March/2009 'Nehalem' models |
8GB Matched Set 16GB Matched Set 32GB Matched Set  Also available:

(2GB Modules x 4) (2GB Modules x 8) (4GB Modules x 8) 6GB, 12GB, &
$157.99 $299.99 fom$1499.99  24GB Kits
Upgrade: "
«1066MHz ~ « Quad-Core 2.66GHz/2.93GHz;
8-Core 2.26GHz/2.66GH2/2.93GHz -
*Up to 8GB for ) ) :
March 2009 Quad-Core Model in 3 eas s with our on-line
. nfigurator!
We Have The Right Memory For Your Mac
From 68020 to PPC to Intel®, Power Mac® G5 - ;
r— 1 All OWC memary meets or exceeds |

from Classic to Pro — OWC | manufactuterspecfiationsfor !
+ maximum quality assurance, but
| attheindependent pricesyou |

PowerBook® G4 , can afford. Plus, you receive

has the right memory for all
the latest Macs!

! the industry-leading Lifeti

We have Mac mini G4 :Mf.:msnﬁ'puiie::im =
= memo,:'ny = | Warranty and ’f"-’". '
or any Mac S | award-winni ;
s s ()
Aslowas  Aslowas As low as As low as [ utomersupport. Weme )

$15.00 $15.00 $42.95 $15.99 TTTTTTTTTTTTY

per GB per GB per GB per GB

Cash Back Rebates on your old memory, hard drives, and more! For details, visit www.macsales.com/money-back-rebate

Mac SuperDrive DVD+CD Burning Solutions

www.macsales.com/superdrives

OWC Has Provided Expert Blu-ray
Solutions for Over 2 Years!
We Know Blu-Ray for Mac (and PC too). External Solutions

&9 Blu-ray Solutions from $69.99
arirogonee nowfom$112.99

NOW
TWICEAS FAST!
Burn Blu-ray
upto 8X
speed!

PLUG AND PLAY INTERNAL AND EXTERNAL SUPERDRIVES

“\

Internal Solutions

AR, 52599

External
solutions i
irclucly he We have solutions for ALL laptops and desktops!
Award-Winning

Prosoft Data -
Backup 3!

OWC Mercury Pro Blu-ray External Drives
Now Write/Read up to 8X Blu-ray Discs
OWC Mercury Pro Blu-ra
Burner/SuperDrive
Dual-Layer

only $ 359.99

FireWire® 800/400+
USB 2.0+eSATA

Create with: - Apple DVD Player « Apple iMovie® . EMC® Retrospect® - Roxio® Toast® - Prosoft
" J « Apple iDVD® « Apple DVD Studio Pro® « Apple Disc Burner « Apple iTunes® « Apple iPhoto®  « NTI™ Dragon Burn

School/Corporate Purchase Orders ; ‘onservation & Recycling
accepted with approved credit. Learn more about OWC's new greener tomorrow

'Green' headquarters.

NewsrTech, NewerTach arrow loga, and miniStack are regl ol and aned the Technology, Inc. loga is a rrademark of Mewer Technalogy, Ine, OWC and
OWC logo are registered trademarks and Mercury On-The-Ga Pro, Mercury Elite-AL Pro, and Other World Cs ing are trad, ks of Other World Computing. Other
miarks may be the trademark or registered trademark property of their owners. Prices, specifications, and availahility are subject ta change without notice.
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iGo 5333

i360°539.50

Get The Key To
MacBook Security

A Mobile Mac Esential

Macworld
(111

GT SecuriKex

The Cross-Platform Security Leader.”
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'S Thinnest.
soard|Protectori

rd
Green Onions Supply < 0.25mm
vs
Other Brands > 0.5mm

Usars from other brands will notice our improved
sensitivity, and new users will foel our improved
anp.

RT-KESOT Exclusively for the Unibody MacBook
and MacBook Pro
AT-KBS04 Exclusivaly for the MacBook Alr and

polycarbonate MacBook
AT-KBS05 Exclusively for the Apple Keyboard
(USE with numpad)

trmclar ks of Apgie ir

ROTA America, Inc.
hittp:/fwww.greenonionssupply.com
1-888-248-2019

s .
\_/nions suepty

een

Editors' rating

romchion iWoofer 5119

Go green, have fun, and look
great! Marware's Eco Runner
and Eco Vue are safe,
environmentally friendly, and
easy on your wallet. Catch the
wave of responsibility with a
green carrying solution for your
iPhone or iPod. Marware is
leading the way by donating
2% of profits to community and
environmental organizations.

WWW.marware.com
954.927.6031

O MIARWARE



Granite

DeleGeleTeAeL

High End External
FireWire and SATA
Cables

Gender Adapters
Controller Cards
HUB/Repeaters

(888) 819 - 2190
www.granitedigital.com

\\m\\\\mﬂ“‘"ﬂ

work sitting
or standing
anytime -
at the touch
of a button

biomorph.com

e cataloy 888 302 DESK

Are your projects taking \
on a life of their own?

frustrating, But it doesn't need to be
Shave hours, even days off of your projects

» Easy to understand graphical user interface.
ne-click resource collaboration.

Download your FREE trial of this award winning
software at: www.projectx.com/trial
Version 2.0 coming soon!

Project management for the rest of us.

(O MIARWARE '

2 0al0 ]

www.marware.com
954.927.6031

LAPTUK

MAC STANDS SUPERSTORE

Brilliant

InSightCruises.com/Mac-10
May 2-9, 2010 .
recipe management

Mac
Mania 10

A Cooks Boo
RECIPE MANAGEMENT

\Roundtﬂp NYC to Bermuda

Try the demo:

www.3caam.com

MACESSITY.COM
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FASTEST TURNAROUND * GREAT PRODUCT OPTIONS  PERSONAL SERVICE * PHOTO-QUALITY PRINTING

LARGE PRINT JOB CAPACITY

If you have several million in print volume, we
have the capacity to get your work done! With
four 40° Komori presses; two 6 color, and two
8 color, and in-house bindery equipment, we
can handle ANYTHING you require, Focus on
GROWING your business and let us take care

FREE BRANDED WEBSITE

Zoo Printing is accepting applications for state-
of-the-art branded websites for our trade
customers, These websites function JUST LIKE
our website. Your website will order, charge,
and ship all BLIND for you to maintain your
relationships with your dlients. Act now, this

100 OFFSET VS. DIGITAL

Traditionally, digital printing offered quick
tumaround, small quantities, but inferior quality
at high prices. Now with the new technology at
oo Printing, WHY go digital when you can order
OUR offset printing with the cheaper prices,
faster turnaround, and superior “photo-quality”
We now nﬁu SHORT RUN options for most of

PAPER OPTIONS

100# Gloss Book + AQ
1004 Gloss Book + v ¥
100# Gloss Cover + AQ
14pt Gloss Cover + AQ
14pt Gloss Cover + UV
TeptGloss Cover + v 9

100¢ Uncoated Cover 89

of the printing.

704 Uncoated Text

60# Gloss Label Stock
1000,8.5X 11
Brochure

100Ib Gloss Text 4/4 n
Full color on both sides with aqueous coating
Business Cards % 5
14pt C25 4/0

Full color on one side with UV coating

1000,4.25x 6 %

Postcards
Full color on both sides with AQ or UV coating

1000,2x3.5

West Coast

PN

www.zooprmtmg com 2 3Busmsss
PRINTING :

14ptor 16pt C254/4
L ) ™,

TURNAROUND

Mooove on over'to greener pastures!

ratCow - the udderly uniqgue Web host.

The FatCow Web Hosting Plan

- Unlimited Disk Space for Your Files

- Unlimited Data Transfer

- Unlimited E-Mail Accounts

- Easy-to-Use Site Building Tools

- Free Blogging & Forum Tools

- ShopSite Online Store

- Customizable Control Panel

- Free Ad Credits on Google and Yahoo

25% OFF for
MacWorld Readers p

$66 - —

1.866.544.9343

Visit us today. www.fatcow.com/macworld
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Graduates, StOCk Up while you still can!

» Students, parents, and teachers save up to
85% off with academic discounts.

#MG859615 | $149.95
You Save $20!

Corel Painter 11
#MG982011 | $99.95

APDRADNE WA WA VI A RTINS RO
P BAMNS AALLY AMD AVNOOY \

Special Price
for College
Students

painter i

(54 Design Premium
Student Edition
W imG962669 | $398.95 .\ ” -
“ You Save $1400! o

ACADEMIC Use Promo Code [¥YETLI when placing your order and receive FREE Sony Ear Buds
s E With your ord:?r of $100 or more! Hurry, this offer ends 9/1/09. Prices are subject to change.
UPERSTOR Visit us online or call now: www.AcademicSuperstore.com/mwjl | 1-800-218-7455

We can save 1t!

Want proof? www.drivesavers.com 800.440.1904
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Overnight Repairs & Upgr'ades 1-888-64-RESTORE

* Free Diagnosis , - (1-888-647-3786)
* Free Return Sh|pplng "_I'- = ."; '.".__::___ :‘___..-- : eami:l S5pm Pacific M-F (F
* Local Pickup Nationwide techrestore.com
"« Free e-Waste Recycling

* Repair your electronics
* Buy Restored devices
* Recycle e-Waste

\ TechRestore regularly recycles
.tons of electronic waste and
epairs thousands of Macs,
Pods. iPhones and

game systems.
\ =3
%

Help us do
(even more. m b
w

““"
6‘0

Qeen techrestore.com/recycle

—
PrintRunner

Quality Printing For Less

Full Color Offset Printing at Amazing Prices
Business Cards

Brochures

! ! L 1 3
CUSTC NTI CC E IN-HOUSE R Tl { )
A0 3 = ~Lonbie feetriy,

Call Now! 1-888-PRINT-89 or Order Online: www.PrintRunner.com

)673 Topanga Canyon Place Chatsworth, CA 91311
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Performanc:e

>

MacMemory.com

sharpdotsicom

Your Online Resource For All Your Printing Needs

Wiz

Don't Gamble with Your Mac MACWORLD SUBSCRIBER
Generic RAM is a Leading Cause of PROMOTION AT BEE
Decreased Performance & Instability
Upgrade with oz gl;;é%
Ramjet Certified Memory
R ey = e v
— — N Full Color Pri.nting
I ) == Additional Products A\giﬁl;l:
Conﬂdence Guaranteed Cornpatible RhEw ;g::;ig?:
Performance Fastest Available Enter coupon code: 0709CAT for discount
Reliability Lifetime Warranty 1000 4/4 Busi & 5
eTa — usiness cards
Convenienos Samo'GEREEREN ;—Ee RapiDots 1000 4/4 4x6 Posteards  $57

Save time and money! 1000 4/4 5.5x8.5 Postcards 599
Speak to a Secure Online Ordering af Bypass digital proof process 1000 4/4 49 Rack Cards  $129

Memory Expert 2-3 business day turnaround 1000 4/4 8.5x11 Flyers ~ $155
MOCMemOW'COm Go to www.sharpdots.com or call 877.742.7789
Reliability

Mac of All Tradesw FAST. RELIABLE. SECURE.

Data recovery from
all hard drives, all platiorms...

Your solution for buying and selling used Macs

Serving individual and
volume buyers and sellers

Volume discounts available

; www.macofalltrades.com « Affordable, Up- '\
Mckfes' . Up-front Pricing
wsecune Serving the Apple® community since 1995 # | (no hidden charges) *‘

» Superior, 24/1 Service

« Confidentiality Guaranteed

A Y

M EE m 918-664-6342 & + High Recovery Success

cz.com | & - < “Slass: 0
bl e LB pﬂn u%. . ”0 Class-100 Clean Room Lab Standards ,}

Apple M M Save B ) '
N —— ’3:9 R e Patent-Pending Recovery Technology ‘d
iWork 09 Single U $79 $64 $15 = "
Mac Boxed Set F-:t.lllry Pk $229 $159  $70 5 * Complete Computer Forensic Services _
Final Cut 2 Studio $1299 $1079 $220 - :
Final Cut Express 4.0 $199 $149 $50 /
Final Cut Express 4.0 Upg $99 $69 $30
Apple InEar Hoadphones 370 i3 %20 V- ESS DATA RECOVERY LABS
T — T wWww.datarecovery.com
MobileMe Family Pack $149 s84 $65 4 .
Logic E 8 $199 $164 $35 |
Y ———— 800.237.4200
OS X 10.5 Server 10 Client  $499 $259 $240 e e
0S X 10.5 Server Unlimited $999 $499  $500 .
Prices rounded down and subject to changs, not for errors, timited
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Student & Educator Software Discounts! BRI/

Special price with any Office,

: ‘ \ Adobe ochompurchase! o FF Retail!
# Q painter
ry !

Adobe Photoshop Adobe CS4 Design Maya Unlimited 2009 Corel Painter 11

CE:P E:th 51 9 993 St:l;gle;;g $29 998 it:.ldi?t ?53,3;8 shP 3399 § 4998

] 85

Adobe Student Editions available to college students only. ﬂ :
. -
yuwoiE - -l | orders over
3 CoreDRAW o > $99!

) . o ~ Expires 6-30-2009

Adobe CS4 Design Adobe C54 Web CorelDRAW Graphics ClipArt&More Toredeem, use

Prgemrjnsi:jg; 539993 P;E}?::I;I;S 53 4998 Swtfpx4 § 4998 3.5 Million $998 Priority code: MW10

SRP $49

journeytd PR www.JourneyEd.com/MW ............ ...

.com

SCREEN REPAIR | (AL T
LOGIC BOARD REPAIR | [

« Laptop Repair _ :
BeiProtected::

« Liquid Spill Repair
« Accidental Damage/Abuse Repair Unique personal protection items
Be]CooI™

« We buy DEFECTIVE Apple computers
Gadgets and Spy Tools galore!

MicroReplay ... om0

= A www.MicroReplay.com
BIG COLOR POSTERS | BANNERS | CANVAS | MOUNTING | LAMINATION
BIGPOSTERS.com
JHUGEDISCOUNTS

P SPECIAL OFFER |

RETRACTABLE BANNER STAND

S 33" x 78" Banner Stand
Includes Graphic |
& Nylon Case -

| 2x3

Qty 1: $8.99
nufactured HP 51645a

Color Archival [§

Poster Canvas

Sizes up to 60"x100ft | High Resolution | Color Accurate
Various media: Paper, Canvas, Vinyl, Fabric, Backlit & more

888-880~HUGE.

Croative fubtes Printing & Graphics | 96 Garss Bvd Farming pcade | NY 11735 | tel 601,240 221 | www bigposten. com .
No Minimums | No Voicemail - We Answer our Phones 9am-5pm | Fast Turnaround

Rema

Rl 35 ok carndee_ . —
et

Use Promotion code: MACWORLD

SHINNVE I18VIOVELIIAN

NEW LOW PRICE!

More great deals at...

inkfarm.com

the ink & toner supersite.™
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By Jonathan Seff
The State of American Broadband

Inthe countrythat invented the Internet, why is high-speed access so bad?

T he Internet was born and raised
in the United States. But thanks
to slow speeds, inconsistent

availability, and bandwidth caps, we now

lag behind the rest of the world when it
comes to broadband Net access.

Slow and Limited

According to Point Topic (a UK-based
researcher), there were 79 million
broadband subscribers in the United
States at the end of 2008. (The report
defines broadband as anything over 256
kilobits per second.) However, at roughly
26 percent, the United States ranked 22nd
out of 13 countries in broadband penetra-
tion by population. Other studies have
ranked us about the same.

Yes, having more than 300 million
people spread out over 3.5 million—plus
square miles presents challenges. But
it's pathetic that roughly three-quarters
of the people in this country don’t have
broadband Internet service.

The speed and price of broadband in
the United States is shameful as well. In
my San Francisco neighborhood, the
fastest available DSL service is 3 megabits
per second downstream and 512 Kbps
upstream for $25 a month. By contrast,
Macworld contributor Kirk McElhearn,
who lives in France, gets twice those
speeds with DSL for €30 a month (about
$40). If he didn't live in a semirural area,
his service would be even faster.

My local cable carrier (Comcast) says
it could provide up to 12 Mbps down-
stream for $43 a month, or up to 16
Mbps for $67 a month. But Comcast
doesn’t guarantee those speeds—and
they can vary widely.

Verizon's fiber optic service (FiOS),
offers download speeds up to 50 Mbps
and upload speeds up to 20 Mbps for
$50 to $145 a month. But FiOS isn't
available in San Francisco—or anywhere
else in northern California. In fact, FIOS
Internet service is currently available in

92 Macworld July 2009

only 17 states. It has been slow getting to

the rest of us because laying the fiber
necessary to make it work is costly and
time-consuming.

No matter how fast your Internet
service is, it may also be subject to
bandwidth restrictions. In October
2008, Comcast placed a 250GB per
month cap on residential users.

You might think you'd never get close

to that 250GB ceiling. But in a multi-
media world, you could start feeling
cramped much sooner than you might

expect. Download HD movies from the

iTunes Store, upload photos and HD
videos to places such as Flickr or
YouTube, and back up your Mac to an
online service, and you could use up
your bandwidth allotment pretty fast.
Time Warner Cable also announced
its own trial program of tiered Internet
plans, with substantial charges if you

It’s pathetic that
roughly three-
quarters of the
peoplein this
country don’t
have broadband
Internet service.

went over your allotment. The company
backed off after public outcry. But tiered
or metered bandwidth plans seem to be
gaining traction among ISPs.

Help onthe Way?

The situation is not entirely hopeless.
The U.S. economic stimulus package
that passed in February included $7.2
billion for “competitive grants to
accelerate broadband deployment in
unserved and underserved areas.” The
Federal Communications Commission
has until February 2010 to develop a
national broadband plan. (You can share
your comments by visiting the Electronic
Comment File Submission page
[macworld.com/4828] and entering 89-51
in the box under Proceeding.)

But put that spending in context:
Australia will spend almost $31 billion to
set up a new broadband network; its goal
is to provide at least go percent of the
country with 100 Mbps access by 2018.
South Korea is dishing out $25 billion to
boost wired broadband speeds to 1 gigabit
per second and wireless speeds to 10 Mbps
by 2012. (That's in a country where 100-
Mbps downloads are already the norm).

AT&T and Verizon have been
expanding the reach and speed of their
respective broadband wireless networks.
And technologies like FiOS will become
more widespread—Dbut that's years away.

And when it comes to caps, Congress-
man Eric Massa of New York plans to
introduce a bill in the House of Repre-
sentatives prohibiting unfair tiered price
structures, while also encouraging more
competition among Internet providers.

The bottom line? There are lots of
excuses but no good reasons for not
doing a better job as a nation of making
sure fast, affordable broadband is as
ubiquitous and easy to obtain as
electricity, water, or snail mail. &3

PHOTOGRAPHBY ROBERT CARDIN

Jonathan Seff is a Macworld senior editor.
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